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Chapter 1  

Manage Schedules with the 
Schedule Planner widget

The Schedule Planner widget accomplishes all of the functions of the Schedule Planner and Schedule 
Editor but with a modern design, increased ease of use, and efficient execution. It offers multiple views, 
enhanced color coding for improved visualization, powerful editing capabilities from the toolbar and call 
outs, and plenty of shortcuts to make your work faster and easier.

 l The main view is the calendar-like Gantt view on page 15.
 l Alternatively, the Tabular view on page 18 is a table-like view of the schedule.
 l The Minimized view on page 19 shows basic schedule data while you work in another widget.

Gantt view
 1. Select View > By Employee, By Job , By Schedule Group , or By Employment Terms.

 2. Click Gantt View  on the toolbar.

Color coding

 l The orange highlights and vertical orange line show the current date and time.
 l Locked days are shaded gray. You cannot edit shifts or pay codes on locked days.
 l Inactive employees are faded and their row is gray.

 l A yellow bar indicates employees who do not have a Scheduler license.



 l An exclamation point indicates employees who have Rule Violations .

 o ! Red — At least one violation has a severity of No Save.
 o ! Orange — No violations have a No Save severity, but at least one has a Warning severity.
 o ! Yellow — No violations have a No Save or Warning severity, but at least one has an 

Informational severity.
 l Assigned Shifts are blue.

 o Segments are shown as separate sections. Breaks are blank.

 o Below the shift times or label are indicators for:
Transfer

Lock

Comments

Details

 l Open Shifts are in the top, pink row.

 o The numbers indicate the number of open shifts on that day or zone.

 o Click Open Shifts .
Open shifts are red.

 l Pay codes are green.

 l Accruals are purple.
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 l Date cells are color coded for availability.

Availability types

Employee availability types and color codes:

 o Available — Employee is available to work during this time.

 — Green
 o Preferred — Employee prefers to work during this time. Employees indicate when they prefer to 

work. Preferred availability can be assigned only to employees, not to locations and not globally.

 — Dark green  
 o Preferred Time Off — Employee prefers not to be scheduled during this time. Preferred Time Off 

availability can be assigned only to employees, not to locations and not globally.

 — Purple
 o Unavailable — Employee is not available to work. If employees are scheduled when unavailable, 

the system can generate a schedule rule violation. 

 — Gray
 o Unknown — Employee is not certain about their availability. If employees do not know their 

availability but want to be considered for work, enter their availability as Unknown.

 — White 

Edit the schedule

 l Toolbar on page 23 — Along the top, control the schedule display, save or refresh data, or access 
Quick Actions on page 27.

 l Call Outs on page 34 — To see details or edit an item, right-click shifts, pay codes, accrual amounts, 
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schedule groups, or empty date cells.
 l Keyboard Shortcuts on page 39 — Cut, copy, and paste items.

Tabular view
 1. Select View > By Employee, By Schedule Group, or By Employment Terms.

 2. Click Tabular View  on the toolbar.

Restrictions on the tabular view

 l Shows only the shift labels or start and end times, it does not display segment information.
 l Shows shifts only on the day when the shifts start even if the spans go into the following day.

Color coding 
Color codes are the same as in the Gantt view, although the look of schedule items is less colorful.

 l The orange highlights show the current date.
 l Shifts have a blue cap.

If the bar has 2 shades of blue, the shift contains a transfer.
 l Open Shifts are in the top, pink row.

Click Open Shifts .
Open shifts have a red cap.

 l Pay codes have a green cap.

 l Accruals have a purple cap.

Edit the schedule
In addition to using the toolbar, call outs, and keyboard shortcuts, in the Tabular view you can also use:

 l Double-click a shift to edit shift times or labels directly in the cell. You cannot edit the labels of pay 
codes or accrual amounts in the cell.

 l Keyboard Shortcuts on page 39 — Press Tab or arrow keys to move between cells.
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Minimized view
When you minimize the Schedule Planner widget, it continues to show basic schedule information while 
another widget is open in the primary view.

 l If the selected time period includes today:

 o Today's date and the current time
 o The number of Incoming and Outgoing Employees for the current day

 l If the period does not include today:

 o The date and time of the first day of the period
 o Only the number of Incoming Employees for the first day of the period
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Select Schedule Views

Select View > By Employee, By Schedule Group, By Employment Terms, or By Job.

By Employee
Shows the day-by-day schedule of the employees:

 l Daily Intervals – The schedule can show up to 4 weeks of scheduled shifts by shift start times in a 
single view. You can load longer periods. Scroll to see more if not all of the loaded period is visible.

 l Visible details — What you see of segments, breaks, comment and lock indicators, shift labels or start 
and end times, depends on how far in you zoom.

By Schedule Group
Shows schedules with employees listed by schedule groups

 l Employees are gathered according to membership in schedule groups.
 l Groups and employees are sorted alphanumerically.
 l Employees who are not in a group are listed first as “Ungrouped employees.”
 l Empty Groups are not displayed unless selected.

By Employment Terms
Shows schedules of employees by employment terms – legal contracts between employer and employee.

 l Rows show working hours.
 l Employees who do not work according to employment terms are at the top. 
 l When scheduled to work hours different from the hours in their contract, the pay rules of the employees 

determine the impact on pay.

By Job
Shows scheduled shifts by job in graphical format. Use this view to:

 l See coverage by job
 l Identify gaps in a schedule
 l Create open shifts
 l Not available from the Tabular view
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Select Dates

Select the schedule period
 1. Click the down arrow in the upper right corner of the tool bar.
 2. Either:

 o Select the schedule period. 

 o Click . Select the Start and End Dates. Click OK.
 3. Click Apply.

The top date row shows the full length of the loaded period. If you selected more than 4 weeks, use 
the scroll bar along the bottom, or tabs along the top, to see other weeks. Example: If you open 52 
weeks, you can select from 52 tabs along the top to navigate to specific weeks.

Zoom in or out
In the date rows along the top of the schedule, you can click to zoom in and zoom out within the loaded 
period. 

The schedule can show from 1 to 30 days (4 weeks) in one view. If the loaded period is longer than the 
view of the schedule, use the scroll bar along the bottom, or tabs along the top, to show other days of the 
loaded period.

You can zoom in either direction: from several weeks into a single day, from a day out to a week, from a 
week into several days, from several days into one day, from a day out to one week, from a day or a week 
out to the full loaded period, and so on: 

 o Click a day header to see in detail the schedule for that day.
 o Click a week header to see the schedule only for that week.
 o Double-click the top date row to zoom out to the full loaded period.
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 o Click and drag across days orweeks in the second date row to zoom to that range of dates.
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Toolbar

The toolbar shows view and action buttons along the top of the schedule. 
Some of the buttons are available only for employees who have the Scheduler license.

Time period and locations
In the upper left above the toolbar, select the time period and locations:
 1. Click the down arrow in the upper right corner of the tool bar.
 2. In the Context Selector:

 o Select the schedule period or select dates .
 o Select the locations or click Edit.
 o Click Apply.

Toolbar buttons

 View 

 l By Employee on page 20
 l By Schedule Group on page 20
 l By Employment Terms on page 20
 l By Job on page 20

 Show or hide columns

 Visibility filters

 l Show or hide schedule zones
 l Select intervals to show
 l Show shift start and end times, or shift labels
 l Show full or short names of pay codes and accruals
 l Show or hide assigned shifts
 l Show or hide pay codes
 l Show or hide employee availability
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 l Show or hide schedule accrual amounts
 l Show or hide open shifts
 l Show or hide holidays
 l Show or hide hours of operation

 Select all items in the schedule

Select view

 l Tabular view

 l Gantt view

 Sort multiple columns

By Employee view only

 Enter Time Off

 Add, edit, or delete a Schedule Pattern

 Tools

 l Manage Employee Schedule Request Periods
 l Manage Open Shift Visibility Periods
 l  Multi-Edits — edit multiple schedules
 l Assignments 

 Select a schedule engine

 l Calculate Open Shifts  on page 106 — creates open shifts that you can fill manually, fill with a 
schedule engine, or post for employees to request. It creates shifts only for workloads that are defined 
by shift set.

 l Auto-Scheduler — generates a weekly schedule for a location. It creates shifts for workloads that are 
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defined by labor volume, shift set, or zone set, and assigns available employees to shifts based on 
headcount requirements.

 l Priority Scheduling Engine (PSE) — assigns open shifts to employees according to sorting and 
matching rules. It is best suited to completing whole schedules when shift times are defined and 
employees are assigned shifts according to the job and fixed rules.

 l Schedule Generator — creates or assigns open shifts for a location according to the workload, shift 
templates or profiles, employee and organizational rules, and engine settings. It creates shifts only for 
workloads that are defined by labor volume or zone set, and can assign open shifts regardless of how 
they were created.

In the By Schedule Group and By Employment Terms views only:

 l  Add employees to a group

 l  Remove employees from a group

 l  Load schedule groups or employment terms

 Select employee actions 
Select either:

 l Add Shift
 l Add Pay Code
 l View Accrual Amounts
 l Lock
 l Unlock

 

 l Quick Actions on page 27 are one-click shortcuts in the toolbar that you use to complete common, 
multiple-step tasks, speed up data entry, and reduce errors.

 Unassign a shift and create an open shift

 Refresh the schedule

 l To discard unsaved changes, click Yes.
 l To save changes, click No. Click Save.
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 Show Comments and Notes 

 Share
Select either:

 l Export the schedule data to PDF, Excel, or an email message.
 l Print the schedule that is visible on the screen.

 Save 

 l If Gray, save is not enabled = The schedule has no changes to save.
 l If Orange, save is enabled = Click to save changes.

 Go to
Display another widget or workspace:
 1. Select employees in this widget.
 2. Click the Go To button.
 3. Select another widget such as the time card to see the same employees in that widget.
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Quick Actions

Quick Actions are one-click shortcuts in the toolbar that you use to complete common, multiple-step tasks, 
speed up data entry, and reduce errors.

 1. Select View > By Employee, By Job , By Schedule Group , or By Employment Terms.
 2. Click the button for the action before you select the item. The cursor changes to show the selected 

action.

Important: The following list shows all possible quick action buttons. However the actions that are 
available and the order of actions are configurable, so your selection probably differs from this list. 

The toolbar can show up to 10 quick action buttons, but up to 12 actions can be available. Click 
 to select the other actions.

 Assign
Assign Open Shifts to employees.

 o Not available from the By Job view
 o You cannot assign open shifts to a group.

 a. Click Assign.
 b. Select the open shift.
 c. Select an employee. 

The shift is assigned to the employee. If the employee’s primary job does not match the job of the 
open shift, the segment becomes a transfer job. Work rule or labor level transfers remain the 
same.

 d. If break rules are violated, reassign the breaks:

 o Right-click the shift.

 o Click Assign Breaks  in the call out.
 e. Repeat as needed.
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 Unassign
Unassign shifts or pay codes from employees.
You cannot unassign locked shifts or any shifts from a group.

 a. Click Unassign.
 b. Select the shift or pay code.

The shift is removed from the employee's schedule and becomes an open shift. If a segment was 
for the employee’s primary job, this segment becomes a Regular segment with a job transfer to the 
original primary job. Work rule or labor level transfers remain the same.

 c. Repeat as needed.

 Insert Shift Transfer
Change the job (Regular, Transfer, and Off shift segment) for a shift.
You cannot transfer:

 o Break and Unavailable shift segments
 o Pay codes
 o Accrual amounts
 o Open shifts
 o To locked shifts or days

 a. Click Insert Shift Transfer.
 b. Select the transfer job and location. 

If you can't see the whole name of the location, hover the pointer over the name to show the whole 
name in a tool tip.

 c. Select a shift in the schedule. 
The job transfer applies to all segments of the shift. Work rule or labor level transfers remain the 
same.

 d. Repeat to transfer the same shift to other shifts.

 Insert Shift Template
Create and assign shifts from a shift template to an employee.
Not available from the By Job view
You cannot assign templates to:
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 o Break and Unavailable shift segments
 o Pay codes
 o Accrual amounts
 o Open shifts
 o Locked shifts or days

 a. Click Insert Shift Template.
 b. Select the template.
 c. Select the date cells, whether empty or not.
 d. Repeat as needed.

 Comment
Add Comments to a shift or pay code.

 o You can add multiple comments to assigned shifts or pay codes. 
 o You cannot add comments to empty cells or to shifts or pay codes that are locked.
 o You cannot add Notes with this button.

 a. Click Comment.
 b. Select the comment.
 c. Select the shift or pay code.
 d. Repeat to attach the same comment to other shifts or pay codes.

 Pay Code
Replace an assigned shift with a pay code.

 o Not available from the By Job view
 o You cannot replace a shift segment, a locked shift, a shift during a locked day, an accrual, or an 

empty cell.

 a. Click Pay Code.
 b. Select the category and pay code.

The list displays only time-based, not money-based, pay codes.
 c. Select an assigned shift. 
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 o The pay code replaces the entire duration of the shift. 
 o If configured, the shift becomes an open shift.

 d. If an employee is assigned multiple shifts that day, select whether to use all shifts that day to 
calculate the pay code value (schedule day) or replace only a selected shift with the pay code.

 e. Repeat to replace another shift with the same pay code.

 Copy / Paste
Copy and paste a shift in the schedule.

 a. Click Copy / Paste. 
 b. Select the shift to copy.
 c. Select the date cell to paste the copy.
 d. Repeat to paste the item in another cell.

 Delete
Delete a shift, pay code, or accrual.
You cannot delete a locked item or a shift or pay code on a locked day.

 a. Click Delete.
 b. Click the shifts, pay codes, or accruals.
 c. Repeat as needed.

Tip: To restore items deleted by mistake, click  and do not save. You lose all changes since 
the last save.

 Lock / Unlock
Lock or unlock a shift. You cannot lock or unlock days with this button.

 a. Click Lock / Unlock.
 b. Either:

 o Click an unlocked shift to lock it.
 o Click a locked shift to unlock it.

 c. Repeat as needed.
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 Swap
Swap, assign, or unassign shifts, pay codes, or days with no shifts.
You can swap:

 o Two shifts, pay codes, or days with no shifts between two employees on the same day. Both 
employees must be qualified and available.

 o Two items between two employees on different days. 
Swaps between different days do not overwrite existing items. Employees can be assigned two or 
more items. Select the first item. Select the second item. The swapped items move to the cells of the 
original items. To swap again so that the employee has one item, select the first cell. Select a 
second item.

 o A shift for a pay code between two employees on the same day
 o A pay code for a shift between two employees on the same day
You cannot swap:

 o Items with a group
 o Accruals
 o Items between the same employee
 o Locked shifts
 o Day-based pay codes
 o Money-based pay codes
 o Cascading pay codes

 a. Click Swap.
 b. Select the first item.
 c. Select the second item.
 d. Repeat as needed.

Alternative: You can use swap to assign or unassign shifts or pay codes.

 o Assign an open shift or a pay code to an employee:

 a. Select the open shift or pay code.
 b. Select a day with no shift or pay code.

 o Unassign a shift or pay code:
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 a. Select an assigned shift or pay code.
 b. To assign the shift or pay code to another employee, select an employee with no assigned shift 

or pay code.

Offset Shift
Move an entire shift.

 a. Click Offset Shift.
 b. Click and drag the shift on the schedule to the new time. 

 o The minimum increment is 15 minutes. 
 o The maximum offset is 8 hours earlier or later.

Tip: Hover the pointer near the shift to show a tool tip of the new start time.

 c. If break rules are violated, reassign the breaks:

 o Right-click the shift.

 o Click Assign Breaks  in the call out.
 d. Repeat as needed.

Shift Duration
Quickly edit the start or end time of a shift.

 a. Click Change Duration.
 b. Click and drag the start or end of the shift to the new time.

 o The minimum increment is 15 minutes. 
 o The maximum offset is 8 hours earlier or later.

Tip: Hover the pointer near the shift to show a tool tip of the new start or end time.

 c. If break rules are violated, reassign the breaks:

 o Right-click the shift.

 o Click Assign Breaks  in the call out.
 d. Repeat as needed.

32



 Assign Breaks
Assign breaks to existing shifts. Breaks are scheduled according to the defined times in the configured 
break rule.

 a. Click Assign Breaks .
 b. Click the shift.
 c. Repeat as needed.

 3. Click Save.
 4. To deactivate the current action, click the same button that you have been using or click another button.
 5. To track changes, check the Schedule or Day Lock audit.
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Call Outs

What are "call outs"?
Call outs are windows that open only when you choose. They replace tool tips, menus, and conventional 
dialog boxes by combining:

 l Information — Static, detailed information — like in a tool tip — about items in the schedule
 l Actions — Buttons that complete actions or open dialog boxes — these work like menu items in pop-

up or drop-down menus.
To see call outs:
 a. Right-click an item such as an employee, shift, pay code, accrual amount, or an empty date cell.

 b. Click  or elsewhere in the schedule to close the call out.

Action buttons
The action buttons in call outs change according to the type of call out, the view, the status of the item, and 
your function and data access profiles (FAP, DAP). Examples: Group buttons are available only from the 
By Group and By Employment Terms views. The Reinherit button is available only if the employee is 
assigned a schedule pattern. The Paste button is not available if you haven't previously clicked the Copy or 
Cut button.

If an action button is not visible because the call out is too small, click More Actions  to select the 
action.

Employee action buttons

Lock shifts or days

Unlock shifts or days

Append time to a shift

Insert a Shift Transfer

Show or edit Availability Patterns

Add the employee to a group
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By Schedule Group and By Employment Terms views only

Remove the employee from a group

By Schedule Group and By Employment Terms views only

Add a Shift

Add a Pay Code

Insert a Schedule Pattern

Enter Time Off

Replace Shift

Edit Accrual Amounts

Add or edit an Accrual Pattern

View Accrual Amounts

View Audits

View Schedule Outline

Shift action buttons

Comments and notes:

 l To read notes in a tool tip, hover the pointer over .

 l To add or edit comments or notes, click Edit .
Delete a shift

Cut a shift to duplicate and paste in another cell

Copy or duplicate a shift to paste in another cell

Lock shifts or days
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Unlock shifts or days

Assign Breaks

Enter Time Off

Unassign the employee from the shift

Find a replacement employee to work the shift

Reinherit the schedule pattern that is assigned to the employee's schedule group 
or employment terms group.

By Schedule Group and By Employment Terms views only

Edit the Shift

Add a Pay Code to the shift

Edit Accrual Amounts

Open shift action buttons

Comments and notes:

 l To read notes in a tool tip, hover the pointer over .

 l To add or edit comments or notes, click Edit .
Delete a shift

Cut a shift to duplicate and paste in another cell

Copy or duplicate a shift to paste in another cell

Assign Breaks

Assign the Shift

Find a replacement employee to work the shift

Edit the Shift
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Pay code action buttons

Comments and notes:

 l To read notes in a tool tip, hover the pointer over .

 l To add or edit comments or notes, click Edit .
Delete a pay code

Cut a pay code to paste in another cell

Copy a pay code to duplicate and paste in another cell

Reinherit the schedule pattern that is assigned to the employee's schedule group 
or employment terms group.

By Schedule Group and By Employment Terms views only

Edit the pay code

Insert a Schedule Pattern

Accrual amount action buttons

Delete an accrual amount

Cut an accrual amount to paste in another cell

Copy an accrual amount to duplicate and paste in another cell

Edit the accrual amount

Empty cell action buttons

Restore shifts or pay codes from a schedule pattern

By Employee view only

Reinherit the schedule pattern that is assigned to the employee's schedule group or employment 
terms group.

By Schedule Group and By Employment Terms views only
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Paste a copied, duplicated, or cut shift, pay code, or accrual amount

Insert a Shift Template

Show or edit Availability Patterns

Enter Time Off

Add a Shift

Add a Pay Code

Add Accrual Amounts
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Keyboard Shortcuts

Tip: To select all items in the schedule, press Ctrl+ A.

Cut, copy, and paste
 a. Select a shift, pay code, or accrual amount.
 b. Either:

 o Cut to remove the item: Press Ctrl+ X.
 o Copy the item but leave the original item in place: Press Ctrl+ C.

 c. Paste the cut or copied item: 
 a. Select a date cell. You can paste an item to a cell that already has a schedule item. Example: You 

can paste a shift to a day that already has a shift.
 b. Press Ctrl + V.
 c. Repeat to paste the same item in another cell.

Navigation

 1. Click Tabular View  on the toolbar.
 2. Select a date cell.

 l Tab: Moves right; if a cell is editable, moves to the first editable item
 o At the end of a row, moves to the first cell on the row below
 o At the end of a table, moves to the first cell of the first row

 l Shift + Tab: Moves left; if a cell is editable, moves to the first editable item
 o At the start of a row, moves to the last cell on the row above
 o At the start of a table, moves to the last cell of the last row

 l Up and Down arrow: Moves one cell or item in the direction of the arrow
 o If a cell contains more than one shift or pay code, moves to the next or previous editable item in the 

cell
 o At the end of a column, moves no further

 l Left and Right arrow: Moves one cell in the direction of the arrow only if the cells are not editable
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 o Moves one cell in the direction of the arrow only if the cells are not editable
 o If the cell contains editable text, moves along the text
 o At the end of a row, moves no further
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Smart Search

Most drop-down lists offer Smart Search to help you to quickly find specific items. Start typing the name of 
the item — even a single letter — and the search filters items according to your text.
Example: In Assigned to, start typing the name of an employee. As you type, search filters the employees. 
You can stop at any time and select the employee before you finish typing their name.
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Show or Hide Columns

To make the schedule easier to read, you can show or hide columns that are available in your preferences.

Note: You cannot change the order of the columns; the order is defined in the column set.

 1. Click Show or Hide Columns  in the toolbar.
 2. Select or clear the check box for the columns.
 3. To change the width of a column, click and drag the edge of the column header. 
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Sort Columns

By one column
 1. Click the column header to sort in alphanumeric order.

An up or down arrow in the header indicates the current sort order.
 2. Select Sort Ascending or Sort Descending. 

By 2 columns
 1. Select View > By Employee.

Not available from the By Job, By Schedule Group, or By Employment Terms views.

 2. Click Sort Multiple Columns  in the toolbar.
 3. The first column defines the initial sort order; the second column is sorted based on the sort of the first 

column.

 a. Select the first column. Click the up  or down  arrow to sort in ascending or descending 
alphanumeric order. The dark arrow indicates the current sort order.

 b. Select the second column. Click the up or down arrow.

 c. To change the column that sorts first, click the Switch Sort  button.
 d. Click Apply.

Note: If later you click a column header to sort it, you lose this 2-column sort.
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Comments and Notes

Comments identify the reason for the existence of shifts, pay codes, or requests in the schedule. 
Comments are configured; managers and employees can select but do not edit comments.
Notes are free text that employees or managers can add to comments.
Shifts and pay codes that have comments, display a Comment icon:

 

Show comments by shift or pay code
 1. Right click a shift or pay code to see the comments in the call out.

 2. To read notes in a tool tip, hover the pointer over .

 3. To add or edit comments or notes, click Edit .
 4. In the Shift Editor, either:

 o Click Add Comment. Select a Comment. Optionally, enter text in a Note.
 o Select a Comment. Either select another comment or enter text in a Note.

 5. Click Update.
 6. Click Apply.
 7. In the widget, click Save.

Show all comments
Show all comments and notes from any shift or pay code during the loaded period.

 1. In the toolbar, click Comments .

 o Date — Start date of the shift or pay code
 o Shift/Pay Code

 l Shift: Start and end time or shift label
 l Hourly pay code: Pay code and amount (hours)
 l Money-based pay code: Pay code and amount

 o Name — Employee name
 o Comments — Does not show comments that were entered by employees or that come from the time 
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card
 o Note — Ends with the author of the note

 2. To change the sort order, click a column header. The arrow indicates the current sort order. Click again 
to switch between ascending and descending alphanumeric order.

 3. Click OK.
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Weekends and Holidays

Weekends: The label in the date header is bold.
Holidays: The label in the date header is red.

 l If you don't see holidays, either:

 o Holidays are hidden. Click the Visibility Filter . Select Show Holidays.
 o None are during the visible dates or the selected schedule period. Zoom to another date or select 

another period.

 l Hover the pointer over the date header to display the name of the holiday.

 l If the holiday spans multiple days, the tool tip shows start and end times.
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Unsaved Changes

If changes to the schedule have not been saved, the Save button is enabled.

 l If Gray, save is not enabled = The schedule has no changes to save.
 l If Orange, save is enabled = Click to save changes.

 l If you do not want to save changes since the last save, click Refresh . Click Yes to confirm.
 l To remove changes that are saved, you have to edit the information manually and save again.
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Chapter 2  

Edit Schedules
You cannot edit items on signed-off days.
 1. Select View > By Employee, By Job , By Schedule 

Group , or By Employment Terms.

 2. Select a time period and locations. Click Apply.

 o Assigned Shifts are blue.
 o Segments are shown as separate sections. Breaks are blank.

 3. (Optional) If you select By Schedule Group or By Employment Terms, click Load Schedule Groups or 

Employment Terms  to load all available groups.

Tip: To edit the schedule for all members of a group that is configured for inheritance, make the 
changes in the row for the schedule group and not in the rows for each employee.

Create shifts and segments  
Shifts can contain segments such as for breaks or transfer jobs.
 1. Either:

 o Double-click an empty date cell.

 o Right-click an empty date cell. Click Add Shift  in the call out. 

Shift Editor — Add Shift



 o  — Insert a shift segment

 o  — Delete a shift segment
 o Alternatively: 

 o Rather than enter times and durations in the table, you can edit by 15-minute intervals in the 
graphical view of the shift. 

 o Click and drag the edges or the arrows below the edges of the segments. 

 o To add a segment to the start or end of the shift, click . Click and drag the red edge or 
arrows to adjust.

 o To delete the new segment, click  .
 2. (Optional) In Assigned to, select another employee.
 3. (Optional) Select a Shift Template.
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 4. (Optional) Enter a Shift Label.

Important: Shift labels do not change if you edit a shift. Example: If the shift label is 7a3p, and a 
manager changes the end time to 4 p.m., the label does not change and it no longer reflects 
accurately the underlying shift.

See Shift Label Formats on page 330 for formatting information.
 5. Enter the number of consecutive days to Repeat this shift. This value is in continuous days and does 

not skip holidays or weekends.
 6. Define each segment:

 a. Select the Start Date.
 b. Select the Type (Regular (primary job), Break, or Transfer) of shift segment.
 c. Enter the Start and End Time. The maximum length of a shift is 24 hours.

See Formats on page 329 for formatting information.
 d. If available, select the End Date.
 e. Duration displays the total length. To change the Duration, edit the Start or End Time.
 f. If the segment is a Transfer, select or click Search:

 o Job —  Select or search for a Job Transfer from the Organizational Map. Access to Perform 
Job Transfers must be enabled.

 o Labor —  Enter the labor account number or short name, or search for and select the labor 
level. Access to Perform Account Transfers must be enabled.

 o Work Rule —  Enter the name or search for and select the work rule. Access to Perform Work 
Rule Transfers must be enabled.

Note: A transfer is not valid for Breaks.

 g. If available, select a Skill & Certification Profile to apply to regular or transfer segments. To 
select from all available profiles, select Search. Select the profiles. Click the arrow keys. Click 
OK.

 h. If available, select Details.

 i. To add another segment, click .

 o If you add a segment in between segments, the Duration defaults to 0.
 o If you add a segment after the last segment, the Duration defaults to 1 hour.
 o To change the Duration, edit the Start or End Time.

 7. (Optional) Add comments and notes:
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 a. Click Add Comment.
 b. Select a comment.
 c. Enter text in a Note. Click Add.

The shift displays a Comment icon . 

 8. Click Apply.
 9. In the widget, click Save.

Insert shift templates
To create standard shifts that don't change often, insert shift templates rather than create shifts 
individually.
If employees work standard shifts, assign shift templates to build schedules. Shift templates store shifts 
that are named and have assigned start and end times, but no assigned dates or employees. Shifts that are 
defined by shift templates can have segments.

Important: You cannot use shift templates that contain job transfers that are not in your transfer set.

 1. Right-click an empty date cell.

 2. Click Insert Shift Template  in the call out.
 3. Select the template.

Tip: If you know the name of the template, you can enter it. Search filters for matching templates 
as you type.

 4. Click OK.
 5. Click Save.

Duplicate existing shifts
The new shifts have the same attributes as the original.

Cut, copy, and paste schedule items
Use the call-out or keyboard actions to quickly build or update schedules by moving or duplicating existing 
shifts, pay codes, or accrual amounts.
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You cancopy a shift, pay code, or accrual amount if it is locked, signed-off, or on a locked or signed-off 
day. When you paste the copied item, it is not locked.

Restrictions

 o You cannot cut:

 o a shift, pay code, or accrual amount if it is locked or signed-off
 o a shift or pay code on a locked or signed-off day

 o You cannot paste a shift or pay code to a day that is locked or signed-off.
 1. Either:

 o Use call outs:

 a. Right-click a shift, pay code, or accrual amount.
 b. In the call out, either:

 l Cut to remove the item: Click Cut.
 l Copy the item but leave the original item in place: Click Copy .

 c. Paste the cut or copied item: 
 a. Right-click an empty date cell. 
 b. In the call out, click Paste.
 c. Repeat to paste the same item in another empty date cell.

 o Use keyboard shortcuts.
 2. Click Save.

Edit shifts directly in a schedule cell  
Unless you enter a shift segment, the time is charged to the employee's primary job and cannot be charged 
to a transfer job.

 a. Available only from the Tabular view. Click .
 b. Select a date cell.
 c. Enter the start and end times, or the name of a shift template.

Important: If you do not enter the name of a shift template, the shift cannot have segments.

See Formats on page 329 for formatting information.
 d. Click Save.
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Edit shifts
 1. Either:

 o Double-click a shift.

 o Right-click the shifts. Click Edit  in the call out.

Shift Editor

 o  — Insert a shift segment

 o  — Delete a shift segment
 o Alternatively: 

 o Rather than enter times and durations in the table, you can edit by 15-minute intervals in the 
graphical view of the shift. 

 o Click and drag the edges or the arrows below the edges of the segments. 

 o To add a segment to the start or end of the shift, click . Click and drag the red edge or arrows 
to adjust.
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 o To delete the new segment, click  .
 2. In Assigned to, you can assign the shift to another employee.

Note: Repeat this shift is not available when you edit shifts.

 3. Define each segment:
 a. Select the Start Date.
 b. Select the Type (Regular (primary job), Break, or Transfer) of shift segment.
 c. Enter the Start and End Time. The maximum length of a shift is 24 hours.

See Formats on page 329 for formatting information.
 d. If available, select the End Date.
 e. Duration displays the total length. To change the Duration, edit the Start or End Time.
 f. If the segment is a Transfer, select or click Search:

 o Job —  Select or search for a Job Transfer from the Organizational Map. Access to Perform 
Job Transfers must be enabled.

 o Labor —  Enter the labor account number or short name, or search for and select the labor 
level. Access to Perform Account Transfers must be enabled.

 o Work Rule —  Enter the name or search for and select the work rule. Access to Perform Work 
Rule Transfers must be enabled.

Note: A transfer is not valid for Breaks.

 g. If available, select a Skill & Certification Profile to apply to regular or transfer segments. To 
select from all available profiles, select Search. Select the profiles. Click the arrow keys. Click 
OK.

 h. If available, select Details.

 i. To add another segment, click .
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 o If you add a segment in between segments, the Duration defaults to 0.
 o If you add a segment after the last segment, the Duration defaults to 1 hour.
 o To change the Duration, edit the Start or End Time.

 4. (Optional) Add comments and notes:

 a. Click Add Comment.
 b. Select a comment.
 c. Enter text in a Note. Click Add.

The shift displays a Comment icon . 

 5. Click Apply.
 6. In the widget, click Save.

Append time to shifts  
To only change the start or end time of shifts on the same day, append time to a shift. 
Example: Schedule all employees in a department to come in one hour early.
Not available from the By Job view.
 1. Select the employees.

 2. Click Append Shift  in the call out.

Restrictions: You cannot append to pay codes, signed-off or locked shifts, or shifts during locked 
days.

 3. Select the Effective Date.
 4. Select to append to the Start or End of the current shift.
 5. Enter the Amount of time to add to the shift.
 6. If the segment is a Transfer, select:

 o Job —  Select or search for a Job Transfer from the Organizational Map. Access to Perform Job 
Transfers must be enabled.

 o Labor —  Enter the labor account number or short name, or search for and select the labor level. 
Access to Perform Account Transfers must be enabled.
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 o Work Rule —  Enter the name or search for and select the work rule. Access to Perform Work Rule 
Transfers must be enabled.

Note: A transfer is not valid for Break or Unavailable types.

 7. Click OK.
 8. Click Save.

Lock shifts  
Lock shifts to protect them from being edited or deleted. Locking disables most actions in the call outs for 
the shifts.
Example: Lock shifts so that they do not change when you edit or delete patterns.

Restriction: You cannot lock accruals or pay codes.

 1. Either:

 o Lock one shift

 a. Right-click the shift.

 b. Click Lock  in the call out. 

 o Lock multiple shifts

 a. Right-click employees. 

 b. Click Lock  in the call out. 
 c. Select Shift.
 d. (Optional) Select All to lock the entire shifts for the selected employees.
 e. Click Apply.

 2. Confirm that the shifts show a padlock icon.

 3. Click Save.
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Unlock shifts  
Locked shifts show a padlock icon.

 1. Either:

 o Unlock one shift

 a. Right-click a locked shift.

 b. Click Unlock  in the call out.

 o Unlock multiple shifts

 a. Right-click employees who have locked shifts.

 b. Click Unlock  in the call out.
 c. Select Shift.
 d. (Optional) Select All to unlock the entire shifts for the selected employees.
 e. Click Apply.

 2. Confirm that the padlock icon is gone from the shifts.
 3. Click Save.

Lock days 
Lock days to prevent changes to schedules on those days. Locking disables most actions in the call outs for 
the shifts.
Example: Lock days to prevent shifts on those days from being edited or deleted, or lock empty days to 
prevent creation of shifts on those days.
Not available from the By Job view.
 1. Right-click employees or groups.

 2. Click Lock  in the call out. 
 3. Select Days.
 4. Either:
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 o Select All to lock all days during the loaded period for the selected employees.
 o Select a Start Date and End Date during the loaded period to lock days for the selected employees 

only during that date range.
 5. Click Apply.
 6. Make sure that the locked days are gray.
 7. Click Save.

Unlock days  
Locked days are gray.
Not available from the By Job view.
 1. Right-click employees who have locked days.

 2. Click Unlock  in the call out.
 3. Select Days.
 4. Either:

 o Select All to unlock all days during the loaded period for the selected employees.
 o Select a Start Date and End Date during the loaded period to unlock days for the selected 

employees only during that date range.
 5. Click Apply.
 6. Make sure that the unlocked days are no longer gray.
 7. Click Save.

Transfer shifts  
You can transfer employees to work different jobs, labor levels, or work rules.

 l Example Job transfer — A manufacturing manager needs to transfer everyone who works on Line 1 
to work on Line 2 because of a mechanical problem.

 l Example Labor Level transfer — For a training session, transfer all employees on Floor 1 to Cost 
Center 32145 from 3 p.m. until the end of their shift.

 l Example Work Rule transfer — Several employees who are On Call are called into work from 4 to 9 
p.m.; they need to be paid a shift differential. The Manager transfers them from an On Call to an On 
Call/Worked Shift work rule.

Not available from the By Job view.
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 1. Right-click the employees.

 2. Click Insert Shift Transfer  in the call out.

Important: Insert a shift transfer only for shifts that have 2 or fewer segments because the transfer 
replaces all segments that follow, including breaks.

 3. Select the Effective Date. This is the date when the system searches for the selected shifts to insert 
the transfer; must be during the time period of the schedule

 4. Enter the Start and End Time. The maximum length of a shift is 24 hours.
See Formats on page 329 for formatting information.

 5. Select:

 o Job —  Select or search for a Job Transfer from the Organizational Map. Access to Perform Job 
Transfers must be enabled.

 o Labor —  Enter the labor account number or short name, or search for and select the labor level. 
Access to Perform Account Transfers must be enabled.

 o Work Rule —  Enter the name or search for and select the work rule. Access to Perform Work Rule 
Transfers must be enabled.

 6. (Optional) Add comments and notes:

 a. Click Add Comment.
 b. Select a comment.
 c. Enter text in a Note. Click Add.

The shift displays a Comment icon . 

 7. Click Apply.
 8. Click Save.

Replace shifts
You can find and replace a shift for multiple employees.
Example shift replacements:

 l During a holiday, the manager needs to add 2 hours to all shifts from 2 to 8 p.m. for all employees, and 
enter a comment and note to indicate that overtime is approved for that period.

60



 l A machine is broken, and the manager must send everyone home and get them to work on Saturday. 
The manager adds a work rule and includes a comment and note to justify the overtime.

Restrictions: You cannot replace signed-off shifts, locked shifts, shifts during locked days, or pay codes.

Not available from the By Job view.

 1. Right-click the employees.

 2. Click Replace Shift  in the call out.
 3. In Find Existing Shifts, enter dates or times. Click Find.
 4. Define each segment:

 a. Select the Start Date.
 b. Select the Type (Regular (primary job), Break, or Transfer of shift segment.
 c. Enter the Start and End Time. The maximum length of a shift is 24 hours. Duration displays the 

total length.
See Formats on page 329 for formatting information.

 d. Duration displays the total length. To change the Duration, edit the Start or End Time.
 e. If available, select Details.
 f. If the segment is a Transfer, select:

 o Job —  Select or search for a Job Transfer from the Organizational Map. Access to Perform 
Job Transfers must be enabled.

 o Labor —  Enter the labor account number or short name, or search for and select the labor 
level. Access to Perform Account Transfers must be enabled.

 o Work Rule —  Enter the name or search for and select the work rule. Access to Perform Work 
Rule Transfers must be enabled.

Note: A transfer is not valid for Break or Unavailable types.

 5. To add another segment, click .

 o If you add a segment in between segments, the Duration defaults to 0.
 o If you add a segment after the last segment, the Duration defaults to 1 hour.
 o To change the Duration, edit the Start or End Time.

 6. (Optional) Add comments and notes:
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 a. Click Add Comment.
 b. Select a comment.
 c. Enter text in a Note. Click Add.

The shift displays a Comment icon . 

 7. Click Save.
 8. In the widget, click Save.

Delete shifts  
 1. Right-click a shift.

 2. Click Delete  in the call out.
 3. Click Yes to confirm. You delete the entire shift, not just a segment.

Tip: To restore an item deleted by mistake, click Refresh but do not save. You lose all changes 
since the last save. If you did save changes and the deleted item comes from a schedule pattern or 
group, you can restore deleted shift or pay codes or re-inherit patterns from a schedule group or 
employment terms.

 4. Click Save.

Restore deleted shifts or pay codes
Not available from the By Job view.
The deleted items must be part of an active schedule pattern for the selected employee.
 1. Right-click an empty date cell that contained a shift or pay code from the pattern but that item was 

deleted.

Important: If the shift or pay code was replaced by another, delete it before you restore.

 2. Click Restore  in the call out to restore the items from the schedule pattern.
 3. Click Save.
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Assign Breaks

Breaks are scheduled according to the defined times in the configured break rule.

 l You cannot edit breaks on a locked day, locked shift, or signed-off day.
 l You can assign breaks only to individual shifts and not to schedule groups or employment terms groups.

 Assign breaks manually to single shifts
 1. Assign breaks to open, new, or existing shifts:

 o Right-click an open shift. Click Assign Breaks  in the call out. Click OK to confirm.

 o Right-click an empty date cell. Click Add Shift  in the call out. In the shift editor, click Assign 
Breaks. Click Apply. 

 o Right-click a shift. Click Edit  in the call out. In the shift editor, click Assign Breaks. Click 
Apply.

 2. In the widget, click Save.

Assign breaks automatically
If auto-breaks are configured for a shift segment and work rule, breaks are assigned automatically when 
you edit shifts.
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Edit Pay Codes

You cannot edit items on signed-off days.

 1. Select View > By Employee, By Job , By Schedule Group , or By Employment Terms.
 2. Select a time period and locations. Click Apply.

Pay codes are green.

 3. If you don't see pay codes, either:

 o Pay codes are hidden. Click the Visibility Filter . Select Show Pay Codes.
 o None are in the schedule.

Add pay code edits  
 1. Right-click employees, shifts, or empty date cells.

 2. Click Add Pay Code  in the call out.
 3. Select the Effective Date to apply the pay code. This date must be during the time period of the 

schedule
 4. Select the Pay Code.
 5. In Calculate Hours Using, you can select a symbolic value. The system automatically derives the Start 

Time and calculates the Amount.

 o Available only for a time-based pay code edit for an employee — not for a group or a money-based 
pay code

 o Full or Half Sched Day — The sum or half of the sum of all shifts during the day. Selectable even 
if the employee has no shifts. Full Sched Day accounts for breaks, shift differentials, and overtime. 
Amount is 0:00.

 o Full or Half Contract Day — The sum or half of the sum of all shifts of all contract groups 
associated with the employee. The Amount dynamically updates after changes to the contract group. 
Selectable even if the employee is not associated with a contract group. Full Contract Day accounts 
for breaks, shift differentials, and overtime. Amount is 0:00.

 o Full or Half Pattern Day — The sum or half of the sum of all shifts of all patterns associated with 
the employee on that day. The Amount dynamically updates after changes to the pattern. Selectable 
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even if the employee is not associated with a pattern; if so, the amount is 0:00.
 o Only if you selected a symbolic value, enter or select the Hours (hh:mm).

Note: If a pay code edit has a day-based pay code, a duration in hours, and a symbolic source with 
a value = 0, the day equivalent in Amount cannot be calculated because Hours / 0 is 
mathematically indefinite. The system substitutes an Amount of 0.00. 

 6. In Amount, enter the length of the pay code or select a symbolic value.

Units change according to the type of pay code.

 o For days (d.dd), enter a number between 0 and 1, or select a symbolic value.
 o For money, enter a positive or negative number.
 o For hours (hh:mm), enter a positive or negative number, or select a symbolic value.
 o For cascading days, enter a number between 0 and 1. Default = 1. Not available from the By 

Employment Terms view.
 o For cascading days yoked, enter a number between 0 and 1. Default = 1. Not available from the By 

Employment Terms view.

 o Symbolic values

Symbolic values allow the system to derive the start time and calculate the amount of a pay code 
edit in the schedule. The value is the sum of a symbolic source and at least one duration amount that 
employees can select.

Symbolic sources

 l Contract – Hours are based on contract terms.
 l Fixed – A defined, unchanging number of hours
 l Pattern – Hours are based on pattern templates.
 l Schedule – Hours are based on the schedule.

Durations

 l Full Day – Entire shift that day
 l Half Day – Half the total time of shifts that day. Important:1

1The time off starts only when the first shift of the day starts. For other half-day amounts, select 1st or 2nd 
Half Day or Hours.
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 l Available only for time-off requests if configured:
 l 1st Half Day – Total time of the first half of the shift that day
 l 2nd Half Day – Total time of the last half of the shift that day

 l Hours — Employee can enter the number of hours
 7. Only for Amounts in hours (hh:mm), select Override Accrual Days to override the Amount. Enter up 

to 1 day.
 8. Define overrides: 

 o If the pay code edit replaces a shift, select Override Shift. Example: Set a Vacation pay code edit 
to override a shift.

 o Select Whole Shift or Partial Shift. Partial shift creates a segment within the existing shift.
 o For a money-based pay code, the value is always Whole Shift.

 o If the pay code edit is added to the shift, clear Override Shift.

 l Example: To pay a Bonus or schedule an On-Call shift, do not override the shift. 
 l If an employee has more than one scheduled shift during a day, a pay code edit overrides only the 

first shift that day. To change this default override, your system administrator can configure pay 
code edits to override all shifts.

 l Override Shift is selected by default. To clear it by default, your system administrator can change 
the default setting in a custom property file.

 9. If you did not select a full-day symbolic value, enter the Start Time.
See Formats on page 329 for formatting information.

 10. Enter the number of consecutive days to Repeat the pay code. This value is in continuous days and 
does not skip holidays or weekends.

 11. In Transfers, select:

 o Job —  Select or search for a Job Transfer from the Organizational Map. Access to Perform Job 
Transfers must be enabled.

 o Labor —  Enter the labor account number or short name, or search for and select the labor level. 
Access to Perform Account Transfers must be enabled.

 o Work Rule —  Enter the name or search for and select the work rule. Access to Perform Work Rule 
Transfers must be enabled.

 12. (Optional) Add comments and notes:

 a. Click Add Comment.
 b. Select a comment.
 c. Enter text in a Note. Click Add.
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The shift displays a Comment icon . 

 13. Click Save.
 14. In the widget, click Save.

 15. To make sure that the time card displays the pay code, click Refresh .

Delete pay code edits  
 1. Right-click a pay code.

 2. Click Delete  in the call out.
 3. Click Yes to confirm.

Tip: To restore an item deleted by mistake, click Refresh but do not save. You lose all changes 
since the last save. If you did save changes and the deleted item comes from a schedule pattern or 
group, you can restore deleted shift or pay codes or re-inherit patterns from a schedule group or 
employment terms.

 4. Click Save.
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Edit Accrual Amounts

You cannot edit items on signed-off days.

 1. Select View > By Employee, By Schedule Group, or By Employment Terms.
 2. Select a time period and locations. Click Apply.

Accruals are purple.

 3. Show an employee's accruals:

 a. Right-click one employee.

 b. Click  or More Actions  > View Accruals in the call out.
 c. Click OK.

Create accrual amounts 
 1. Right-click one employee or an empty date cell.

 2. Click Edit Accrual Amounts  in the call out.
 3. Define each accrual code edit:

 a. Select the Accrual Code.
 b. Enter an Amount.
 c. Select the Effective Date.

 4. To add another accrual amount edit, click . 

 5. To delete an accrual amount edit, click .
 6. Click Apply.
 7. Click Save.

Edit accrual amounts 
 1. Either:
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 o Right-click one employee or an empty date cell. Click Edit Accrual Amounts  in the call out.

 o Right-click an accrual. Click Edit  in the call out.
 2. Define each accrual code edit:

 a. Select the Accrual Code.
 b. In Amount, enter the number of hours. The maximum length of an accrual is 24 hours. See 

Duration Formats on page 330.
 c. Select the Effective Date.

 3. To add another accrual amount edit, click . 

 4. To delete an accrual amount edit, click .
 5. Click Apply.
 6. Click Save.

Delete accrual amounts 
 1. Right-click the accruals.

 2. Click Delete .
 3. Click Yes to confirm.

Tip: You can delete an accrual amount from an accrual amount pattern. Select the employees, 
groups, or employment terms. Click Accrual Amount Pattern  in the toolbar. Click Add Pattern. 
Click  to delete each accrual amount edit until none remain. Click Apply. Click Yes to confirm.

 4. Click Save.

69



Edit Accrual Amount Patterns

 1. Select View > By Employee, By Schedule Group, or By Employment Terms.
 2. Select a time period and locations. Click Apply.
 3. Right-click the employees, groups, or employment terms.

 4. Click  or More Actions  > Edit Accrual Patterns in the call out.
The table lists the employee’s active patterns for the loaded period from the oldest start date to the 
most recent.

 o For multiple employees, the table lists only those patterns that are active for all of the selected 
employees.

 o An employee can have multiple patterns active at the same time.

 o  Edit the pattern.

 o  Delete the pattern.
 o Pattern: Name of the pattern

 o Rotation: Summary of the pattern details; to see full details, click the Edit button  for the pattern.
 o If you selected multiple employees, click Selected Employees to see the list of employees. 

Accrual Amount Patterns
Accrual Amount Patterns contain an accrual code with an accrual amount that repeats daily or weekly. 
The accrual amount is negative, and the goal is to finish with a 0-hour balance at the end of each day or 
week. Example: —8 hours, Monday through Friday.

 l If employees have varied accrual targets, create a different pattern for each target amount. Assign 
each pattern to the employees. Example: The target for Monday, Wednesday, and Friday is —6; and 
the target for Tuesday and Thursday is —8.

 l You can use accrual amounts for any accrual grant. However, use pay code edits for vacation, sick, 
and other standard accrual types.

Flexitime accrual amounts 
When employees have flexible schedules, use a Flexitime accrual code to track the hours they are 
supposed to work against the hours they actually worked.
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 l Define the accrual codes in accrual rules.
 l Create an accrual pattern to select the Flexitime accrual code and assign the target hours that the 

employee is required to work. A Flexitime accrual code can have negative amounts.
For example, an employee can be assigned –80 hours over a two-week period or –8 hours a day. The 
employee works a varied number of hours each day, but the balance at the end of the two weeks is as 
close to zero as possible.
If an employee has a positive or negative balance of hours at the end of the Flexitime period, the 
Flexitime accrual rule determines how to handle the balance. Grants can be concurrent. For example, 
an employee can have a target of –80 for the Flexitime period, and a daily target of –8. 

Tip: You can use Accrual Amounts for any accrual grant. However, use pay code edits for 
vacation, sick, and other standard accrual types.

Core Hours 
Core hours are the hours when a Flexitime employee must be on the job. The employee can select when to 
work the remaining hours in their schedule.
Define core hours in Setup > Pay Policies > Pay Rules.

 l For example, an employee has an accrual grant of 8 hours a day with core hours from 10 a.m. to 2 p.m. 
A punch-in at 10:30 a.m., generates an exception on the time card.

 l The Flexitime accrual target is on the employee’s schedule.
 l Accrual amounts from fixed accrual grants are not in the schedule.

Create or edit an accrual amount pattern 
 1. Either

 o Click Add Pattern to create a new pattern.

 o Click the Edit button  for the pattern to edit.

Important: If you edit a pattern, that entire pattern is deleted, and the system regenerates the 
pattern from the start to end dates. If you removed an accrual from the pattern, the regenerated 
pattern restores it in the schedule even if only the end date changed.

 2. Define each accrual code edit:
 a. Select the Anchor Date. This is the start date of the repeating pattern, and it defines the first 

week of the pattern. This date must be on or before the Start Date.
 b. Select the Start Date. This is the date when the pattern starts to apply to the employees. It must 

be during the schedule period, and the schedule must be signed-off.
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 c. (Optional) Select an End Date. This is the date when the pattern no longer applies to the 
employees. Alternatively, select Forever, or leave the End Date undefined, so that the pattern 
continues indefinitely.

 d. Select the Accrual Code.
 e. Enter the Amount.
 f. To repeat the pattern, in Define Pattern For, enter up to 52 Weeks or up to 365 Days.
 g. (Optional) To replace any other pattern that has the same accrual code with this accrual pattern 

during the period of this pattern, select Override Other Patterns with the Same Accrual Code.
 h. Select the days to apply the pattern.
 i. Repeat for other dates or items.

 o To add another accrual amount edit, click . 

 o To delete an accrual amount edit, click .
 3. Click Apply.
 4. Roll out the pattern for the employees:

 a. Click OK.
 b. Click Save.

 o The pattern is rolled out from the start to the end date.
 o Existing accruals are not overwritten.
 o Existing accrual patterns are overwritten only if Override Other Patterns with the Same 

Accrual Code is selected.

Delete accrual amount patterns 

 1. Click Delete  for the pattern to delete.
 2. Click Yes to confirm.
 3. Repeat to delete other patterns.
 4. Click OK. The changes to the pattern are rolled out for the current schedule period.
 5. Click Save. All pattern-related accruals are deleted from the original start date or the last sign-off date 

to the end date.
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Edit Schedule Patterns

Schedule Patterns can be assigned to one or more employees, to a schedule group, or to a set of 
employment terms.
 1. Select View > By Employee, By Job, By Schedule Group, or By Employment Terms.
 2. Select a time period and locations. Click Apply.
 3. Right-click the employees, groups, or employment terms.

 4. Click Insert Schedule Pattern  in the call out or on the toolbar.
The table lists the employee’s assigned patterns for the loaded period from the oldest start date to the 
most recent.

 o For multiple employees, the table lists only those patterns that are currently assigned to all of the 
selected employees.

 o Employees can be assigned multiple patterns. Example: Employees can have weekday and weekend 
patterns.

 o  Edit a pattern.

 o  Delete a pattern.
 o Duration: Length of the pattern

 o Rotation: Summary of the pattern details; to see full details, click the Edit button .
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 o If you selected multiple employees, click Selected Employees to see the list of employees. 

Create and assign schedule patterns  
 1. Either:

 o Click Insert Schedule Pattern  on the toolbar.

 o Right-click the employees. Click Insert Schedule Pattern  in the call out.
 2. Click Add Pattern.
 3. Select the Anchor Date. This is the start date of the pattern, and it defines the first week of the 

pattern. This date must be on or before the Start Date.
 4. Select the Start Date. This is the date when the employees start to work the pattern. It must be during 

the schedule period, and the schedule must be signed-off.

Example: The pattern starts on a Sunday (Anchor Date), but an employee's first shift is on Monday 
(Start Date).

 5. (Optional) Select an End Date. This is the date when the pattern no longer applies to the employees. 
he schedule must be signed-off. Alternatively, select Forever, or leave the End Date undefined, so that 
the pattern continues indefinitely.

 6. In Define Pattern For, enter up to 52 Weeks or up to 365 Days to repeat the pattern.
 7. Click a date cell in the pattern:
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 o Add a shift that has no segments — Enter the start and end times directly in the cell.
 o Add shifts with segments — Click Add Shift. Enter the options — Edit Schedules on page 49.
 o Click Add Pay Code. Enter the options — Edit Pay Codes on page 64.
 o Select a Shift Template.
 o Select a Pattern Template.
 o Right-click a shift or pay code; select Copy or Cut. Right click an empty date cell; select Paste.

 8. (Optional):

 o Add a row — click . Enter the options.

 o Delete a row — click .
 9. (Optional) To override other patterns for the period from the start to the end date, select Override 

Other Patterns.

 o You can override only shifts or pay codes that are in patterns, not "ad hoc" shifts or pay codes that 
are not in patterns.

 o If a pattern adds shifts or pay codes to currently scheduled shifts or pay codes, the employees can be 
scheduled for multiple shifts or pay codes at the same time. 

 10. (Optional) Highlight all occurrences of specific shifts or pay codes that are in the pattern. Example: It 
can be difficult to see identical shifts in long patterns.

 o Click Items in Rotation.
 o Select or enter the shift or pay code. Click Find.

 11. Click Apply.
 12. Click OK. The pattern is rolled out for the current schedule period.
 13. Click Save. The pattern is rolled out from the start to the end date.

Edit schedule patterns  
 1. Either:

 o Click Insert Schedule Pattern  on the toolbar.

 o Right-click the employees. Click Insert Schedule Pattern  in the call out.

 2. Click the Edit button  for the pattern to edit.
 3. As needed, edit the following:
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 a. Select the Anchor Date. This is the start date of the pattern, and it defines the first week of the 
pattern. This date must be on or before the Start Date.

 b. Select the Start Date. This is the date when the employees start to work the pattern. It must be 
during the schedule period, and the schedule must be signed-off.

Example: The pattern starts on a Sunday (Anchor Date), but an employee's first shift is on 
Monday (Start Date) of that week.

 c. (Optional) Select an End Date. This is the date when the pattern no longer applies to the 
employees. he schedule must be signed-off. Alternatively, select Forever, or leave the End Date 
undefined, so that the pattern continues indefinitely.

 d. In Define Pattern For, enter up to 52 Weeks or up to 365 Days to repeat the pattern.
 e. Click a date cell in the pattern:

 o Add a shift that has no segments — Enter the start and end times directly in the cell.
 o Add shifts with segments — Click Add Shift. Enter the options — Edit Schedules on page 49.
 o Click Add Pay Code, or right-click a pay code and select Edit Pay Code. Enter the options — 

Edit Pay Codes on page 64.
 o Select a Shift Template.
 o Select a Pattern Template.
 o Right-click a shift or pay code; select Copy or Cut. Right click an empty date cell; select 

Paste.
 o Right-click a shift or pay code; select Delete.

 f. (Optional):

 o Add a row — click . Enter the options.

 o Delete a row — click .
 g. (Optional) To override other patterns for the period from the start to the end date, select Override 

Other Patterns.

 o You can override only shifts or pay codes that are in patterns, not "ad hoc" shifts or pay codes 
that are not in patterns.

 o If a pattern adds shifts or pay codes to currently scheduled shifts or pay codes, the employees 
can be scheduled for multiple shifts or pay codes at the same time. 

 h. (Optional) Highlight all occurrences of specific shifts or pay codes that are in the pattern. 
Example: It can be difficult to see identical shifts in long patterns.
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 o Click Items in Rotation.
 o Select or enter the shift or pay code in the drop-down list. Click Find.

 4. Click Apply.
 5. Click OK. The pattern is rolled out for the current schedule period.
 6. Click Save. The pattern is rolled out from the start to the end date.

Delete schedule patterns  
You can delete a schedule pattern from the original start or latest sign-off date to the end date of the 
pattern.
 1. Either:

 o Click Insert Schedule Pattern  on the toolbar.

 o Right-click the employees. Click Insert Schedule Pattern  in the call out.

 2. Click the Delete Row button  for the pattern to delete.
 3. Click Yes to confirm.
 4. Repeat to delete another pattern.
 5. Click OK. The changes to the pattern are rolled out for the current schedule period.
 6. Click Save. All pattern-related shifts are deleted from the original start date or the last sign-off date to 

the end date.
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Show a Schedule Outline

Summarize the read-only schedule of one employee at a time: shift segments and the pattern an employee 
works, including variations.
 1. Right-click one employee.

 2. Click  or More Actions  > View Schedule Outline in the call out.

 o Name: 
 l Shift label
 l Name of pay code, pattern, or accrual

 o Type: Type of schedule item such as shift, pay code, schedule pattern, accrual amount, accrual 
pattern

 o Start Date: 
 l Start date of a shift or pattern
 l Effective date of a pay code or accrual amount

 o End Date: 
 l End date of a shift or pattern
 l Effective date plus the hours amount of a pay code or accrual amount

 3. Click OK.

78



Manage Availability 

Display, assign, override, and change employee Availability.

Availability types

Employee availability types and color codes:

 l Available — Employee is available to work during this time.

 — Green
 l Preferred — Employee prefers to work during this time. Employees indicate when they prefer to 

work. Preferred availability can be assigned only to employees, not to locations and not globally.

 — Dark green  
 l Preferred Time Off — Employee prefers not to be scheduled during this time. Preferred Time Off 

availability can be assigned only to employees, not to locations and not globally.

 — Purple
 l Unavailable — Employee is not available to work. If employees are scheduled when unavailable, the 

system can generate a schedule rule violation. 

 — Gray
 l Unknown — Employee is not certain about their availability. If employees do not know their 

availability but want to be considered for work, enter their availability as Unknown.

 — White 

Availability levels 

All employees have an availability level. If no availability is defined for the employee or location, the 
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employee is assigned to the global default availability.
Higher levels of availability override lower levels.
Employee Override — Temporarily overrides base employee availability during a time period. 

 l Overrides all other availability levels that are assigned to the employee — employee, location, and 
global — for a specified period of time. Changes to lower levels of availability do not affect override 
availability. 

 l When the override period ends or when you delete an override, the underlying, lowest-level, base 
pattern availability is reinstated.

Methods to define an override, depending on whether the override has a recurring pattern:

 l Define or modify a recurring override pattern.
 l Override availability temporarily for a single period that does not repeat, for a period as short as one 

day, or that repeats without any pattern.
 l Create a pattern to override availability for a longer time period.
 l All methods are at the same level in the availability hierarchy. If two overrides for the same employee 

overlap in time, only the last one created is retained for the period of the overlap; the previous override 
is deleted for the period of the overlap.

Note: Your system may include pay codes defined with availability. Example: A vacation pay code 
could automatically change an employee's availability to Unavailable. Pay code availability behaves 
like an employee override. If a pay code availability overlaps an employee override on the same 
employee overlap in their period, the last one applied takes effect.

Employee base pattern — Defines the default or normal availability of an employee. 

 l Overrides location and global availability. Changes to location or global availability do not affect 
employee availability.

 l An availability template can define an employee’s availability.
 l An employee’s base pattern can be for a specified period, or can continue indefinitely. 
 l Base patterns can be chained to apply in sequence. If two base patterns overlap in time, the later one 

overwrites the earlier one for the overlap. 
 l The employee base pattern supersedes location or global availability for the period specified in the base 

pattern. Changes to location or global availability do not affect an employee’s base pattern.
 l Define or modify an employee base pattern availability.

Note: Employee availability always overrides location availability. Changes to location-level 
availability affects only employees who do not have employee-level or employee override 
availability.

If you remove employee availability:
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 l Location availability takes priority.
 l If location availability is not defined, global availability takes priority.
Location — Defines availability for a location (and the child locations) in the organizational map. 

 l Use the availability template to define availability of all employees at a location and of all child 
locations. All employees whose primary job is in these locations inherit that availability pattern. 

 l Location availability overrides global availability. Changes to global availability do not affect location 
availability.

 l All employees at that location who do not have an employee availability defined for a given period 
inherit this availability pattern for that period. 

 l You must use an availability template to define a location availability.
Global — Organization-wide default setting that assigns one availability to all employees, 24 hours a day, 
7 days a week. 
Global availability can be Unknown, Available, or Unavailable, but not Preferred and not Preferred Time 
Off. If not defined, Global availability defaults to Unknown.
Any employee who does not have a location or employee availability defined for a given period inherits the 
global availability for that period. 

Pay codes and availability

Pay Codes can be configured to automatically affect an employee’s availability. Pay code availability 
behaves like an employee override.
Examples:

 l A vacation pay code could automatically change an employee's availability to Unavailable.
 l Enter a pay code for sick time. Change the employee’s availability to unavailable for 24 hours, while 

the pay code accrues for 8 hours.
 l If a full-time employee is on vacation for a week, enter the vacation pay code. Indicate that the 

employee is unavailable 24 hours a day for the 5 vacation days. However, the employee is debited only 
8 hours a day for vacation.

The Staffing Assistant and availability

If configured, the Staffing Assistant uses availability to rank employees who are qualified to work an open 
shift. It can sort employees by the amount of time that they are available to work a shift.

 l Yes — The employee can work the whole shift.
 l A time range — The employee can work during those hours.
 l No — The employee is unavailable for the whole shift.
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Show availability
You can display employee availability in 1-Hour, 4-Hour, or 15-Minute intervals views.

 1. Click Gantt View  on the toolbar.
 2. Select View > By Employee, By Schedule Group, or By Employment Terms.
 3. Select a time period and locations. Click Apply.

 4. In the toolbar, click the Visibility Filter .

 a. Select Employee Availability.
 b. Select the interval: Daily, 4 hours, 1 hour, or 15 minutes.
 c. Select Employee Availability and the availability types to show: Available, Preferred, 

Preferred time off, Unavailable.

Note: Availability is updated every 15 minutes.

 d. (Optional) To hide availability, clear the availability types.

Show availability patterns
 1. Select View > By Employee, By Schedule Group, or By Employment Terms.
 2. Right-click employees.

 3. Click Availability Pattern  in the call out.
The table lists the active patterns for the employees during the loaded schedule period. Multiple 
patterns can be active at the same time.

 o Click a column heading to sort the patterns.

 o  Edit a pattern.

 o  Delete a pattern.
 o If you selected multiple employees, click Selected Employees to see the list of employees. 

Edit availability

Create base or override availability patterns 

 1. In the Availability editor, click Add Pattern.

 2. To insert an availability pattern, click .
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 3. Enter a Pattern Name up to 30 characters long.
 4. Select an Anchor Date to establish the start date of the pattern.
 5. Select a Pattern Type:

 o Base — Default or normal availability of employees
If base patterns overlap in time, the later pattern overwrites the earlier pattern during the overlap.

 o Override — Temporary override of the base availability of employees
Example: An employee changes from part-time to full-time to accommodate a temporary change in 
staffing requirements. Override the employee’s availability pattern for that period of time. When the 
staffing requirements return to normal, edit the override to end the pattern. The base pattern takes 
effect when the override ends.

 6. Select an Availability Start Date when the availability pattern takes effect. It can differ from the 
Anchor Date. This date cannot be before the employee’s sign-off date in the time card.

 7. Select an End Date or, to repeat the pattern indefinitely, select Forever.
 8. In Define Pattern for, enter the number of and select Weeks or Days. Maximum = 52 weeks or 365 

days.
 9. (Optional) Select an availability pattern from Insert Template. The template overwrites the pattern 

name and dates. You can edit any parameters of the pattern.
 10. Select the days to apply the availability pattern:

 o For an entire day or days — Click and drag to select a range of days, or press Ctrl and click to 
select non-contiguous days. Select an availability type.

 o By whole or half hour increments — Click Hourly View. Select the segments. Click an 
availability type. Click Apply.

 o For part of an hour — Click Hourly View. Enter the Start and End Times in as small as one 
minute intervals. Select the availability Type. Click Apply.

 11. To insert another availability pattern, click .

 12. To delete an availability pattern, click .
 13. Click Save.

Override availability patterns for a short time

Override an employee’s availability temporarily for a few days for a one-time event that does not involve a 
pay code. If you use pay codes that affect availability, do not use an override because the pay code adjusts 
the availability.

Tip: Alternatively, you can change availability temporarily by a pay code for short-term leave.

Example, an employee is not available for a holiday.
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The base, location, or global availability pattern takes effect when the override ends.
 1. Right-click an empty date cell.
 2. Enter a Pattern Name up to 30 characters long. Default = Override_{date}
 3. (Optional) Change the Number of Days. This value is continuous; it does not skip holidays or 

weekends.
 4. Click and drag to select a range of time.
 5. Select an availability type.
 6. Click Save.

Edit availability patterns permanently 

Permanently change an availability pattern for employees.
Example: An employee changes from part-time to full-time employment. 

Important: When you edit an availability pattern, you cannot restore the original pattern for that time 
period.

 1. In the Availability editor, click  to edit a pattern.
 2. Edit:

 o Enter a Pattern Name up to 30 characters long.
 o Edit the Anchor Date to establish the start date of the pattern.
 o In Pattern Type, select Base. If base patterns overlap in time, the later pattern overwrites the earlier 

pattern during the overlap.
 o Edit the Availability Start Date when the availability pattern takes effect. It can differ from the 

Anchor Date. This date cannot be before the employee’s sign-off date in the time card.
 o Edit the End Date or, to repeat the pattern indefinitely, select Forever.
 o In Define Pattern for, enter the number of and select Weeks or Days. Maximum = 52 weeks or 365 

days.
 o (Optional) Select an availability pattern from Insert Template. The template overwrites the pattern 

name and dates. You can edit any parameters of the pattern.
 o Select the days to apply the availability pattern:

 l For an entire day or days — Click and drag to select a range of days, or press Ctrl and click to 
select non-contiguous days. Select an availability type.

 l By whole or half hour increments — Click Hourly View. Select the segments. Click an 
availability type. Click Apply.
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 l For part of an hour — Click Hourly View. Enter the Start and End Times in as small as one 
minute intervals. Select the availability Type. Click Apply.

 o To insert another availability pattern, click .

 o To delete an availability pattern, click .
 3. Click Save.
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Chapter 3  

Manage Rule Violations

From the schedule
In the schedule, an exclamation point indicates employees who have Rule Violations.

 l ! Red — At least one violation has a severity of No Save.
 l ! Orange — No violations have a No Save severity, but at least one has a Warning severity.
 l ! Yellow — No violations have a No Save or Warning severity, but at least one has an Informational 

severity.
If the exclamation point has an asterisk (*), the employee has more than the configured Maximum Number 
of Violations Per Employee.
To see detailed information about the most severe violation, click an exclamation mark.

Show all rule violations
The Rule Violations widget part lists employee and organizational rules that the schedule violates — up to 
200 violations, up to 10 for each employee or job.
 1. Select View > By Employee, By Job , By Schedule Group , or By Employment Terms.
 2. Select a time period and locations. Click Apply.
 3. Select the Rule Violations tab.
 4. To change the sort order, click a column header.

 5. To reduce the number of columns, click Filter . Clear the columns to hide.
 6. To resolve a violation, select an employee.



If the exclamation point has an asterisk (*), the employee has more than the configured Maximum 
Number of Violations Per Employee.

Schedule rule severity levels

 o No Save — The schedule cannot be saved with this severity of rule violation.
 o Warning — You can save the schedule and continue without responding to the violation.
 o Informational — A rule has been broken, but at the lowest level of severity. You can save the 

schedule and continue without responding to the violation.
 o Not Considered — This rule is not checked.

 7. Click Save.

 8. To update the list, click  in the schedule.
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Edit Multiple Schedules

Use the Multi-Edit action to edit schedules for a group of employees. 

Important: Your display access profile and function access profile must be configured to use all 
functions of the Multi-Edit action, and to modify employees and shifts. Contact your system 
administrator.

Important: You cannot edit shifts that are locked or during locked days.

 1. Select View > By Employee, By Job, By Schedule Group, or By Employment Terms.
 2. Select a time period and locations. Click Apply.

 3. Select the Tools , then select Multi Edits. 
 4. Either:
 2. Either:

 o Filter employees

 a. From Context, select Filtering Employees.
 b. From Filter By, select either:

 l All Employees – Employees regardless of availability.
 l Available Availability – Employees whose availability is Available or Preferred.
 l Hire Date – Employees by the date they were hired.
 l Preferred Availability – Employees whose availability is Preferred.
 l Unavailable Availability – Employees whose availability is Unavailable.
 l Unknown Availability – Employees whose availability is Unknown.

 c. From Operator:

 a. For Availability (Available, Preferred, Unavailable, Unknown), select either:

 l Overlaps – Select only employees whose availability setting occurs during the date and 
time that you selected.

 l Does not overlap – Select only employees whose availability setting does not occur 
during the selected date and time. Not available for filter by All Employees.

 b. For Hire Date, select either:
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 l Equal to – Select only employees who were hired on the selected date or time.
 l Not equal to – Select only employees who were not hired on the selected date or time.
 l Greater than – Select only employees who were hired after the selected date or time.
 l Greater than or equal to – Select only employees who were hired on or after the 

selected date or time.
 l Less than – Select only employees who were hired before the selected date or time.
 l Less than or equal to – Select only employees who were hired on or before the selected 

date or time.
 d. Enter the date or time:

 a. For Availability:

 l Select or enter a Date that is during the time period of Scheduler.
 l Enter two times separated by a hyphen in Time Period. Example: Enter 8a-4p. The time 

period cannot be longer than 24 hours. See Formats on page 329 for formatting 
information.

 b. For Hire Date, select or enter the Hire Date.

Note: You can select more than one filter option, but the options must make sense together 
in order to see results.
Example: Available, Availability and Hire Date.

 a. From Context, select Filtering Employees.
 b. From Filter By, select either:

 l All Employees – Employees regardless of availability.
 l Available Availability – Employees whose availability is Available or Preferred.
 l Hire Date – Employees by the date they were hired.
 l Preferred Availability – Employees whose availability is Preferred.
 l Unavailable Availability – Employees whose availability is Unavailable.
 l Unknown Availability – Employees whose availability is Unknown.

 c. From Operator:

 a. For Availability (Available, Preferred, Unavailable, Unknown), select either:

 l Overlaps – Select only employees whose availability setting occurs during the date and 
time that you selected.
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 l Does not overlap – Select only employees whose availability setting does not occur 
during the selected date and time. Not available for filter by All Employees.

 b. For Hire Date, select either:

 l Equal to – Select only employees who were hired on the selected date or time.
 l Not equal to – Select only employees who were not hired on the selected date or time.
 l Greater than – Select only employees who were hired after the selected date or time.
 l Greater than or equal to – Select only employees who were hired on or after the 

selected date or time.
 l Less than – Select only employees who were hired before the selected date or time.
 l Less than or equal to – Select only employees who were hired on or before the selected 

date or time.
 d. Enter the date or time:

 a. For Availability:

 l Select or enter a Date that is during the time period of Scheduler.
 l Enter two times separated by a hyphen in Time Period. Example: Enter 8a-4p. The time 

period cannot be longer than 24 hours. See Formats on page 329 for formatting 
information.

 b. For Hire Date, select or enter the Hire Date.

Note: You can select more than one filter option, but the options must make sense together 
in order to see results.
Example: Available, Availability and Hire Date.

 o Filter shifts

 a. Select the locations:

 l Only shifts that are completely or partially worked at selected locations – Select Selected 
Locations in Show. Navigate to and select the organizational locations.

 l All shifts that are in Scheduler, whether transfers or not – Select a HyperFind query in Show.
 b. From Context, select Filtering Shifts.
 c. From Filter By, select either:

 l All Shift — Select employees from all shifts.
 l End Date – Select employees by the end date of assigned shifts.
 l End Time – Select employees by the end time of assigned shifts.
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 l Shift Period – Select employees by any time during the time span of assigned shifts.
 l Start Date – Select employees by the start date of assigned shifts.
 l Start Time – Select employees by the start time of assigned shifts.

 d. From Operator:

 a. For End Date, End Time, Start Date, or Start Time, select either:

 l Equal to – Select only employees who are assigned shifts that start or end on the date and 
time that you selected.

 l Not equal to – Select only employees who are assigned shifts that do not start or end on 
the selected date or time.

 l Greater than – Select only employees who are assigned shifts that start or end after the 
selected date or time.

 l Greater than or equal to – Select only employees who are assigned shifts that start or 
end on or after the selected date or time.

 l Less than – Select only employees who are assigned shifts that start or end before the 
selected date or time.

 l Less than or equal to – Select only employees who are assigned shifts that start or end 
on or before the selected date or time.

 b. For Shift Period, select Includes to select only employees who are assigned shifts that span 
the selected time.

 e. Enter the time or date:

 a. Select a End or Start Date that is during the time period of Scheduler. Multi-Edit cannot 
modify shifts that overlap from a previous day that is not selected. The first segment must 
start during a selected day.

 b. For End or Start Time or Shift Period, enter the time. See Formats on page 329 for formatting 
information.

Note: You can select more than one filter option, but the options must make sense together in 
order to see results.
Example: Start Date on or after 3/1/2015 and End fate on or before 3/3/2015.

 a. Select the locations:

 l Only shifts that are completely or partially worked at selected locations – Select Selected 
Locations in Show. Navigate to and select the organizational locations.

 l All shifts that are in Scheduler, whether transfers or not – Select a HyperFind query in Show.
 b. From Context, select Filtering Shifts.
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 c. From Filter By, select either:

 l All Shift — Select employees from all shifts.
 l End Date – Select employees by the end date of assigned shifts.
 l End Time – Select employees by the end time of assigned shifts.
 l Shift Period – Select employees by any time during the time span of assigned shifts.
 l Start Date – Select employees by the start date of assigned shifts.
 l Start Time – Select employees by the start time of assigned shifts.

 d. From Operator:

 a. For End Date, End Time, Start Date, or Start Time, select either:

 l Equal to – Select only employees who are assigned shifts that start or end on the date and 
time that you selected.

 l Not equal to – Select only employees who are assigned shifts that do not start or end on 
the selected date or time.

 l Greater than – Select only employees who are assigned shifts that start or end after the 
selected date or time.

 l Greater than or equal to – Select only employees who are assigned shifts that start or 
end on or after the selected date or time.

 l Less than – Select only employees who are assigned shifts that start or end before the 
selected date or time.

 l Less than or equal to – Select only employees who are assigned shifts that start or end 
on or before the selected date or time.

 b. For Shift Period, select Includes to select only employees who are assigned shifts that span 
the selected time.

 e. Enter the time or date:

 a. Select a End or Start Date that is during the time period of Scheduler. Multi-Edit cannot 
modify shifts that overlap from a previous day that is not selected. The first segment must 
start during a selected day.

 b. For End or Start Time or Shift Period, enter the time. See Formats on page 329 for formatting 
information.

Note: You can select more than one filter option, but the options must make sense together in 
order to see results.
Example: Start Date on or after 3/1/2015 and End fate on or before 3/3/2015.

 5. Click Search.
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 6. To remove filters select the row and click Remove .

To refine the filter, change your filter by criteria by adding a row click , add additional filter criteria, 
remove all filter criteria. 
select the same or different Context, and repeat with other search criteria.

 7. Click Search.

 8. Select employees or shifts
The table displays the employees or shifts that the search found. 

 o Employees – All employees who are scheduled, who signed off their schedule, or who do not have a 
Scheduler license. Excludes employees who are not employed during the entire time period of the 
schedule.

 o Shifts, does not display:

 l Shifts that are Unavailable or Off
 l Pay codes
 l Accruals
 l Shifts that are assigned to employees who do not have a Scheduler license, or who are not 

employed.

 o To change the sort order, click a column heading.
 o Select the items to edit.

 l To select all items, click Select All.
 l To de-select all selected items, click Clear.

 9. Modify employees or shifts

 o Either:

 l If you filtered employees:

 a. Select Action > Override Availability.
 b. Select the Availability Type to override.
 c. Select or enter a Date that is during the time period of Scheduler.
 d. Enter the Time Span during which to override the availability. Enter two times sepperated by 

a hyphen(-).
Examples: 8a-4p or 800-1600

 l If you filtered shifts:
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Select Action and either:

 l Assign Breaks – Assigns and distributes breaks during the shifts according to break rules.
 l Change Shift Label – Enter a Shift Label or a blank label to delete the current labels. See 

Shift Label Formats on page 330 for formatting information.
 l Modify Start Time – Enter a Start Time.
 l Modify End Time – Enter an End Time that is after the start time.
 l Offset Whole Shift – Moves the start and end times but does not change the length of the 

shift. Enter a Duration – a negative value moves the shift earlier; a positive value moves the 
shift later. An offset cannot be greater than 24 hours.

 l Delete Shift – Deleting shifts can cause rule violations.
 l Insert Transfer – Changes organizational job, labor account, or work rule during a time 

period that overlaps the employee’s shift. Select a Transfer, or click Search to create a 
transfer. Enter the Start and End Times. If the transfer is before or after the start or end time, 
it is lengthened accordingly. 

 l Note: If you do not select a transfer job, the transfer defaults to the primary job.

 l Important: You cannot move a shift beyond the selected time period in Scheduler.

 l You can Sort any of the results in columns.
 l You can also change the width of any column by dragging the column border in the header. To 

retuen the columns to their default size double-click in the column header area.
 o Click Apply.
 o If the modification fails, the results will be highlighted in purple. Hover the cursor over the item for 

a tool tip of reasons the modification failed. If the modification is successful, results will be 
highlighted in orange.

 10. If shift lengths are also altered, click Assign Breaksaction .
 11. The selections in the Multi-Edit dialog remain. If needed, modify for another edit or search again. Click 

Done.
 12. Save the schedule when all edits are completed.
 13. Refresh the schedule to undo any multi-edit actions.
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Unassign Employees from Shifts

When you unassign employees from shifts, the shifts become Open Shifts that keep the same job 
assignment and times as the original shift.
 1. Select View > By Employee, By Job , By Schedule Group , or By Employment Terms.
 2. Select a time period and locations. Click Apply.
 3. Right-click an assigned shift. You cannot unassign a shift that is locked, signed off, during a locked 

day, or during an Off or Unavailable period.

 4. Click Unassign  in the call out.
 5. In the widget, click Save.

96



Post Schedules

When a manager posts a schedule, employees can see the posted part of the schedule and can request 
changes to that part of the schedule.

Show posted and unposted schedules
 1. Select View > By Employee, By Job , By Schedule Group , or By Employment Terms.
 2. Select a time period and locations. Click Apply.

 3. Select Tools  > Manage Schedule Posts in the toolbar.
 4. Audit displays posted and unposted schedules for the selected location and time period, including 

schedules that the Auto-Scheduler automatically posted. 
Status — Posted or Unposted
Date and Time — When the schedule was posted or unposted
User — The manager who posted or unposted the schedule
Location — The organizational location of the schedule
Job — The posted or unposted job
Date Range — Date range of the schedule

 o (Optional) Select another location in Filter by Location.
 o To change the sort order of the list, click a column heading.
 o To show details in a tool tip, hover the pointer over a cell.

Post schedules
 1. Click Post. The system posts all jobs at the location and during the time period, including empty cells.

 o If part of the location or period was already posted, the schedule can get complicated when you 
unpost the schedule.

 o Only if you use the forms-based (Process Manager) version of ESS: Do not post a schedule during 
an open sign-up period. If you do, employees cannot sign up for shifts.

 2. Click Yes to confirm.
 3. Click Done.
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Unpost schedules
When a manager unposts a schedule, employees can no longer see the posted part of the schedule (unless 
their access profile allows them to see unposted schedules) and cannot request changes to that part of the 
schedule.
 1. Select posted schedules that start tomorrow or later and do not end today. 

If you unpost schedules that include today, shifts and pay codes that start today or started yesterday or 
earlier remain posted even if they extend to tomorrow.

 2. Click Unpost.
 3. Click Yes to confirm.
 4. Click Done.
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Chapter 4  

Manage Open Shifts

An Open Shift is a shift that is scheduled for a job, but no employee is assigned to work it.
 1. Either:

 o Select View > By Employee, By Schedule Group, or By Employment Terms.
Open Shifts are red and in the top row of the schedule.
The numbers indicate the number of open shifts on that day or zone.

 l To show the open shifts, click the Open Shifts right arrow .

 l To collapse the open shifts, click the Open Shifts down arrow .
 o Select View > By Job.

Open shifts are red and are in each job for each day that has open shifts.
 2. Select a time period and locations. Click Apply.
 3. If you don't see open shifts, either:

 o Open shifts are hidden. Click the Visibility Filter . Select Show Open Shifts.
 o None are in the schedule.

You cannot edit items on signed-off days.



Create open shifts
 1. Right-click an empty date cell in the open shift area.

Alternative: You can copy assigned shifts to create open shifts that have the same attributes 

except that no employees are assigned. Right-click the shift. Click Copy  or Cut . Right-
click an empty date cell in the open shift area. Click Paste .

 2. Click Add Shift  in the call out.

 o  — Insert a shift segment

 o  — Delete a shift segment
 o Alternatively: 

 o Rather than enter times and durations in the table, you can edit by 15-minute intervals in the 
graphical view of the shift. 

 o Click and drag the edges or the arrows below the edges of the segments. 

 o To add a segment to the start or end of the shift, click . Click and drag the red edge or arrows 
to adjust.
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 o To delete the new segment, click  .
 3. (Optional) In Assigned to, select an employee.

You cannot add open shifts to a schedule group or employment terms.
 4. (Optional) Select a Shift Template.
 5. (Optional) Enter a Shift Label.

Important: Shift labels do not change if you edit a shift.
Example: If the shift label is 7a3p, and a manager changes the end time to 4 p.m., the label does not 
change and it no longer reflects accurately the underlying shift.

See Shift Label Formats on page 330 for formatting information.
 6. Enter the number of consecutive days to Repeat this shift. This value is in continuous days and does 

not skip holidays or weekends.
 7. Define each segment:

 a. Select the Start Date.
 b. Select the Type (Regular (primary job), Break, or Transfer) of shift segment.
 c. Enter the Start and End Time. The maximum length of a shift is 24 hours.

See Formats on page 329 for formatting information.
 d. If available, select the End Date.
 e. Duration displays the total length. To change the Duration, edit the Start or End Time.
 f. If the segment is a Transfer, select or click Search:

 o Job —  Select or search for a Job Transfer from the Organizational Map. Access to Perform 
Job Transfers must be enabled.

 o Labor —  Enter the labor account number or short name, or search for and select the labor 
level. Access to Perform Account Transfers must be enabled.

 o Work Rule —  Enter the name or search for and select the work rule. Access to Perform Work 
Rule Transfers must be enabled.

Note: A transfer is not valid for Breaks.
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 g. If available, select a Skill & Certification Profile to apply to regular or transfer segments. To 
select from all available profiles, select Search. Select the profiles. Click the arrow keys. Click 
OK.

 h. If available, select Details.

 i. To add another segment, click .

 o If you add a segment in between segments, the Duration defaults to 0.
 o If you add a segment after the last segment, the Duration defaults to 1 hour.
 o To change the Duration, edit the Start or End Time.

 8. (Optional) Add comments and notes:

 a. Click Add Comment.
 b. Select a comment.
 c. Enter text in a Note. Click Add.

The shift displays a Comment icon . 

 9. Click Apply.
 10. In the widget, click Save.
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Create open shifts from shift templates
 1. Right-click an empty date cell in the open shift area.

 2. Click Insert Shift Template  in the call out.
 3. Select the template.

Tip: If you know the name of the template, you can enter it. Search filters for matching templates 
as you type.

 4. Click Apply.
 5. In the widget, click Save.
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Edit open shifts
 1. Right-click an open shift.

 2. Click Edit Shift  in the call out.
 3. Edit the available options as needed.
 4. Click Apply.
 5. In the widget, click Save.
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Assign open shifts
 1. Right-click an open shift.
 2. In Assigned to, select an employee.
 3. (Optional) You can change any of the available options.
 4. Click Apply.
 5. In the widget, click Save.
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Calculate Open Shifts 

Calculate Open Shifts (COS) creates Open Shifts that cover shortages in the required workload from the 
Workload Planner. COS removes existing open shifts that have been covered by scheduled shifts.

Important: Calculate Open Shifts creates shifts only from shift sets. To create open shifts from labor 
volumes or schedule zones, use the Schedule Generator.

Important: Do not use COS during a request period because it increases the coverage requirement by 1.

 Example: With a coverage shortage of 1, COS increases the shortage to 2. Two employees can then sign 
up for the shift and cause overcoverage.

 1. Select View > By Employee, By Job, By Schedule Group, or By Employment Terms.
 2. Select a time period and locations. Click Apply.

 3. Click Engines  and select Calculate Open Shifts from the toolbar.

Tip: By default if existing shifts identically cover the required workload, COS does not create open 
shifts but considers those existing shifts. To allow COS to consider shifts that partially cover the 
workload, configure COS system settings.

Open shifts are red and at the top of the schedule.
 4. Click Save.
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Assign Open Shifts with the Staffing Assistant

Use the Staffing Assistant to find the most appropriate employee to work an open shift, or replace an 
employee who can no longer work a shift.
 1. Select View > By Employee, By Job, By Schedule Group, or By Employment Terms.
 2. Select a time period and locations. Click Apply.
 3. Select the Staffing Assistant tab.
 4. Either:

 o Select an Open Shift from the Staffing Assistant or the schedule.
 o Replace an employee who can no longer work a shift. Select the shift from the schedule.

 5. Click Find Replacement  in the call out. 
 6. (Optional) Select another Location.
 7. Select Criteria or a Procedure Set. 

To use SMS Quick Fill or Mobile Scheduler, select a Procedure Set.
 8. Click Load.

The table displays qualified and available employees in the order of best match. The table columns 
come from the linked column set.

 o For a criteria set, the column set is defined by the Staffing Assistant Genie. A star indicates 
employees who fulfill all criteria.

 o For a procedure set, the column set is defined by the procedure set.

 l If the procedure set is not linked to a column set, the column set for the configured schedule 
Genie is used.

 l If that Genie is not specified, the column set that is configured for the Schedule Planner widget is 
used.

 o No. — Rank as sorted by the Staffing Assistant
 o To see details in a tool tip, hover the pointer over the cell.
 o To change the sort order, click a column header.

 9. Filter employees
(Optional) Refine the list of employees:
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 o Click Filter .
 o Select one of:

 l Filter on Job — Include only employees who match the job of the shift with a primary or transfer 
job. The filter shows the employee’s primary job even if the employee matches a transfer job.

 l Availability Percent — Enter a number from 0 to 100 to filter only employees who match an 
availability percentage of the shift.

 l Include Unknown — Select to include employees whose availability is unknown, and consider 
these employees as 100% Available.

 l Skills — Filter employees who have all or some skills. Select a skill. Click Add.
 o To display the list without the filter, clear all criteria settings.
 o To create a newly filtered list, clear all criteria settings. Repeat.
 o Click OK.

 10. Contact employees
If SMS Quick Fill or Mobile Scheduler is configured, offer the shift directly to the employees. 
Otherwise, contact the employees by phone, email, or in-person.

 a. Click Contact .

 b. If SMS Quick Fill is configured

 o Select how to assign the open shifts:

 l Assign to First to Accept – Assigns shifts in the order that employees accept
 l Offer to All, Assign by Match Order – Enter the Wait Time (minimum = 1 minute). 

Offers the shifts to all selected employees at once. After the Wait Time expires, assigns 
shifts by match order to employees who accepted. The Wait Time starts when you click 
Send.

If Mobile Scheduler is configured

 o Select how to assign the open shifts:

 l Assign to First to Accept — Assigns shifts in the order that employees accept
 l Offer to All, Assign by Match Order — Enter the Wait Time (minimum = 1 minute). 

Offers the shifts to all selected employees at once. After the Wait Time expires, assigns 
shifts by match order to employees who accepted. The Wait Time starts when you click 
Send.

 l Call Sequentially by Priority — Notifies employees about open shifts by contacting 

108



employees one at a time, in order from the list. Enter the number of minutes to wait between 
calls to employees who do not respond.
The first employee on the list is notified about an open shift. If the employee does not 
respond or declines the shift, the next employee is notified; and so on. When an employee 
does not respond, the system will call the next employee after waiting the number of minutes 
in the wait time.

Tip: To configure the system to call the next employee immediately after the previous 
employee has not responded or has declined a shift, set the wait time to 0.

When an employee accepts the shift, no additional notifications are sent to other employees 
on the list.

 c. (Optional) Select a Comment.
 d. Click Send.

Tip: Because the speed of SMS or IVR messages can vary by message or telecommunications 
carrier, employees may not receive all messages at the same time or in the same order. 
Normally, employees receive messages within a minute of transmission. However, several 
minutes can pass before receipt of a message. If latency is a concern, select Offer to All, 
Assign by Match Order, because you can set the wait time to be long enough to compensate 
for variations in transmission time.

To track responses, see Track Contacts and Responses on page 110.

 11. When an employee accepts to work the shift, click Assign Shift  in the row for that employee.
 12. If break rules are violated, reassign the breaks:

 o Right-click the shift.

 o Click Assign Breaks  in the call out.
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Track Contacts and Responses

Track employee responses to offers to work open shifts that you sent from SMS Quick Fill or Mobile 
Scheduler.
 1. Select View > By Employee, By Job , By Schedule Group , or By Employment Terms.
 2. Select a time period and locations. Click Apply.
 3. Select the Staffing Assistant tab.

 4. Click Contact Tracking .
Contact Tracking shows employee responses until the open shift request is filled or the shift is 
canceled.
(Optional) Search for a specific Employee.
(Optional) Select another Time Period. Click Load.
(Optional) To show shift details in a tool tip, hover the pointer over a Contact Date and Time.

 o Status:

 l In Queue — The call is ready to go to the employees. If the status does not change, 
communication may be interrupted.

 l In Progress — The call was sent to the employees, and the system is waiting for responses.
 l Accepted — One or more but not all employees accepted the request.
 l Completed — The call was sent, some employees responded, and all open shifts were assigned.
 l Partially Completed — Applies only to requests to fill multiple identical shifts. The call was 

sent. At least one shift was assigned, but at least one shift remains open. The task is no longer in-
progress because all employees responded, or the shift end time passed. Check the audit.

 l No Response — An employee responded after the request is filled, or the shift is canceled.
 l System Canceled — One of the following occurred:

 l The call could not be sent because of a configuration error such as an incorrect email address.
 l The call was sent and all employees responded, but no shifts could be assigned.
 l The call was sent, but the shift end time passed with no shifts awarded.

Check the audit.

 o  Contact Details — Click to show Details about the open shift, the employees who were 
contacted, and how to assign the shift. Click OK.

 o  Audit — Click to show the Audit of the shift offer: the order in which employees were 
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contacted, the medium of contact, contact details such as a phone number, when the message was 
sent and responded to, the status of the reply, and the outcome of the task. You can Print the audit. 
Click OK.

 5. Click OK in Contact Tracking.
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Assign Open Shifts with the Priority Scheduling 
Engine

The Priority Scheduling Engine (PSE) assigns Open Shifts to employees according to configured rules that 
can be based on production schedules, labor standards, employee requests. Use the PSE to create or edit 
schedules. The PSE ignores employees who do not have a valid Scheduler license.
 1. Select View > By Employee, By Job, By Schedule Group, or By Employment Terms.
 2. Select a time period and locations. Click Apply.
 3. Lock all shifts, pay codes, or days that you do not want to change.
 4. Click Save.

 5. Click Engines  and select Run Priority Scheduling Engine from the toolbar.
 6. From Run, select a Procedure Set. 
 7. To select a shorter time period, change the Start or End Date.
 8. Click Start.

 o If the status bar is moving, the PSE is running normally.
 o If the status bar is empty, the PSE hasn’t started, is stopped, or is finished.
 o The status bar can stop moving for short periods if the PSE is processing many employees. If the 

status bar stops moving for several minutes, the PSE may be frozen. Click Close. Click Start again.
 9. To stop the PSE while it runs, click Stop. If you stop the PSE while others use it, you do not affect their 

processing.
 10. When the PSE finishes, review and compare the shift assignments:

 o The list is sorted by date then employee name. To change the sort, click the Date, Name, or ID 
column heading.

 o Number of Remaining Open Shifts – The number of shifts that the PSE cannot assign.
 o To Be Unassigned – The shift assignments as before the PSE run.
 o To Be Assigned – The new shift assignments that the PSE proposes.

If the PSE unassigns a shift from an employee and then reassigns the same shift (same times and 
job) to the same employee, the PSE adds an asterisk (*) to the shift in both To Be Unassigned and 
To Be Assigned.

 11. Either:
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 o Print the assignments before you accept them, click Print.

Tip: This is the only time when you can print the proposed assignments. Alternatively and if 
enabled, you can retrace the information for each employee in the PSE Audit, or examine the 
proposed assignments in detail in the XML PSE output file.

 o Accept the proposed shift assignments, click Save. Click Close.

Important: If another person runs the PSE on the same shifts before you save the assignments, 
you lose the proposed shift assignments. Only the first person to save can save assignments.

 o Reject the assignments, click Close. You lose the proposed shift assignments.
 o Reject and redo the assignments, select another procedure set or dates. Click Start.
 o If open shifts remain, click Save to accept the proposed assignments. To assign the remaining open 

shifts, select another procedure set. Click Start.
 o If the PSE proposes no changes, but you think changes are required, select another procedure set. 

Click Start.
 12. If break rules are violated, reassign the breaks:

 o Right-click the shift.

 o Click Assign Breaks  in the call out.
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Generate Schedules or Open Shifts with the 
Schedule Generator

The Schedule Generator creates or assigns open shifts for a location according to the workload, shift 
templates or profiles, employee and organizational rules, and engine settings. It creates shifts only for 
workloads that are defined by labor volume or zone set, and can assign open shifts regardless of how they 
were created.

Important: The Schedule Generator creates shifts only for workloads that are defined by labor volumes 
or zone sets. To create open shifts from shift sets, use Calculate Open Shifts. The Schedule Generator 
can assign open shifts regardless of how they were created.

Use the Schedule Generator to generate schedules or Open Shifts. 
 1. Select View > By Employee, By Job , By Schedule Group , or By Employment Terms.
 2. Select a time period and locations. Click Apply.

 o For multiple locations, the Schedule Generator affects schedules according to the Schedule 
Generator settings at each location.

 o The Schedule Generator stops automatically at 500 employees, 50 shift templates, or 12 weeks.

Important: Make sure that no employees at the locations are signed off from their time card. 
Otherwise, the Schedule Generator cannot generate a schedule.

 3. Lock shifts or days that you do not want the Schedule Generator to change.
 4. To make sure that the schedule is updated, click Save.

 5. Click Engines  and select Run Schedule Generator from the toolbar.
 6. To select a shorter time period, change the Start or End Date. The dates must be during the selected 

time period.
 7. Select a Setting.

Important: If you assign open shifts to employees, you can trigger break violations if the breaks 
differ from the employee's work rule. To reassign the breaks, select Assign Breaks for individual 
shifts or from Multi-Edit. 

The available settings are configured for the selected locations. If no settings are listed, contact your 
system administrator.
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 8. Click OK.

 o To stop the Schedule Generator, click Cancel.
 o To display summary information as the Schedule Generator runs, click Details. The details do not 

update automatically – click Refresh.
 9. Either:

 o Click Close.
 o To display summary information:

 a. Click Details:
 l Errors – Schedule or shift generation did not complete because of errors.
 l Warnings – Parts of the schedule or shift generation are not complete, or the Schedule 

Generator was canceled.
 l Input Overview – Detailed information about the input scope, employees, settings, initial 

shifts, pay codes.
 l Output Overview – If schedule or shift generation completed successfully, detailed 

information about the changes for shifts and employees.
 b. To save or print the details, use a text editor.
 c. Click Close.
 d. Click Close on the Schedule Generator dialog box.

 10. With Generate Open Shifts and Assign Breaks, assigned and open shifts may not cover the workload 
completely. Select the Coverage tab to verify results. Compare the Scheduled & Open Shift to the 
Planned schedule data.

 11. Either:

 o Accept the changes – Click Save.
 o Reject the changes – Click Refresh. Click Yes.

 12. If break rules are violated, reassign the breaks:

 o Right-click the shift.

 o Click Assign Breaks  in the call out.
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Generate Schedules with the Auto-Scheduler

Use the Auto-Scheduler to automatically generate schedules for the right number of employees in the right 
places at the right times by optimizing the following:

 l Business requirements
 l Service requirements
 l Employee preferences
 l Compliance to rules and budgets

Overview
Use the Auto-Scheduler when staffing requirements vary depending on business demand to automate 
scheduling tasks:

 l Track the staffing plan for the labor that is not related to volumes.
 l Track employee availability.
 l Generate a schedule, based on meeting volumes, employee preferences, coverage, minor rules, union 

rules, and budgeted costs restrictions.
 l Select the most qualified employee for a shift based on prioritized criteria; for example, availability, 

job, seniority.
 l Integrate with time and attendance to track exceptions and evaluate schedule costs.
 l Provide data to help stay within employee and organizational guidelines; for example, correct hours off 

between shifts, employees are scheduled for the right number of hours.
 l Provide tools to swap employees, add shifts, or send employees home according to real-time conditions.
 l If configured, compare scheduled shifts to the earned workload plan.
 l Employee Self-Service (ESS) for Scheduling – So that employees create schedules, maintain their 

availability, and request changes.

Workload
The Auto-Scheduler generates a weekly schedule for organizational locations. It assigns available 
employees to shifts, based on headcount requirements that come from the Workload Planner or Forecast 
Manager.
The Auto-Scheduler completes workload requirements based on the employee's Primary Job, Job Transfer 
Set (Seniority Date or Job Preference Order), Schedule Rule Set, Schedule Rule Overrides, Schedule Rule 
Set Optimization Overrides, and Availibility.
It creates shifts for workloads that are defined by labor volume, shift set, or zone set.
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Breaks 
The Auto-Scheduler automatically assigns breaks to shifts, including initial shifts, when it creates a 
schedule only if employees have automatic break placement enabled in their work rule. It considers job 
coverage requirements and the break placement rules.
If break rules are violated, reassign the breaks:

 l Right-click the shift.

 l Click Assign Breaks  in the call out.

Custom fields
If the Auto-Scheduler can schedule more than one employee for a shift, it selects the employee who has 
the most seniority. To configure the Auto-Scheduler to use different criteria or in a different order, create 
custom fields in order of priority.

Modified shifts
After you modify a shift, including locking it, the Auto-Scheduler no longer considers the shift to be auto-
generated. If you then unlock the shift, the Auto-Scheduler does not delete it.

Requirements
To create a weekly schedule for a date range, the Auto-Scheduler requires the following:

Option sets

 l Parameters that control how to generate a schedule:

 o Jobs to schedule; the priority of each job if undercoverage occurs
 o If not enough available employees, how to spread coverage
 o Importance of employee preferences
 o If conflict, weight of employee preferences against coverage requirements
 o Maximum budgeted number, dollars or hours, of the schedule; can be overridden

 l Number of iterations of the schedule to run:

 o The Auto-Scheduler generates a schedule and then rates the quality of that schedule.
 o The generated schedule is a base to create another schedule. The Auto-Scheduler compares the 

schedules and saves the better one.
 o The saved schedule is the base for another schedule. This process continues for the number of 

iterations to generate the best possible schedule.
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Availability
The Auto-Scheduler assigns shifts only to available employees. It considers employees who have no 
availability setting as Unavailable or Unknown.

Workload requirements
Define workload requirements by headcount by job by 15-minute time period. The Auto-Scheduler cannot 
generate a schedule for a location without workload requirements. If a shift or schedule zone does not start 
or end on the 15-minute boundaries, the time is rounded. Workload requirements come from the staffing 
plan that is defined in the Workload Planner.

Batch processing during off-periods
The Auto-Scheduler can generate schedules during periods when more system resources are available. 
Example: If the Auto-Scheduler runs at night, the generated schedule is available the next work day.
 1. Lock all shifts that you do not want to change. 

By default, the Auto-Scheduler does not override manually entered or edited shifts.
 2. Use the Event Manager to schedule the Auto-Scheduler.

Generate schedules in real-time
 1. Select View > By Employee, By Job , By Schedule Group , or By Employment Terms.
 2. Select a time period and locations. Click Apply.
 3. Lock all shifts or days that you do not want to change.

 4. Click Engines  and select Run Auto-Scheduler from the toolbar.
 5. Select or enter the Week Start Date.

 o The date must be during the current week or in the future.
 o If you select a date in the middle of a week, it switches to the start day of that week.

 6. Select the Option Set.
 7. To limit the employees to consider, select Filter by Primary Job.

 o The Auto-Scheduler schedules only employees whose primary job is in the option set.
 o Select this option for employees who can work in multiple locations. 
 o Example: The primary job for employees is in Location A, but they can also work in Location B. To 

schedule Location B but exclude these employees from working at Location B, select Filter by 
Primary Job.

 8. To regenerate a schedule and override shifts that were entered or edited manually, select Override 
Unlocked Shifts.
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 9. To ignore restrictions on budgeted hours or costs, select Override Budgeted Cost ($) or Override 
Budgeted Hours. These options are available only if a budget limit is in the option set.

 10. Click Start.

Important: 
The Auto-Scheduler automatically saves the changes to the schedule.
If the Auto-Scheduler is configured to evaluate skills and certifications, processing time can increase 
significantly.

 11. (Optional) After the Auto-Scheduler generates a schedule, you can edit it:

 o Manually edit the individual schedules. Lock the shifts or days that you are not changing. Then, run 
the Auto-Scheduler again.

 o Edit the headcount in the staffing plan of the Workload Planner. Run the Auto-Scheduler again with 
the new headcount.
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Chapter 5  

Schedule Totals

If configured, between the bottom of the schedule and the top of any widget parts are schedule totals that 
you can compare to plan, policy, and budget guidelines.

 l Indicators — Expand an organizational job to display indicators for each day. 
For a tool tip that defines an indicator, place the pointer over the name of the indicator.

 o Click the down arrow  to collapse the list.
 o Click the up arrow  to expand the list.

 l All Days — Combined values of each indicator for all days during the time period or Hyperfind

Tip: To change the size of the Indicators or All Days column, click and drag a border of the 

column. To return to the original size, click Refresh  or double-click in the column headers. 
You cannot change the size of individual day columns.

 l For a tool tip that shows details about any value, place the pointer over the cell.

Coverage totals

 l Scheduled Hours 
Number of hours that count toward coverage



 o All paid scheduled hours for each employee, not only productive hours — Total of scheduled 
productive hours for each day, including pay codes that are configured to be included in schedule 
totals.

 o Excludes unpaid auto-meal deduct time, unpaid scheduled breaks, and pay codes that are configured 
to not be included in scheduled totals (such as scheduled leave time).

 o The pay rule, break rule, and day divide settings affect the number of scheduled hours in a day. 
Break hours may be counted on the day the shift starts, no matter when the break occurs, even if a 
shift crosses midnight.

 o Ignores open shifts, unpaid break segments, negative time totals, holidays, hours that are based on 
hours visibility

 o Removes overlapped schedule totals
 o Includes Scheduled Hours-type pay codes
 o Excludes transfers out, historical totals

 l Employee Schedule Hours
Number of hours that count toward coverage

 o All paid scheduled hours for each employee, not only productive hours — Total of scheduled 
productive hours for each day, including pay codes that are configured to be included in schedule 
totals.

 o Excludes unpaid auto-meal deduct time, unpaid scheduled breaks, and pay codes that are configured 
to not be included in scheduled totals (such as scheduled leave time).

 o The pay rule, break rule, and day divide settings affect the number of scheduled hours in a day. 
Break hours may be counted on the day the shift starts, no matter when the break occurs, even if a 
shift crosses midnight.

 o Excludes transfers out

 l Schedule Cost
Total daily wage cost of all paid hours for all shifts in the Day column

 o Only if the Auto-Scheduler is used
 o A red flag indicates the cost total is outdated.

 l Number of Employees 
Number of employees scheduled for each day
Not totaled by Full-Time Equivalent (FTE) employees
Example: 2 part-time employees fill a regular, 8-hour shift. Number of Employees = 2. If 2 people fill 
two 8-hour shifts, Number of Employees also = 2.
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 l Projected Hours 
Hours that employees are projected to work based on the Actual Hours worked and Scheduled Hours
Projected Hours = Actual Hours + Remaining Scheduled Hours

 l Projected Cost
Cost of the hours that employees are projected to work
Projected Cost = Projected Hours X Employee Average Wage Rate

Metrics totals
If configured, the schedule totals area can include any of the Metrics Indicators.
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Chapter 6  

Show Coverage

Requirements to display coverage

 l Select a location – You cannot view coverage from a Hyperfind query, such as All Home.
 l Your display profile must be configured to display Coverage.
 l The locations must be assigned a workload – Shift Set or schedule Zone Set.
 l You must be able to display transfer-in employees.
 l A high enough threshold for the number of employees and organizational jobs that you need to select.



Show Daily Coverage 
Daily Coverage shows how a schedule differs from staffing requirements by comparing the daily variance 
between the staffing plan and the current schedule for a shift or schedule zone, for one or all jobs. It shows 
the difference between the number of employees required and the number of employees who are scheduled 
for a job, for a selected time span within the time period of Scheduler.
The data that appears depends on the following:

 l Selected time span
 l Counts or Coverage view
 l Individual job or Total All Jobs
 l Exact match system setting

Daily Coverage tips

Best practices
To evaluate how a schedule differs from staffing requirements, analyze the variance in the Daily 
Coverage.

 l Difference between the number of employees required and the number of employees scheduled for a 
job — for a selected time span within the time period of Scheduler

 l Displays as numbers (Counts view) or as a graph (Coverage view)
 1. Select a location – not a Hyperfind query – and time period.
 2. Assign at least one location to a Workload Shift Set or a Schedule Zone Set.
 3. To display the daily coverage area by default every time that you choose a location, select Daily 

Coverage when you configure Schedule Planner.

Note: The site.scheduling.dailycoverage.visiblebydefault system setting is no 
longer available.

 How schedule gaps affect coverage 
Gaps are time periods between scheduled shifts when no workers are scheduled. Normally, coverage does 
not count gaps.
Scheduled workers calculate coverage at the start of each quarter-hour. If a gap does not start or end on 
the quarter-hour, the gap can affect coverage.

Examples:
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 l Workload Plan: 1 worker needed from 7:00 a.m. to 3:00 p.m.
Scheduled: 1 worker from 7:05 a.m. to 2:50 p.m. (not an exception shift)
Results:
The calculation correctly indicates a coverage shortage at 7:00 a.m. because no one is scheduled at the 
start of the 7:00 a.m. quarter-hour interval.
The calculation indicates no shortage at 2:45 p.m, even though coverage is short between 2:50 p.m and 
3:00 p.m.

 l Workload Plan: 1 worker needed from 7:00 a.m. to 3:00 p.m.
Scheduled: 1 worker from 7:00 a.m. to 10:05 a.m. / 1 worker from 10:15 a.m. to 3:00 p.m.
Result: No coverage shortage is reported, despite a gap between 10:05 a.m. and 10:15 a.m. No shortage 
is indicated because a worker is scheduled at 10:00 a.m., and another at 10:15 a.m.

How scheduled breaks affect coverage
Coverage counts scheduled breaks within shifts as covered. The break does not have to begin or end on the 
quarter-hour. The break can be more or less than 15 minutes.
For a transfer to another job before or after the break, the time is counted as follows:

 l If an organizational job segment is before the break, the break time is part of that job.
 l If no organizational job segment is before the break (the shift begins with a break), the break time is 

part of the job that follows the break.
These rules do not govern a gap between two shifts, or a gap caused by a split shift.

Effect of shift exceptions on daily coverage counts
Shift exceptions are used only in locations that use schedule zones.
Shift exceptions are shifts that count toward a zone’s coverage only if they span more than half of the 
zone. If the shift covers less than half of a zone, coverage equals zero.

Example:

 l 7 a.m. to 3 p.m. Day Zone
 l 3 p.m. to 11 p.m. Evening Zone
 l An employee works a shift from 7 a.m. to 3:30 p.m. To not count the 30 minute overlap after 3 p.m. 

toward the evening zone, define the shift as a shift exception.
 l An employee works a shift from 9 a.m. to 5 p.m. To not count the 2-hour overlap after 3 p.m. toward 

the evening zone, define the shift as a shift exception. Even though the employee does not work the 
first two hours of the Day Zone, the entire shift counts as covering the entire zone.
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 1. Select View > By Employee, By Job , By Schedule Group , or By Employment Terms.
 2. Select a time period and locations. Click Apply.
 3. Select the Daily Coverage tab.
 4. In View, select Counts, Coverage, Earned Counts, or Earned Coverage.

 o Counts view shows the scheduled number followed by the planned number.

 l The background color can be configured to show overcoverage, undercoverage, or equal coverage 
for specific jobs.

 l If you also select Jobs > Total Jobs:

 l The counts are available only if the jobs use the same workload shift set or schedule zone set, 
and only for spans that are in the schedule shifts and zones.

 l Plus sign (+): At least one job has over coverage.
 l Minus sign (–): At least one job has under coverage.
 l Both plus and minus signs: The span has both undercoverage and overcoverage.

 o Coverage view shows a bar graph.

 l Indicates undercoverage and overcoverage.
 l Shaded bar graph and tool tips indicate variances between scheduled and planned workloads.
 l Each cell displays the scheduled number.

Important: Not available if you select Job > Total Jobs.

 o Earned Counts view
 o Earned Coverage view

 5. Job — Select the jobs.

 o To display all assigned jobs during the time span, select List All Jobs. Each job is on a separate 
line.

 o To display the sum of all the jobs only if the jobs use the same workload shift set or schedule zone 
set, and only for spans that are in the schedule shifts and zones, select Total Jobs (default).

 6. Span
Scheduled — Number of employees whose shifts cover the span exactly and have no job transfers. 
Scheduled breaks do not affect the value.
Planned — Required coverage from the Staffing Plan that is configured in the Workload Planner
Select a Time Span:
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 o Total Shifts — A single sum total for all the shifts for the entire day that compares the scheduled 
number of employees to the planned coverage for all shifts at the location and time period
Do not select a Job.
If the global.WTKScheduler.ShiftCoverageCounting.RequireExactMatch 
system setting is:

 l Enabled: The shifts must match exactly the span (same start and stop times) and have no job 
transfers. For other time spans it ignores this setting and will always calculate coverage as if the 
setting is false. The setting is taken into account only if no coverage counting profile is assigned 
to the location.

 l Not enabled: Any combination of scheduled shifts can provide coverage. Start and end times do 
not have to match exactly. A single employee's shift or a group of shifts from multiple employees 
can combine to cover the staffing requirement of the span. A shift that goes beyond the span is 
included in the calculation.

 o 12-Hour — Compares the scheduled number of employees to the planned coverage. One row for 
each 12-hour period in the day, the first row starts from the start time of the earliest shift or zone for 
the job.
Do not select a Job.
For Scheduled, a shift must cover the period completely to be defined as scheduled. If any part is a 
job transfer, the shift does not cover the period. A single employee's shift or a group of shifts from 
multiple employees can combine to cover the staffing requirement of the span.

 o 8-Hour — Compares the scheduled number of employees to the planned coverage. One row for 
each 8-hour period in the day, the first row starts from the start time of the earliest shift or zone for 
the job.
Do not select a Job.

 o 4-Hour — Compares the scheduled number of employees to the planned coverage. One row for 
each 4-hour period in the day, the first row starts from the start time of the earliest shift or zone for 
the job.
Do not select a Job.

 o 1-Hour — Compares the scheduled number of employees to the planned coverage. One row for 
each 1-hour period in the day, the first row starts from the start time of the earliest shift or zone for 
the job.
Do not select a Job.

 o View All — Compares the scheduled number of employees to the planned coverage. One row for 
each shift and zone for the selected jobs.
Select a single Job, or to display only the common shifts that are configured for all of the jobs, 
select List All Jobs.
If the global.WTKScheduler.ShiftCoverageCounting.RequireExactMatch 
system setting is:
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 l Enabled: The shifts must match exactly the span (same start and stop times) and have no job 
transfers. For other time spans it ignores this setting and will always calculate coverage as if the 
setting is false. The setting is taken into account only if no coverage counting profile is assigned 
to the location.

 l Not enabled: Any combination of scheduled shifts can provide coverage. Start and end times do 
not have to match exactly. A single employee's shift or a group of shifts from multiple employees 
can combine to cover the staffing requirement of the span. A shift that goes beyond the span is 
included in the calculation.

 o Single Shifts — Compares the scheduled number of employees to the planned coverage. One row 
for each job.

 a. Select a single shift.
 b. Select a single Job, or to display only the common shifts that are configured for all of the jobs, 

select List All Jobs.
If the global.WTKScheduler.ShiftCoverageCounting.RequireExactMatch 
system setting is:

 l Enabled: The shifts must match exactly the span (same start and stop times) and have no job 
transfers. For other time spans it ignores this setting and will always calculate coverage as if the 
setting is false. The setting is taken into account only if no coverage counting profile is assigned 
to the location.

 l Not enabled: Any combination of scheduled shifts can provide coverage. Start and end times do 
not have to match exactly. A single employee's shift or a group of shifts from multiple employees 
can combine to cover the staffing requirement of the span. A shift that goes beyond the span is 
included in the calculation.

 o Single Zones — Coverage for a schedule zone that is assigned to the location

 a. Select a single zone.
 b. Select a single Job, or to display only the common shifts that are configured for all of the jobs, 

select List All Jobs.
If the global.WTKScheduler.ShiftCoverageCounting.RequireExactMatch 
system setting is:

 l Enabled: The shifts must match exactly the span (same start and stop times) and have no job 
transfers. For other time spans it ignores this setting and will always calculate coverage as if the 
setting is false. The setting is taken into account only if no coverage counting profile is assigned 
to the location.

 l Not enabled: Any combination of scheduled shifts can provide coverage. Start and end times do 
not have to match exactly. A single employee's shift or a group of shifts from multiple employees 
can combine to cover the staffing requirement of the span. A shift that goes beyond the span is 
included in the calculation.
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Show the Coverage graph
The Coverage graph displays a line graph, aligned with and below the schedule, that compares current 
coverage to the workload plan.
 1. Select View > By Employee, By Job , By Schedule Group , or By Employment Terms.
 2. Select the locations and time period. The locations must have an assigned workload. You cannot view 

coverage from a HyperFind query. Select a location in Show.
 3. Select the Coverage tab.
 4. Select an organizational Job or Total Jobs.

Tip: If you change locations to a parent location of the Jobs in the Coverage graph, the graph does 
not update unless you select another Job.

 5. Select one of the Skill & Certification Profiles (SCP). If you selected Total Jobs, the profile value is 
combined for all jobs.

 6. Click  to select the coverage curves to show:

 o Scheduled – Number of employees who are currently scheduled
Accounts for scheduled breaks that count towards coverage. Example: If 3 people are scheduled and 
one takes a 30-minute break, Scheduled shows 2 during the break.

 o Open & Scheduled – Sum of the number of hours of open shifts, and the number of employees who 
are currently scheduled

 o Planned – Number of employees that the workload plan requires
 o Budget Adjusted – Workload as a time duration, based on the adjusted budget
 o Coverage Variance – Difference between the staffing plan and the current schedule. A positive 

number indicates overcoverage. A negative number indicates undercoverage.
 o Skill & certification profile (SCP) coverage identifies when requirements for skills and certifications 

are met:
SCP Scheduled – Number of employees who are currently scheduled and have the required 
skills and certifications
SCP Open & Scheduled – Sum of the number of hours of open shifts that are assigned skill & 
certification profiles, and the number of employees who are currently scheduled and who have 
the required skills and certifications
SCP Planned – Number of employees who have the required skills and certifications that the 
workload plan requires
SCP Coverage Variance – Difference between the staffing plan and the current schedule, 
accounting for skill & certification profiles. A positive number indicates overcoverage. A 
negative number indicates undercoverage.
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 7. Click Load. The data is in 15-minute increments.
The Coverage tab and graph can display coverage for organizational jobs that each use different types 
of workload. However, neither displays more than one type for a single job. A location can have jobs 
with workloads based on shift sets, zone sets, or labor volumes. However, if a job has a workload 
based on a mix of shift sets, zone sets, and labor volumes, the system displays only the workload that is 
based on, in order, labor volume, shift set, or zone set.
The Coverage graph loads data from the day before the start date to the day after the end date of the 
selected time period. It loads a maximum of 9 days of data (7 days from Scheduler plus the before and 
after days).

 8. To display a tool tip of detailed coverage information, hover the pointer over any time on the graph.
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Chapter 7  

Evaluate Productivity with 
Metrics 

Metrics measure and track workforce performance and identify inefficiencies in schedules by way of 
Indicators that compare planned with actual workload, labor volume, coverage, volume, hours, 
hours/volume, and cost at any organizational level. 

Important: Metrics can be customized, and your configuration may not include all elements in this topic.

 1. Select View > By Employee, By Job , By Schedule Group , or By Employment Terms.
 2. Select a time period and locations. Click Apply.

You cannot view coverage or select the Metrics tab from a Hyperfind query. You must select 
locations.

 3. Select the Metrics tab.
 4. Load Metrics:

 a. Select a Metrics indicator.
 b. Click Load.

Tip: To make the area for the Metrics larger or smaller, click and drag the border 
 between the Metrics and the schedule.

 o Grouping Strategies and Indicators— Metrics Grouping Strategies group Metrics indicators 
to quickly show variances between planned, scheduled, and actual staffing. A grouping strategy 
can nest indicators by Employee, Hours category set, Job, Job group, Location type, 
Organizational job, Pay code, Schedule group, Skill & certification profile, Weight level, or 
Zone set.



If totals do not fit in job group, location type, or zone set groups, those totals go in the 
<others> group.

Important: The columns and headings are customized, and your configuration may not 
include all items in this topic.

 l Summary — Combined indicators for all organizational jobs

 l Click the right arrow  to expand a row.
 l Click the down arrow  to collapse a row.

 l Click Expand All  or Collapse All .
 l For a tool tip that defines an indicator, place the pointer over the name of the indicator.

 o All Days — Combined values of each indicator for all days during the time period
 o For a tool tip that shows details about any value, place the pointer over the cell.
 o Days go from midnight to midnight:

 l For shift sets, daily metrics are measured from midnight to midnight.
 l For zones, metrics are displayed only on the days when the shifts start, and for shifts only in 

the zones when they start.

Export Metrics data

Important: These steps export schedule data only from the Metrics. To export other schedule data, see 
Export Schedule Data on page 155.

 1. Click Check Totals to update the schedule Metrics data. This button is enabled and red flags indicate 
if Metrics are outdated.

Tip: If you click Check Totals, and the red flag remains, either schedule changes are not saved, or 
calculation of totals is not finished. Click again.

 2. Click Export  only in the Metrics widget part.
 3. Select a location to store the files.
 4. Click Save.

The data from the Metrics tab – in the same columns, locations, time period, and data formats – goes to 
the file Metrics_yyyymmdd_hhmm.xls.
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Chapter 8  

Transfer Employees to 
Avoid Over Coverage

The Coverage Assignment action displays all employees who are currently assigned shift segments for a 
selected job, date, and time span. It also identifies shift segments that contribute to over coverage. Transfer 
Options displays jobs that can replace those shift segments.
 1. Select View > By Employee or By Schedule Group.
 2. Select a time period and locations. Click Apply.

Note: You cannot view coverage or select Assignments from a Hyperfind query.

 3. Click Tools > Assignments in the toolbar.
 4. Select a Job. 
 5. Select or enter a Date.
 6. Enter a Time Span.
 7. Click Reload.

 o Name – Employees who are assigned to each shift segment
 o Job – Organizational job for each shift segment for any type of workload
 o Segment – Start and end times of each shift segment that overlaps the selected jobs, date, and time 

span. Each row shows one segment for primary and transfer jobs, but not pay codes, breaks, 
unavailable shifts, or accruals.

 o Overcoverage Span – Start time, end time, and duration when more employees are scheduled for a 
job than the workload requires. Each row shows one non-overlapping span.

Tip: Hover the cursor over a cell to display a tool tip of information about an employee or shift.



 8. Identify the shift segments that have overcoverage.

 o Segment has overcoverage spans that do not overlap – One row for each non-overlapping span
 o Segment has overcoverage spans that meet or overlap – One row for the total length of the spans 

that meet or overlap
 9. Correct overcoverage:

 o Select an employee who has a shift segment with overcoverage.
 o Transfer Options displays jobs that the employee can work:

 l Job – Organizational jobs that are at the same time as the overcoverage shift segments, and are 
for the employee’s primary or transfer jobs. The job must be in Scheduler, but cannot be the job 
from which the employee transfers. The job can contain a shift segment that has overcoverage.

 l Undercoverage Span – Start time, end time, and duration when fewer employees are scheduled 
than the workload requires

 o Select a job to replace the job that has overcoverage.
 o Alternatively, enter a time in Selected Span, or for a shift segment that does not have 

undercoverage.

Important: You cannot change the length of a shift.

 10. Transfer either:

 o Only the segment or any portion of the shift that has overcoverage to a job in the employee’s 
transfer set:

 l Select the segment that has overcoverage.
 l Select the job row to replace the segment.

If you click the job row, Selected Span displays the time span of the segment that has 
undercoverage.

 l Enter the time span in Selected Span.
 l Click Transfer Segment.

 o All segments of the shift to a job in the employee’s transfer set, if the shift has multiple segments:

 l Select the job row to replace the segment.
If a shift segment is during a locked day, first unlock the day.

 l Click Transfer Shift.
 11. Optionally, to discard the changes:

 o Click Refresh. The information clears.
 o Click Reload. The information remains.
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 12. Click Save.
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Manage Request Periods

Managers set the periods when employees can submit schedule requests with Employee Self-Service 
(ESS) for Scheduling.
 1. Select View > By Employee, By Job , By Schedule Group , or By Employment Terms.
 2. Select a time period and locations. Click Apply.

 3. Click Tools  > Manage Employee Request Periods in the toolbar.
The employee request period contains a:

 o Submission period — Time period when an employee can submit a schedule request. Occurs only 
once during an employee request period.

 o Request period — Time period of a schedule request

Add or edit employee request periods 
 1. Either:

 o Click Add Request Period.
 o Click  to edit a request period.

 2. Enter a Name.
 3. In Request for, select the type of request.
 4. (Optional) Enter a Description.
 5. (Optional) Employee Query — Select a query of employees who can submit requests. 
 6. (Optional) Suppress Event Notification — Select to not send notifications to the employee group after 

you create a request period. Note: In the function access profile, the Override Alert Event 
Configuration must be set to Allowed.

 7. Define the periods: 

 a.  Submission Period — the time period when an employee can submit a schedule request. Either:

 o Select the Start Date and End Date and enter the start and end Time. See Formats on page 
329.

 o Select Any Time to not limit the submission period.
 b. Request Period — the time period of a schedule request. Either:
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 o Select the Start Date and End Date and enter the start and end Time. See Formats on page 
329.

 o Select Any Time to not limit the request period.
 8. Click OK.
 9. Click Save.

Delete employee request periods 
 1. Click  to delete a request period.
 2. Click OK.
 3. Click Yes to confirm.
 4. Click Save.
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Manage Open Shift Visibility Periods

The Open Shift Visibility Period defines the schedule time period when employees can see and request to 
work Open Shifts.
It contains:

 l Visibility period – Schedule time period when the employee can see open shifts
 l Open shift period – Dates of open shifts that the employees can request to work
Example: The visibility period is the next 2 weeks, but the open shift period is only the first week. The 
employees can see the open shifts for both weeks but can request to work the shifts only during the first 
week. Employees can see and plan ahead, but cannot reserve shifts too far ahead.
 1. Select View > By Employee, By Job , By Schedule Group , or By Employment Terms.
 2. Select a time period and locations. Click Apply.

 3. Select Tools  > Manage Open Shift Visibility Periods.

Show open shift visibility periods of other managers
If you share organizational locations with other managers, you can show open shift visibility periods that 
they created.
 1. Click Periods by Other Managers.
 2. Navigate to and select the locations.The available locations are based on your organizational group, the 

effective date in the People Editor, and the selected As of Date. 
 3. (Optional) Select another date or location.
 4. Click View.

Add or edit open shift visibility periods
 1. Either:

 o Click Add Period.

 o Click  to edit a period.
 2. Enter a Name.
 3. Optionally, enter a Description.
 4. Select a Hyperfind Employee Query.
 5. (Optional and if available) To not send notifications to the employees after you create an open shift 
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visibility period, select Suppress Event Notification. In your function access profile, Override Alert 
Event Configuration must be set to Allowed.

 6. Select Locations.
 7. (Optional) Select a different As of date.
 8. For the Visibility Period, select either:

 o Any Time to not limit the period
 o Start Date and End Date and enter the start and end Times

See Formats on page 329.
 9. For the Open Shift Period, select either:

 o Any Date to not limit the period
 o Start Date and End Date

 10. (Optional) To limit employees to only the open shifts that are assigned in their Shift Template Profile, 
select Filter Open Shift by Employee Shift Template Profile.

Important: To activate this setting, the 
global.WtkScheduler.ESS.FilterOpenShiftByShiftTemplateProfile.visib
le and 
global.WtkScheduler.ESS.FilterOpenShiftByShiftTemplateProfile.check
box system settings must be set to True.

 11. Click Save.

Delete open shift visibility periods

 1. Click  to delete a period.
 2. Click Yes to confirm.
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Enter Time Off

Managers use Enter Time Off requests to enter absences for employees in a direct, quick manner.
After you submit the request, the system automatically:

 l Calculates the correct duration of the absence based on the employee’s schedule for the day or based 
on contract hours

 l Approves the request
 l Replaces the shift segment by the appropriate pay code edit
 l Updates the schedule

 1. Select View > By Employee, By Schedule Group, or By Employment Terms.
 2. Select a time period and locations. Click Apply.
 3. Right-click one employee.

 4. Click Enter Time Off  in the call out.

Tip: If the button is not available, the schedule has unsaved changes. Click Save.

 5. If you selected the wrong employee, you can select another in Assigned to.
 6. In Type, select the type of time-off request. Time-off requests can be for vacation, sick time, 

appointments, personal time, or other absences.
 7. Check the accruals balances. The default date is today; to see balances on another date, select it from 

Accruals on. You cannot edit accruals in this table.
 8. Define each request:

 a. Select the Start Date and End Date. You can pick dates from any time period even if not 
selected in the schedule.

 b. If available, select a Pay Code. Otherwise, the default pay code is used.
 c. Select a Duration. 

The available options differ depending on the type of time-off request:

 o Full Day – Entire shift that day
 o Half Day – Half the total time of shifts that day
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Important: The time off starts when the first shift of the day starts. For other half-day 
amounts, select 1st or 2nd Half Day or Hours.

 o 1st Half Day – Total time of the first half of shifts that day
 o 2nd Half Day – Total time of the last half of shifts that day
 o Hours

 a. Enter a Start Time. See Formats on page 329.
 b. In Length, enter a number of hours, less than or equal to 24 hours. See Duration Formats on 

page 330.

Important: To save the Start Time and Length if you select Hours, you must press Tab 
from Duration.

Note: The values in Start Time and Length reset if you select Full or Half Day; if later 
you select Hours, you must enter the values again.

 9. A single request can include non-consecutive date ranges or multiple pay codes:

 a. To add another date range, click . Define the settings.
 b. To delete a date range, click . 

 10. (Optional) Add comments and notes:

 a. Click Add Comment.
 b. Select a comment.
 c. Enter text in a Note. Click Add.

The shift displays a Comment icon . 

 11. Click Apply. The request is automatically approved and the change to the schedule is saved.

Tip: If the request creates an accruals overdraft, click Yes to approve the request despite the 
overdraft. Click No to edit the request.
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Chapter 9  

Manage Schedule Groups

 1. Select View > By Schedule Group.

 o Employees are gathered according to membership in schedule groups.
 o Employees can be in multiple groups.
 o Groups and employees are sorted alphanumerically.
 o Employees who are not in a group are listed first as “Ungrouped employees.”
 o Blue group header = Groups that allow inheritance of schedules to members of the group
 o Gray group header = Groups that do not allow inheritance
 o The By Group view does not show schedule groups that have no employees.
 o Shifts or pay codes that have been edited lose the link to and are no longer part of the schedule 

group. A vertical, orange bar indicates all shifts or pay codes that do not apply to a group. 

 o Deleted items are not visible, and the date cell shows no indication of the deleted item.
 2. Select a time period and locations. Click Apply.

 3. Click Load . 

 a. Select Schedule Group to load all schedule groups. These groups include those that are in your 
schedule group profile and schedule groups from transfer employees if Transferred-In Employees 
is enabled in your People Record.

 b. Click Apply.



Add members to schedule groups 
Employees can be in multiple groups.
 1. Right-click the employees.

 2. In the call out, click Add to Group .

 a. Select Schedule Group.
 b. Select a Start and End Date.
 c. (Optional) Select to remove employees from other schedule groups during this time period.
 d. Click Apply.

Important: The number of employees in a schedule group significantly impacts system 
performance. Edits take longer if the group contains many employees. However, the number of 
schedule groups has little effect on performance.

Remove members from schedule groups 
When an employee is removed from a schedule group, the employee’s group shifts are removed for the 
date range. Ad hoc shifts are retained.
 1. Right-click the employees.

 2. In the tool bar or call out, click Remove from Group .

 a. Select Schedule Group.
 b. Select a Start and End Date.
 c. Click Apply.

Reinherit schedule patterns from a schedule group 
Restore the schedule pattern to an employee from the pattern that is assigned to the employee's schedule 
group.
 1. Right-click a date cell that contained a shift or pay code from the pattern but that item was edited or 

deleted.

 2. Click Reinherit  in the call out.
 3. Click Save.
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Manage Groups by Employment Terms

 1. Select View> By Employment Terms.

 o Employees are gathered according to shared employment terms.
 o Employees cannot be assigned multiple sets of employment terms at the same time.
 o Employment terms and employees are sorted alphanumerically.
 o Employees who do not work according to employment terms are grouped at the top.
 o The By Employment Terms view does not show employment terms that are not assigned to 

employees.

If a row is gray, either the employment terms are configured so that the employees cannot 
inherit from the group schedule, or the employment terms are not in your access profile.

 2. Select a time period and locations. Click Apply.
 3. (Optional) By default, the By Employment Terms view displays only the employment terms to which 

the selected employees are assigned. To display other employment terms, click Load Employment 
Terms . 

 a. Select the employment terms.
 b. Click Apply.

Assign employment terms to employees  

Application of pay rules:

 l If an employee is assigned to employment terms, and the hours are calculated for the same time period, 
the employment term pay rule applies.

 l If an employee is not assigned to employment terms, and the hours are calculated for the same time 
period, the employee’s pay rule, not the employment terms, applies.

 l If the hours are calculated for a time period when an employee is assigned partly to employment terms, 
the employee’s pay rule applies during the days when the employee is not assigned to the employment 
terms. In addition, the employment term pay rule applies during the days when the employee is 
assigned to the employment terms.

 1. Right-click the employees.

 2. In the call out, click Assign to Employment Terms .
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 a. Select the Employment Terms. 

Important: You can assign an employee to only one set of employment terms at a time. To 
change an employee's employment terms, select another set of Employment Terms.

 b. Select a Start and End Date. 

 o Select a time period during the period of the employment terms.
 o You cannot assign employment terms to employees during dates that are totally or partly outside 

the time period of the employment terms.
 c. Click Apply.

 3. Click Save.

Unassign employment terms from employees  
 1. Right-click the employees.

 2. In the tool bar or call out, click Remove from Group .

 a. Select the Employment Terms.
 b. Select a Start and End Date. 

The employment terms are unassigned only during the time that you unassign the employee, and 
during days that overlap the time period of the employment terms. You cannot unassign employees 
from employment terms in the past.

 3. Click Save.

Reinherit schedule patterns from employment terms  
Restore the schedule pattern to the employee from the pattern that is assigned to the employee's 
employment terms.
 1. Right-click a date cell that contained a shift or pay code from the pattern but that item was edited or 

deleted.

 2. Click Reinherit  in the call out.
 3. Click Save.

Compare target and actual hours
Target Hours displays the difference between actual and target hours for employees who work according 
to employment terms.
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 1. Select the Target Hours widget part. 

Tip: To make the area for the Target Hours larger or smaller, click and drag the border 
 between the Target Hours and the schedule.

 2. Select the Employment Terms or select All.
 3. To show all periods that overlap a date:

 a. From Display Reporting Periods that Overlap, select a date that is during the loaded period. 
Default = the last day of the schedule period.

 b. Click Refresh .
 4. Target Hours do not update automatically; Last Updated displays the most-recent update. To update the 

hours, click Refresh .
 5. To sort, click the head of a column:

 o Name: Employees who are assigned the employment terms
 o Date Pattern Name — Defined by the Work Hours Definition in the employment terms

 l If employment terms have multiple date patterns, the list repeats the employees for each date 
pattern.

 l A date pattern does not have to start on the first day of the week.
 o Reporting Period — Range of dates as defined by the employment terms date patterns; overlaps 

the selected date
Example: A loaded period is from June 8 to 14, but the date pattern starts mid-week on June 11. The 
reporting period is from June 11 to 17. All amounts are correct from June 11 to 17, even if the loaded 
period excludes June 15 to 17.

 o Target Amount — Number of hours as defined by the employment terms 
 o Actual Amount — Based on punched hours during the reporting period:

 l Past reporting period: Actual hours that the employee worked
 l Future reporting period: Amount = zero (or blank) unless a shift or pay code edit contributes an 

amount
 o  Projected Amount — Sum of actual hours worked until yesterday plus scheduled hours for the 

reporting period
 o  Variance — Target Amount — Projected Amount; can be negative
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Schedule Groups and Employment Terms Compared

What are the differences between schedule groups and employment terms? What is the same?

Differences

Schedule Groups Employment Terms
Schedule groups are less formal than Employment Terms. 
Managers can group employees who share schedules or 
any other work characteristics. 
Example: You can group employees who have 
complementary skills.

Employment terms are formal, legal contracts 
between employers and employees.

Employees can be in multiple schedule groups at the 
same time.

Employees can be assigned only one set of 
employment terms at a time; dates of 
employment terms cannot overlap. 
However, multiple employees can share the 
same employment terms.

Similarities

 l Both schedule groups and employment terms group employees who share schedules. Managers can see 
the members of the group at a glance, and can manage schedules as a group rather than one-by-one for 
each employee.

 l Employees who are not in a schedule group or who are not assigned employment terms are displayed 
together at the top of the schedule view.

 l Both schedule groups and employment terms can be configured so that employees either inherit or do 
not inherit schedules from the group:

 o If members of a schedule group do not inherit schedules, the schedule view shows them as a group 
but you cannot schedule the employees as a group.

 o If employees are grouped by employment terms but do not inherit schedules, you can add items to 
the group only for comparison and with no effect on the schedules.
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Manage Schedules

By Job
The By Job view shows scheduled shifts by job in graphical format. Use this view to see coverage by job, 
identify gaps in a schedule, then create open shifts.

 1. Click Gantt View  on the toolbar.
 2. Select View > By Job.
 3. Select a time period and locations. Click Apply.

 o Shifts are grouped by organizational job.

 o Click  to expand an Organizational Job to see the shifts and pay codes.

 o Click  to collapse an organizational job.
 o Open shifts are red and in each job for each day that has open shifts.
 o If you zoom into the time period, segments are shown as separate sections.

 l Breaks are blank.
 l If a shift has a job transfer, the shift is repeated for each job but the segment that does not apply 

to that job is gray.
 l If the employee is a minor, the age is left of the name.

 o To see detailed information in a tool tip about a job, employee, shift, or pay code, hover the pointer 
over the item.

 o You can sort only the Location and Job columns. Click the header.
 4. To edit the schedule, use the Toolbar on page 23 buttons or right-click items to use the actions in the 

Call Outs on page 34.

By Zone
If Zones are configured, you can show shifts by zone in the schedule. 
 1. Select View > By Employee, By Job , By Schedule Group , or By Employment Terms.
 2. Select a time period and locations. Click Apply.

 3. Click Gantt View  on the toolbar.

 4. If the schedule does not show shifts by zone, click the Visibility Filter . Select Zones.
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 5. Show the schedule for periods of one week or shorter.
The days are divided by zone rather than by time of day.
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Chapter 10  

Show Hours of Operation in 
the Schedule

Important: Forecast Manager must be installed and the location must have at least one job that is 
assigned to a task group.

If forecast locations are assigned Hours of Operation and Override Hours, the schedule can show these 
hours so that managers can check coverage for the open and close times of the locations.
Example: Locations can have seasonal hours of operation such as winter or summer hours for forecasting 
purposes.
Also, baseline and adjusted staffing plans can require proficiency at a set of skills or certifications and, to 
ensure that coverage is accurate, be based on the hours a site is in operation.
 1. Select View > By Employee, By Job , By Schedule Group , or By Employment Terms.
 2. Select a time period and locations. Click Apply.

You cannot view hours of operation from a Hyperfind query. You must select locations.

 3. Click the Visibility Filter . Select Show Hours of Operation.
 4. To see the hours of operation and any override hours, hover the pointer over the date header.
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Chapter 11  

Export Schedule Data

To format or process schedule data, or generate reports, you can export schedule information to an Excel 
spreadsheet.

Important: These steps do not export information from the Metrics. To export Metrics data, see 
Evaluate Productivity with Metrics  on page 133.

The same data, columns, locations, and range of dates in Scheduler are in the file Scheduler.xls in 
the following worksheet:

 l  Shifts & Pay Code Edits — Rows separate shifts and pay code edits. Time-based pay code edits are 
exported as decimal values not hh:mm format. If an employee has no shifts or pay code edits, Row 
Type displays None. If an employee is not assigned a location or job, Primary Job is blank.

 l Workload – Baseline and Adjusted workloads for each job, span, and date
 l Coverage – Data from the Coverage tab and graph, in 15-minute increments

Important: The 
site.scheduling.schedulePlanner.export.exportCoverageData system setting 
must be set to True.

 l Volume – Volume data from the workload
 1. Select View > By Employee.
 2. Select a time period and locations. Click Apply.



Tip: If the selected number of employees exceeds the maximum, click No. Select a location with 
fewer employees, or contact your System Administrator to change the maximum in the 
global.LongList.ScheduleSummaryEmployeeThreshold system setting.

 3. To make sure that the schedule is up-to-date, click Refresh  in the toolbar.

 4. Click Share  > Export to Excel.
 5. Either:

 o Click Open. To save the file, save it from Excel. 
 o Click Save. Select the location to store the file. Click Save. Then, click Open.

156



Chapter 12  

Print the Schedule

Print the current view of the schedule.
 1. Select View > By Employee, By Job , By Schedule Group , or By Employment Terms.
 2. Select the location and schedule period.

 3. In the toolbar, click Refresh .

 4. Click Share  > Print Screen.
 5. Follow the instructions for your printer.
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Chapter 13  

Manage Schedules

Like all widgets, the Schedule widget appears differently depending on whether it is in the secondary or 
primary position.

Secondary view
To move the Schedule widget to the secondary position, drag it to either side, depending on how your 
workspace is configured.
When the schedule is in the secondary position, it is minimized and displays a summary of scheduled shifts 
for the next 12 hours, including:

 l Incoming Employees — The total number of employees as well as the time and name of each 
employee whose shift will start in the next 12 hours

 l Outgoing Employees — The total number of employees as well as the time and name of each 
employee whose shift will end in the next 12 hours

The secondary view does not indicate open shifts. 



Primary view
The Schedule widget must be in the primary position before you can use it. To move the Schedule widget 
to the primary position from the secondary position or from Related Links, drag it to the central area of the 
Navigator, or open the widget from a schedule alert if available.
When the Schedule widget is in the primary position, it is organized into two general areas:

 l The top portion displays the schedule.
 l Depending on your configuration, the bottom portion contains up to 3 tabbed schedule add-ons, or 

widget parts: Schedule Coverage, Rules Violations, and Metrics.
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Dividing the two sections is a splitter bar which you can drag up or down to increase or decrease the 
relative size of the two portions. If you click the button in the center of the splitter bar, the bottom portion 
collapses completely. The button then appears at the bottom of the Schedule widget. Click the button again 
to restore the bottom portion to view.
In the main part of the schedule widget primary view, you may be able to see Shifts, Pay Codes, 
Availability, Holidays, and Time Off Requests, depending on how your system is configured.
When you position the cursor on an item in the Primary view, a tool tip temporarily appears with 
information on the item. When you move the cursor the tool tip disappears. 

Each Employee, Job, Shift, and Pay Code in the primary view contains an arrow  button that appears 
when you position your cursor over the item. Click the button to see a menu of available actions you can 
perform on the item. 
The same button appears when you drag-select an unused part of an employee schedule, or an unused part 
of a job schedule. Click the button to see a menu of available actions you can perform on the item.
A Shift or Pay Code can contain one or both of the following icons:

 l The Locked icon indicates that the item is locked for editing.
 l The Comment icon indicates that a comment exists for the item. Position your cursor over the icon to 

see the comment.
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Schedule widget toolbar

Use the Schedule widget toolbar to manipulate the display of the schedule and to perform many common 
tasks, depending on how your system is set up and your user preferences for the Schedule widget. 

View type
By Job view organizes the schedule 
information by job.
By Employee view organizes the schedule 
information by employee.

Column display and sort
Select Columns allows you to select what 
employee information to display.
Sort Employees allows you to sort 
employees according to different criteria.

Visibility Filter
Visibility Filter controls which items you 
can see in the schedule.

Enter Time Off
Enter Time Off is a simplified manner to 
directly enter absences in schedules.

Zoom controls  
Adjusts the horizontal magnification of the 
schedule. Click (+) to zoom in on one day; 
click (-) to see more days or weeks.
Adjusts the vertical magnification of the 
schedule. Click (+) to zoom in on a few 
employees or jobs; click (-) to see more.

Quick action bar
Includes three actions and a menu providing 
access to more actions

Database actions
Refresh reloads the schedule from the 
database. Only active when there are no 
unsaved changes.
Save stores changes in the database.

Cancel removes all changes and reloads the 
schedule from the database.
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 By Employee view

The By Employee view of the Schedule widget organizes shifts by employee along the left side of the 
schedule.
Open shifts are shown at the top of the schedule, before the list of employees. If the loaded schedule has 
more than one open shift, the open shifts are collapsed into one row and a small triangular button points to 
the right.

 l If you click the button, the row expands to show all open shifts.
 l Click the button again to collapse the open shifts to a single row. 
Depending on how your schedule is set up, you may be able to sort the list of employees and display 
additional columns in the By Employee view.

Sort employees
Depending on your access rights and schedule data, you can sort employees based on a procedure set. A 
procedure set is a sequence of instructions, defined for your organization, to complete a scheduling task.

 1. Click Sort Employees  to view up to seven Sort Employee procedure sets defined for your 
organization. 
If your system does not include Sort Employee procedure sets, the Sort Employees button is not 
available and the system sorts employees by last name, in ascending order.

 2. Select a procedure set from the list. Using the selected procedure set, the system sorts the employees 
as of the first day that has shifts for the time period visible in the workspace, not the selected time 
period in the schedule.

 3. To sort the schedule on a specific day, zoom on that day and reapply the sort.

 o If an employee has more than one shift, only the earliest shift is sorted.
 o If you save or cancel the schedule after making changes to scheduled items, the last sort procedure 

is reapplied automatically.
 o For example, if you sort the schedule based on shift start time and move a shift to an earlier time 

slot, the schedule is not resorted. However, if you reselect the sort procedure, the schedule is 
resorted.

 o The default sort procedure (as defined by your system administrator or by your preferences) is 
automatically applied when you change the time period or location or when you refresh the 
workspace. 

 o A check mark identifies the last selected sort procedure in the Sort Employees drop-down list.
 o If you close the Schedule widget and reopen it, the widget displays in its default state. However, if 

you move the widget from the primary position to the secondary position, and back to the primary 
position, it maintains the original settings.
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 o If the sort procedure involves a shift (duration, end, and start time), pay codes and accruals are 
ignored and appear at the bottom of the list.

 o Open shifts are not sorted and remain at the beginning of the list. 

Display more columns
Depending on your access rights and the column set defined by your system administrator or how you have 
set up your preferences, or the available columns you have selected for viewing, you may be able to view 
additional information about your employees. 
To select from the list of configured columns:

 1. Click the Add Columns button  to show the list of configured columns.
 2. Select or clear columns from the list, then click the button again to close the list.

When you view your schedule in the By Employee view, a small open/close button is to the right of the 
employee list. When you click this button, the columns you have selected appear.

 o The set of selected columns only stays in effect during the current session.
 o The selected columns are displayed in the same order as the drop-down list and cannot be reordered.

 3. You can change the width of the left section, or the columns it contains. 

 a. Place your cursor on a divider in the header bar at the top of the columns so that the cursor 
changes. 

 b. Drag the divider to the left or right.

Schedule and Metrics indicators
Depending on how your schedule widget is configured, you may see a table that displays Schedule 
Indicators and Metrics Indicators in the By Employee view. The table is just below the schedule grid, and 
above the schedule widget parts (if any). This table can display one or more schedule or metrics indicators, 
to a maximum of six. These indicators are named in the left column of each row of the table. Like the 
schedule grid above, when multiple days are shown, each column of this table represents one day. The 
indicators are associated with, and aligned with the date in the header of the schedule. 
Scheduled Hours
The total number of shift hours for all employees at the selected location or hyperfind is indicated in the 
cell for each date in the table. Employee shifts that are transferred out are not included in the daily totals. 
The number in the left column (next to the label Scheduled Hours) is the total number of scheduled hours 
for the entire selected period, which is a roll up of the daily totals.

Note: In the Schedule Planner, the schedule hours total in the left column may differ from the Scheduled 
Hours shown in the Schedule widget left column in certain circumstances, even though selected location 
and period are the same. In Schedule Planner, when the location menu shows a location in the 
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organizational map rather than a hyperfind, the schedule period total is derived from the period total of 
each employee which includes hours transferred out, while in the Schedule widget, the period total is 
derived from the daily totals, which do not include shifts transferred out. In the case of hyperfind 
selections for Schedule Planner and Schedule widget, there is no difference in the period totals, since 
hyperfind selections show employee shifts regardless of actual shift location, and do not address shift 
transfers.

Number of Employees
The total number of employees who have a shift scheduled at the selected location or hyperfind is indicated 
in the cell for each day in the selected period. Employees who do not have a shift are not counted. The 
number in the left column (next to the label Number of Employees) is the rolled up number of the daily 
totals for the selected period.
Projected Hours
Calculated from the Actual Hours (worked shifts) and Scheduled Hours by employee and by day.
Projected Cost
Total wage cost of hours that employees are projected to work.

Metrics indicators
Any other indicators are defined as Metrics indicators.

Note: Important differences can exist between Metrics Indicators configured to appear in the Schedule 
widget and the same Metrics Indicators configured to appear in the Metrics widget. In the Schedule 
widget indicators are always grouped by job. In the Metrics widget, indicators always grouped by 
location. In the Metrics tab of the Schedule Planner, Metrics indicators can be grouped by location, 
organizational job, or by another grouping strategy.

 By Job view

The By Job view of the Schedule widget organizes shifts by job along the left side of the schedule. This 
makes it easy to add or adjust shifts according to the type of job that is required.

Visibility Filter

The Visibility Filter in the By Employee or the By Job view controls which items appear in the schedule 
including some or all of the following categories of items:

 l Open Shifts
 l Assigned Shifts
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 l Pay Codes
 l Holidays
 l Availability

Control visibility 

 1. Click the Visibility Filter button .
 2. Select items on the menu to make the items visible.
 3. (Optional) Click the small arrow (4) next to Availability on the menu to show additional Availability 

options. Select or clear any of these check boxes to refine Availability display by type. 
 4. Click the Visibility Filter button again (or click elsewhere) to close the menu and refresh the view. 

Tip: If items disappear as soon as you create them, check the visibility filter. It may be set to hide 
the items you are creating.

Holidays 

Holidays are indicated by a green background color. When you hover the cursor over the background, a 
tool tip displays the name of the holiday and the start and end times

Schedule widget parts
Depending on how your navigator is configured, widget parts — or add-ons — are available along the 
bottom of the Schedule widget.

 l Coverage
 l Rule Violations
 l Metrics
If your navigator is configured to show one or more widget parts, a default widget is added showing the 
same information as the secondary view of the Schedule widget, a summary of scheduled shifts for the 
next 12 hours:

 l Incoming Employees — The total number of employees as well as the time and name of each 
employee whose shift will start in the next 12 hours

 l Outgoing Employees — The total number of employees as well as the time and name of each 
employee whose shift will end in the next 12 hours 
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Show or hide widget parts

 l If the widget parts tabs are hidden, either:

 a. Click and drag the line at the bottom of the schedule upward.

 b. Click the Open Close Widget Parts  button.
 l To hide the widget parts, either:

 a. Click and drag the line between the schedule and the widget parts downward completely or to a 
minimal height.

 b. Click the Open Close Widget Parts  button.
 l To change the default display of the widget parts when you open the Schedule widget, select 

Preferences > Open tabs by default.
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Schedule alerts
If your navigator contains Schedule alerts, the Schedule alert button displays the number of open shifts that 
are available. Depending on the configuration, the alert leads you to either the Call List widget or the 
Schedule widget.
Example: A 34 on the Schedule alert button indicates that there are 34 open shifts. To respond to this 
Schedule alert, click the Schedule alert button and select an open shift from the list. The Schedule widget 
opens in the primary position. 
Example: The list displays 3 open shifts at a time; click the down arrow to view more.
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Manage schedules with the Schedule widget 
The Schedule widget enables you to create shifts, assign the right people to shifts, and make changes as 
necessary.
 1. Move the Schedule widget to the primary position.
 2. Select a time period and HyperFind (a Workforce Central search).
 3. In widgets, you cannot right-click items to make changes. Instead, you can complete many actions 

directly on shifts or use dialog boxes:

 o You can select a shift and drag a shift horizontally to the appropriate time and department. 
However, you cannot drag a shift vertically to make a transfer.

 o You can also change a shift start time by dragging the left boundary, or the end time by dragging the 
right boundary.

 o If you hover the cursor over a job or shift, a tool tip displays detailed information.
 o You can perform a range of other common actions on shifts by clicking the Quick Action bar. 

Tip: Save your edits. After you change a schedule, the Save button changes color from gray to 
orange to indicate that your edits have not been saved. If you navigate away from the page 
without saving your edits, a message warns that you will lose your edits. Click Yes to discard 
your edits. Click No to return to the original page; then you can save your edits.

 l

Edit schedules with quick actions
Quick actions duplicate the most commonly used capabilities of the menu selections in the Schedule 
widget, bypassing most dialog boxes. In some cases, fewer options are available when working with 
quick actions, but the payoff is fewer mouse clicks to get the job done. 

Quick actions bar

The quick action bar is part of the Schedule widget toolbar. Three buttons and a drop down menu 
provide access to the quick actions.

 o The left button and the center button are determined by the system.
 o The right button is the most recently used quick action.
 o The drop-down menu provides access to actions that are not currently visible as buttons in the quick 

action bar.
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How Quick actions work

The mouse clicks for quick actions are different from the mouse clicks for menu commands. When you 
click a quick action button, the action remains active and highlighted until you deactivate it. 
Example: If you need to lock several shifts, you can click the Lock Shift button once, then select each 
shift you want to lock. Do not click the Lock Shift button again until you are finished locking shifts. 
This makes it easy to repeat an action several times. However, this also means that you must 
intentionally deactivate the action when you are finished using it. To deactivate an active quick action, 
click a different quick action button, or click anywhere in the toolbar except the zoom controls. 
Visually, the quick action button reverts to its default state (not highlighted) and the quick action is 
deactivated. 
The quick action is also deactivated when you change the time frame or change the location.

 Copy and paste shifts 
Duplicates a shift in the schedule and applies it to a different time, employee, or job

 a. Click the Copy / Paste button. 
 b. Select the shift to copy.
 c. Select one or more cells, jobs, or employees to paste the copied shift.

The Copy/Paste quick action behaves differently depending on whether you are in the Employee 
view or the Job view. 

 o In the Employee view:

 l You can copy an assigned shift and paste it into an employee name in the left column. This 
assigns a new shift to that employee that has the same time and date as the copied shift.

 l You can copy an assigned shift and paste it in any cell in any employee’s row. This assigns a 
new shift to that employee that has the same time as the copied shift, but a different date.

 l You can copy an open shift and paste it in any cell in an employee row, assigning the 
duplicate shift to that employee on that date.

 l You can copy an assigned shift and paste it into a date in the Open Shift section of the 
schedule widget creating a new and identical open shift on that date.

 o In the Job view:

 l You can copy an open shift and paste it in any cell in the same job row, creating an identical 
open shift on a different date.

 l You can copy an assigned shift and paste it in any cell in the same job row. The employee 
assigned to the copied shift is then assigned to an identical duplicate shift on a different date.
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 Add Pay Code 
Replaces a shift with a pay code 

 a. Click Add Pay Code.
 b. Select the pay code from the list that appears. Only time-based pay codes are available.
 c. Select one or more scheduled shifts to apply the pay code.

 Assign Shift 
Assigns an open shift to an employee

Only in Employee view

 a. Click the Assign button.
 b. Select an open shift.
 c. Select an employee name or anything in the employee’s row of the schedule to assign the shift to 

that employee. The time and date of the assigned shift is always the same as the open shift. You 
cannot move the open shift to another time with Assign.

 Unassign Shift
Removes a shift assignment to create an open shift

 a. Click the Unassign button.
 b. Select one or more assigned shifts to change them to open shifts.

 Delete 
Deletes an assigned shift, an open shift, or a pay code

 a. Click the Delete button.
 b. Select one or more shifts or pay codes to delete them.
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 Swap shifts 
Exchanges assigned shifts between two employees, or exchanges an open shift with an assigned shift

 a. Click the Swap button.
 b. Select an assigned or open shift to swap.
 c. Select a different assigned shift to swap.

Important: Rule violations are detected only when you try to save. If rule violations are 
detected, you will not be able to save your changes.

Lock or Unlock Shifts

 Lock Shift 

 a. Click the Lock Shift button.
 b. Select one or more assigned shifts to lock each one.

 Unlock Shift 

 a. Click the Unlock Shift button.
 b. Select one or more locked shifts to unlock them.

 Apply shift template 
Assigns a pre-defined shift template to an employee or a job for the date you select. If you assign a 
shift template in the Employee view, you create an assigned shift. If you assign a shift template in the 
Job view, you create an open shift.

 a. Click the Shift Template button.
 b. Select a template from the list that appears.
 c. Select a cell in the Schedule widget to assign the shift template to an employee and a start date (in 
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the By Employee view) or a job and a start date (in the By Job view).
 d. (Optional) Select additional cells to assign the same shift template to the employee or job on the 

start date implied by each selected cell.

 Transfer Shift 
Changes the job for a shift; all segments of all selected shifts are assigned the selected job. Other data 
associated with the shift remain unchanged.

 a. Click the Transfer Shift button.
 b. Select the job from the list. The list contains only jobs that are included in both your current transfer 

set and the selected location or jobs selected under a location.
 c. Select one or more scheduled shifts.

 Add Comment 
Attaches a comment to a shift or pay code 

 a. Click the Add Comment button
 b. Select a comment category from the list that appears (Shift or Pay Code).
 c. Select a comment. The available comments or comment categories are limited by your function 

access profile.
 d. Depending on the comment category you selected, select one or more shifts, or one or more pay 

codes to attach the same comment.

 l

Create shifts from shift templates 
In addition to a start time and an end time, a shift template may include segments and breaks. Segments 
in a shift template can include jobs, work rules, and labor levels. Any of these defined in any segment 
of the shift template override similar definitions for an employee or for a job.
Shift templates may be defined for your system. If not, you may be able to configure them, depending 
on your function access profile.
With a shift template, you create an instance of a partially defined shift by selecting a cell in the 
schedule. The selected cell’s column specifies the date, and its row specifies either the shift’s 
employee or the shift’s job, depending on whether you are working in Employee view or Job view.
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 o In the Employee view, you create an assigned shift with the employee specified by the row of the 
cell you selected. 

 o In the Job view, you create an open shift with its job specified by the row of the cell you selected.
Whichever view you use to create an assigned or open shift, the shift time is defined by the template, 
but the shift date is defined by the cell you select. The date of the cell you select defines the date of the 
start of the shift, regardless of its time, or the time of the cell you select.

 l

Manage shift segments 
From the Schedule widget, managers can create, edit, lengthen, shorten, or delete shift segments or add 
segment details.

 o

Add shift segments

 a. On an assigned shift that is not locked, click  and select Change Segments from the Shift 
menu.

 b. Click Add Segments.
 c. By default, all segments are closed. Click the triangle for the New Segment. 

Important: You cannot use Change Segments to create a segment for a break or a transfer job 
but only to edit such a segment.

 d. (Optional) Select a Start Date.
 e. Select a Start Time. You can edit the start or end time of the shift but only within the time period 
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in the Schedule widget. Segments cannot overlap.
 f. Enter a Duration in the format hh:mm.
 g. (Optional) Select Details from the drop-down menu.
 h. Click OK.

 o

Edit shift segments

 a. Click an assigned shift that is not locked.
 b. Select Change Segments from the Shift menu.
 c. Edit the segments one-by-one as needed. The segments are in order from first to last. Click the 

triangle of a segment to edit or close it. 

 d. (Optional) Select a Start Date.
 e. Select a Start Time. You can edit the start or end time of the shift but only within the time 

period in the Schedule widget. Segments cannot overlap.
 f. Enter a Duration in the format hh:mm.
 g. (Optional) Select Details.
 h. Click OK.

Note: The changes are validated after you click OK. If a segment cannot be created, a 
warning message displays the probable reasons.
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 o

Delete shift segments

 a. Click an assigned shift that is not locked and that has segments.
 b. Select Change Segments from the Shift menu.
 c. Click the red button on a segment to delete it. If the shift has only one segment that is not a 

break, you cannot delete it. 

 d. Click Yes to confirm. If you delete the first segment, the second segment becomes the first 
segment, and the start time and duration of the segment do not change.

 e. Click OK. o
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Effect of segment edits on breaks

 l Breaks are not automatically adjusted if you edit other segments.
 l You can edit or delete breaks the same as for other types of segments.
 l However, you cannot use Change Segments to create a break.

 o

Display details about shift segments

Hover the cursor over the shift to display a tool tip of the detailed information. 

Segment Details are available only if:

 l Scheduler is installed.
 l The current manager has a Scheduler license.
 l At least 1 shift segment detail is configured.

 l

Manage breaks
Add, edit, and delete breaks in the schedule:

 a. On a shift, click  and select Breaks from the Shift menu. The Breaks dialog box shows details 
about any breaks that are already defined.

 b. To edit an existing break, select a new starting date and time or duration of the break.
 c. To delete a break, click the red button on the right side of the break. When asked to confirm, click 

Yes.
 d. To add a break, click Add Break, and enter the starting date and time as well as the duration of the 

break. 
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 e. Click OK.
When you add a break to a shift, the system displays a white gap on the shift body to represent the 
break. The edges of the white gap represent the start time and end time of the break. Details about 
the break are displayed when you hover the cursor over the shift. 

 f. Assign breaks
You can apply break placement rules to a shift with Assign Breaks. The system assigns breaks 
based on break placement rules in the work rule of the employee.

 a. On a shift, click  and select Assign Breaks from the Shift menu.
 b. The break rules you have set up are applied to the shift. If the shift already contains breaks, the 

system overwrites those breaks.
 c. If you change the length of the shift, you must select Assign Breaks from the Shift menu again 

to reapply the break rules based on the new shift length.

 l

Unassign shifts

On an assigned shift, click  and select Unassign Shift from the Shift menu.
The shift changes to an open shift.

 l

Add open shifts

 a. To add a shift in the job view:

 b. On a job, click  and select Add Shift. 
 c. Enter a label, starting date and time, and ending date and time, then click Add.
 d. To add a shift in the employee view:

178



 a. On an open shift (open shifts appear above the list of employees), click  and select Add 
Open Shift.

 b. Enter a label, starting date and time, ending date and time, and job, then click Add.
 e. When the open shift has been created, you can assign it an employee.

 l

Fill open shifts

 a. On an open shift, click  and select Assign from the Shift menu.

 b. In the Assign Open Shift dialog box, select an employee from the list. 
If you are using procedure sets, the system displays only those employees who are qualified for the 
shift. 
If you are not using procedure sets, all employees are listed.

Tip: To define or change a procedure set, change your Schedule widget preferences. If no 
employees in the procedure set are qualified to fill the shift, the employee list is blank. Change 
or clear your procedure set preferences.

 c. Click Assign. 

 l

Copy and paste shifts 
Duplicates a shift in the schedule and applies it to a different time, employee, or job
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 a. In the Quick Actions, click the Copy / Paste button . 
 b. Select the shift to copy.
 c. Select one or more cells, jobs, or employees to paste the copied shift.

The Copy/Paste quick action behaves differently depending on whether you are in the Employee 
view or the Job view. 

 o In the Employee view:

 l You can copy an assigned shift and paste it into an employee name in the left column. This 
assigns a new shift to that employee that has the same time and date as the copied shift.

 l You can copy an assigned shift and paste it in any cell in any employee’s row. This assigns a 
new shift to that employee that has the same time as the copied shift, but a different date.

 l You can copy an open shift and paste it in any cell in an employee row, assigning the 
duplicate shift to that employee on that date.

 l You can copy an assigned shift and paste it into a date in the Open Shift section of the 
schedule widget creating a new and identical open shift on that date.

 o In the Job view:

 l You can copy an open shift and paste it in any cell in the same job row, creating an identical 
open shift on a different date.

 l You can copy an assigned shift and paste it in any cell in the same job row. The employee 
assigned to the copied shift is then assigned to an identical duplicate shift on a different date.

 l

Edit start and end times of shifts

 a. You can just select a shift and drag it to the appropriate time.

Best Practice: When you change the times of a shift, edit the Label to indicate that the shift 
changed from the template or normal shift. Example: Add “m” to the beginning of the label to 
indicate that the shift is “modified.”

 b. Alternatively, you can edit a shift from the Shift menu. Either:

 o Start time

 a. On a shift, click  and select Change Start from the Shift menu.
 b. Enter a label, starting date and starting time for the shift, and click OK. 
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 o End time

 a. On a shift, click  and select Change End from the Shift menu.
 b. Enter a label, ending date and ending time for the shift, and click OK.

 l
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Change jobs, labor levels, and work rules 

 a. To change jobs, labor levels, or work rules for a shift, click .
 b. Select one of the following from the Shift menu:

 o Change Jobs

To change a job, use the Add Transfer dialog box. 

 a. On a shift, click  and select Change Job from the Shift menu.
 b. Select a segment or enter a starting and ending time.
 c. In the Add Job Transfer area, select Select location(s)...
 d. In the Select Locations dialog box, click Clear Locations, select a new location, and click 

Select. 
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 e. To add labor levels or a work rule to the transfer, click Advanced. The Labor Levels and 
Work Rule information opens. 

 f. Click Add.

 o

Change labor levels
To change the labor level, use the Edit Labor Level dialog box. 

 a. On a shift, click  and select Change Labor Level from the Shift menu.
 b. Select a segment or enter a starting and ending time.
 c. Select a labor level from each of the displayed levels. If you make a mistake on one line, 

click the red button. To clear all labor levels, click Delete Accounts.
 d. To change a job or a work rule at the same time, click Advanced. The Transfer and Work 

Rule information opens. 
 e. Click Add.

 o

Change work rules
To change a work rule, use the Edit Work Rule dialog box. 
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 a. On a shift, click  and select Change Work Rule from the Shift menu.
 b. Select a segment or enter a starting and ending time.
 c. Select a work rule from the drop-down list.
 d. To change a job or a labor level at the same time, click Advanced. The Add Transfer and 

Labor Levels information opens. 
 e. Click Add.

 c. When you select one of these options, a dialog box opens so you can enter the appropriate 
information. Click Advanced to edit more shift options. For example:

 o If you click Advanced in the Edit Labor Levels dialog box, the Add Transfer and Add Work 
Rules boxes appear. 

 o If you click Advanced in the Add Transfer dialog box, the Edit Labor Levels and Edit Work 
Rules boxes appear.

 o If you click Advanced in the Edit Work Rule dialog box, the Edit Labor Levels and Add 
Transfer boxes appears.

 l

Assign skill and certification profiles 
To add or edit Skill & Certification Profiles for regular and transfer shift segments:

 a. On a shift, click .
 b. Select Change Skill & Certification Profile. 
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 c. Select a segment.
 d. Select profiles.
 e. Click OK.

 l

Manage comments
Comments and notes on shifts or pay codes allow you to record and identify the reason behind certain 
shifts or pay codes in your schedule. Comments can also remind you why you scheduled someone for a 
specific shift, or why you scheduled a certain pay code.

 o
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Add or delete comments

 a. On a shift or pay code, click  and select Comments from the Shift menu. Comments shows 
any comments have already been made. 

 b. To delete a comment, remove the check mark and click OK. You cannot delete comments that 
were entered for status changes to schedule requests.

 c. To add a comment, select a comment from the list.
 d. To add a note to the comment, click the green plus-sign button and enter your note (maximum of 

245 characters).
 e. To delete the note, click the red minus-sign button. 

 f. Click OK.
When a shift or pay code has a comment, the shift or pay code displays a small, blue icon. 

 o

Edit notes

 a. Select a shift or pay code that has a comment. The shift or pay code displays a small, blue icon. 
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 b. In the Comments dialog box, click the down-arrow to display the note. 

 c. Change the note as needed.
 d. Click OK.

 l

Add pay codes
The Pay Code Editor includes basic and advanced views. 

 o The basic view contains fields required to add a pay code: effective date, pay code, amount, start 
time, and scheduled amount (for day pay codes only). 

 o The advanced view provides additional options: override accrual days, create open shift, override 
shift, transfer, repeat for (D), unavailable start time and unavailable amount, comments, and notes.

Important: Some of the options require a Scheduler license.

 a. On an employee, click  and select Add Pay Code. The Pay Code Editor opens in the basic view.
 b. In the Pay Code Editor dialog box, make the appropriate changes. 
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 c. To make additional changes, click Advanced.

 d. Depending on the pay code that you are adding or changing, you can enter information for:

 o Repeat for (D)* — If you select a number here, the system will repeat the pay code edit for the 
same number of scheduled days. For example, if you enter 3, the system creates pay codes for 
the next 3 scheduled days.

 o Override accrual days — Select this check box to override the value in the Amount (hh:mm) 
drop-down list. This option is available only for hours pay codes and is not applicable for day 
and money pay codes. The maximum value allowed is 1. If you select a day pay code, this field 
is disabled, but the system provides the following values:

 l 1.0 — For full scheduled day or full contract day
 l 0.5 — For half scheduled day or half contract day

 o Override shift — Select to override the shift in Amount (hh:mm). Then indicate whether the 
override is for the whole or partial shift. If you are editing a money pay code, you cannot select 
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to override the whole or partial shift.
 o Override shift — Select to override the shift in Amount (hh:mm). Then indicate whether the 

override is for the whole or partial shift and if you want to create an open shift. If you are editing 
a money pay code, you cannot select to override the whole or partial shift.

 o Unavailable Start Time and Unavailable Amount — To mark someone as unavailable to 
work, enter the starting time and duration. For example, if you have an employee who is in 
school from 8 a.m. to noon, enter 8:00 as the start time and 4 for the number of hours.

Note: Availability and Pattern templates are not available in the Schedule widget.

 e. Click Add.

 l

Add a shift or pay code directly on the schedule 

 a. Set the visibility filter to show the item you are adding.
 b. Drag-select the portion of the schedule where you want to add the item. A tool tip shows the start 

and end time of the selection.

Tip: You can zoom in if you have trouble selecting the precise start or end times, or you can 
make an approximate selection and adjust the start and or times on the dialog box.

 c. On the selected portion, click  and select Add Shift or Add Pay Code from the menu. The 
appropriate dialog box opens with most of the fields already defined.

 d. Make the changes as needed.

 l Delete shifts

 a. On a shift, click  and select Delete Shift from the Shift menu.
 b. Click Save. The system deletes the shift without a confirmation message.

 l

Swap shifts
With the Swap Shift quick action, you can: 

 o Immediately exchange assigned shifts between two employees.
 o Immediately exchange an open shift with an assigned shift (the employee is assigned to the open 

shift, and the assigned shift becomes open).
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Important: This means of swapping shifts bypasses the request and approval steps that may be 
required when shifts are swapped by other means. After the swap, the definitions of all shift 
segments (such as job, work rule, comments, and so on) remain unchanged.

 a. From the Quick Actions, click the Swap button .
 b. Select an assigned or open shift to swap.
 c. Select a different assigned shift to swap.

Important: Rule violations are detected only when you try to save. If rule violations are 
detected, you will not be able to save your changes.

 l

Enter time off
Enter Time Off directly in the Schedule widget.

 a. Save any changes to the schedule.
 b. Either:

 o In any view, click the Enter Time Off button . Select the type of time-off request.

 o In the By Employee view, on an assigned shift, an employee, or a date/time, click  and select 
Enter Time Off.

 o In the By Job view, on an assigned shift, click  and select Enter Time Off.
 c. Make any changes that you need. You can pick dates from any time period even if not selected in 

the schedule.
 d. Click Submit.

 o The system calculates the correct duration of the absence based on the employee’s schedule for 
the day or based on contract hours, automatically approves the request, updates the schedule, 
and enters the appropriate pay code edit.

 o If the request requires multiple levels of approval, the system automatically approves for all 
levels of approval, creates the pay code edit, and saves the changes to the schedule.

 l

Lock shifts
Sometimes you may want to lock a shift so the shift cannot be changed or deleted. 
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 o To lock a shift, click  on an unlocked shift and select Lock Shift from the Shift menu. When you 
lock a shift, the color of the shift deepens, but you’ll need to look carefully; it’s a subtle change.

 o To unlock a shift, click  on a locked shift and click Unlock Shift from the Shift menu.
You cannot lock an open shift, a pay code, or scheduled days. 
If a scheduled day has been locked in the Scheduler, you cannot edit the shift in the Schedule 
widget. l
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Manage Availability 
Display, define, override, and change employee Availability.
Two levels of availability, Global and Location, are configured by the system administrator. These 
apply to large numbers of employees and rarely if ever need to be changed. 
The main types of availability for scheduling managers are employee base pattern and employee 
override.

 o These types are managed separately so that a base pattern can be retained in the database even if 
you apply an override to the same period of time. When the override ends, or when the override is 
deleted, the base pattern again takes effect automatically. 

 o However, if two base patterns overlap in time, only the last base pattern applied is retained for the 
period of the overlap. Any former pattern is deleted for the period of the overlap, and retained where 
there is no overlap.

 o Similarly, only the last override applied to a given period is retained.

Color codes for availability 

 Available — light green 

 Preferred — green 

 Preferred Time Off — pink 

 Unavailable — purple 

 Unknown — white 

Availability levels 
All employees have an availability level. If no availability is defined for the employee or location, the 
employee is assigned to the global default availability.
Availability has different levels. Higher levels override lower levels.
Employee Override — Temporarily overrides base employee availability during a time period. 
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 o Overrides all other availability levels that are assigned to the employee — employee, location, and 
global — for a specified period of time. Changes to lower levels of availability do not affect 
override availability. 

 o When the override period ends or when you delete an override, the underlying, lowest-level, base 
pattern availability is reinstated.

Methods to define an override, depending on whether the override has a recurring pattern:

 o Define or modify a recurring override pattern.
 o Override availability temporarily for a single period that does not repeat, for a period as short as one 

day, or that repeats without any pattern.
 o Create a pattern to override availability for a longer time period.
 o All methods are at the same level in the availability hierarchy. If two overrides for the same 

employee overlap in time, only the last one created is retained for the period of the overlap; the 
previous override is deleted for the period of the overlap.

Note: Your system may include pay codes defined with availability. Example: A vacation pay 
code could automatically change an employee's availability to Unavailable. Pay code availability 
behaves like an employee override. If a pay code availability overlaps an employee override on 
the same employee overlap in their period, the last one applied takes effect.

Employee base pattern — Defines the default or normal availability of an employee. 

 o Overrides location and global availability. Changes to location or global availability do not affect 
employee availability.

 o An availability template can define an employee’s availability.
 o An employee’s base pattern can be for a specified period, or can continue indefinitely. 
 o Base patterns can be chained to apply in sequence. If two base patterns overlap in time, the later 

one overwrites the earlier one for the overlap. 
 o The employee base pattern supersedes location or global availability for the period specified in the 

base pattern. Changes to location or global availability do not affect an employee’s base pattern.
 o Define or modify an employee base pattern availability.

Note: Employee availability always overrides location availability. Changes to location-level 
availability affects only employees who do not have employee-level or employee override 
availability.

If you remove employee availability:

 o Location availability takes priority.
 o If location availability is not defined, global availability takes priority.
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Location — Defines availability for a location (and the child locations) in the organizational map. 

 o Use the availability template to define availability of all employees at a location and of all child 
locations. All employees whose primary job is in these locations inherit that availability pattern. 

 o Location availability overrides global availability. Changes to global availability do not affect 
location availability.

 o All employees at that location who do not have an employee availability defined for a given period 
inherit this availability pattern for that period. 

 o You must use an availability template to define a location availability.
Global — Organization-wide default setting that assigns one availability to all employees, 24 hours a 
day, 7 days a week. 
Global availability can be Unknown, Available, or Unavailable, but not Preferred and not Preferred 
Time Off. If not defined, Global availability defaults to Unknown.
Any employee who does not have a location or employee availability defined for a given period inherits 
the global availability for that period. 

Show Availability 
To display availability in effect for each employee and each period in the primary view of the schedule 
widget:

 a. Click .
 b. Select Availability to make all availability types visible. Click the small arrow (4) next to 

Availability on the menu to show a sub-menu of different Availability types. Select or clear any of 
these to refine Availability display by type.

Tip: Vanishing schedule items: If availability colors disappear as soon as you create them, 
check the visibility filter. It may be set to hide availability.

Add availability patterns 
The procedure for a manager to use when defining or editing an employee’s availability pattern is the 
same whether you are working on a base pattern or an override pattern. However, the effects of 
creating or changing an employee’s base pattern are different from creating or changing an override 
pattern.
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Base and Override availability patterns 

The types of employee availability patterns are base patterns and override patterns. 

 o Base patterns are intended to reflect an availability pattern that remains stable for a longer periods 
of time. 

 o Override patterns give you the option to modify an employee’s availability temporarily, without 
costing the effort of re-defining the same base availability pattern when availability returns to 
normal. 

Example

 o If an employee changes from part time to full time to accommodate a temporary change in staffing 
requirements, the employee’s availability pattern may need to be adjusted for a period of time. 

 o In this case, don’t edit the employee’s base pattern; create an override pattern instead. When the 
staffing requirements return to normal, you can delete the override pattern or give it an appropriate 
end date. In either case, the original base pattern takes effect as soon as the override is gone.

 o To continue the same example, if the greater staffing requirement turns out to be permanent, this 
same employee may need to be assigned a permanent full time schedule. You can easily 
accommodate this need by changing the override pattern to a base pattern, a single option on the Edit 
Pattern dialog box. The override pattern then becomes the new base pattern replacing the old.

Override employee availability for a one-time event 
Use the context menu to override an employee’s availability for a one-time event that does not involve 
a pay code. For example, an employee is unavailable for a certain afternoon and this is an exception to 
the usual availability. When the override ends or is deleted, the original pattern resumes.

Note: If your system is set up to use pay codes that affect availability, do not use an override for this 
purpose. The pay code adjusts the employee’s availability automatically. Change the pay code if you 
want to change availability.

 a. Set the visibility filter to show availability.
 b. Drag-select the portion of the employee’s schedule you want to change. A tool tip shows the start 

time and end time of the selection.

Tip: Zoom in if you have trouble selecting the precise start time or end time.

 c. On the selected portion, click  and select Availability from the menu.
 d. Click the small arrow (4) next to Availability on the menu to show a sub-menu of different 

Availability types. Select one type of availability to apply it to the selected period of the 
employee’s schedule
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Delete employee availability assignments

 a. Anywhere in an employee’s schedule, select a time period.

 b. On the selected time period, click  and select Availability > Delete Availability. 
 c. All of the employee availability patterns in the currently displayed schedule period are listed 

including base patterns, override patterns, and one-time overrides. You can sort the list using any 
column as a sort key by clicking on the header of that column.

 d. Select the availability assignment that you want to delete. 
 e. Click Delete.

Note: In addition to the availability assignment you have deleted, there may be other levels of 
availability still in effect. If availability colors are hidden use the visibility filter to display 
availability so you can verify that the desired availability is in effect. It may be necessary to 
delete other availability assignments, or create new ones to obtain the desired resultant 
availability.

 a. Depending on whether you are adding or editing an employee’s availability pattern, either:

 o Add Pattern — On an employee name, click  and select Availability > Add Pattern. The 
Add Pattern dialog box opens with all settings blank.

 o Edit Pattern — Anywhere in an employee’s schedule, select a time period, click  and select 
Availability > Manage Availability > Edit Pattern. The Edit Pattern dialog box opens with all 
fields and parameters set according to those in effect at the selected point in the employee’s 
schedule. Make only the required changes in the steps that follow.

 b. Enter a Pattern Name. This name is displayed when you edit the pattern, or when the employee has 
more than one pattern in the displayed time period.

 c. Select the Base or Override pattern type. 
 d. (Optional) Insert an availability template:

Tip: You can edit any template parameter to customize it for the pattern you need. The stored 
template remains unchanged.

 a. Click Insert Template.
 b. Select a template from the list.
 c. Click OK.

 e. Define the Anchor Date. The first day of the recurrence pattern that you define corresponds to that 
day.

 f. Either:
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 o If the pattern is based on a number of days, select Days. Enter the number of days in the 
recurring pattern.

 o If the pattern is based on one or more weeks select Weeks. In the calendar week portion of the 
dialog box, adjust the display to match the number of weeks in the recurring pattern. Click Add 
Week ( ) to increase the number of weeks if you need more than one week to define the 
recurrence. Click Delete Week ( ) if you add too many weeks by mistake.

 g. Select one type of availability to apply to the employee’s schedule.

Note: To apply availability to a certain time of a certain day, double-click on the day to zoom in. 
To zoom in more, click the zoom in icon. To view progressively longer periods, click on the zoom 
out icon.

 h. Apply the selected availability type to a period as short as 15 minutes or as long as one day by 
clicking the period. Repeat to apply the same availability type to additional periods — there is no 
need to click the availability icon again until you want to apply a different availability type.

 i. Repeat the previous steps until you define all the availability types in the period that defines the 
pattern. 

 j. Define the start date when the availability pattern takes effect, and the end date when it ceases to 
have effect.

 o Select Forever to repeat the pattern indefinitely.
 o Select Until to define a date when the pattern ends.

 k. Click OK.

Caution: When you edit a pattern’s start date or end date such that it shortens the applicable 
period of the pattern, the previous pattern remains in effect before the new start date or after the 
new end date.

Approve requests to change availability
When an employee makes a change to the availability that appears on their schedule, you may have to 
approve it. To view availability requests: 

 a. Open the Request Manager widget. 
 b. Select Change Availability Request. 
 c. Highlight the request you want to approve. 
 d. Select Approve.
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Edit availability

A manager can submit an availability change request on behalf of an employee using Request 
Manager. 

 a. Open the Request Manager widget. 
 b. Select Change Availability Request. 
 c. Select Request Change Availability. 
 d. For Employee, select the employee you want to work with. 
 e. Select the Request Period and Type. 
 f. Select the dates you want to change. 
 g. Check Unavailable, Unknown or Available. 
 h. Click Submit. The selected employees will see the request in their calendar.
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Use Schedule Widget Parts

 l

Display schedule coverage
The coverage graph at the bottom of the schedule compares scheduled coverage to the workload plan. 
The horizontal axis shows time and is aligned with the schedule. As you scroll the schedule, the 
coverage graph also scrolls. The vertical axis shows the number of employees.

 a. Select the Schedule Coverage tab.
 b. In Job, select an organizational job or Total Jobs.
 c. Select one of the Skill & Certification Profiles (SCP). If you selected Total Jobs, the profile value 

is combined for all jobs.
 d. Select:

 o Scheduled – Number of employees who are currently scheduled
Accounts for scheduled breaks that count towards coverage. Example: If 3 people are scheduled 
and one takes a 30-minute break, Scheduled shows 2 during the break.

 o Open & Scheduled – Sum of the number of hours of open shifts, and the number of employees 
who are currently scheduled

 o Planned – Number of employees that the workload plan requires
 o Budget Adjusted – Workload as a time duration, based on the adjusted budget
 o Coverage Variance – Difference between the staffing plan and the current schedule. A positive 

number indicates overcoverage. A negative number indicates undercoverage.
 o Skill & certification profile (SCP) coverage identifies when requirements for skills and 

certifications are met:

 l SCP Scheduled – Number of employees who are currently scheduled and have the required 
skills and certifications

 l SCP Open & Scheduled – Sum of the number of hours of open shifts that are assigned skill 
& certification profiles, and the number of employees who are currently scheduled and who 
have the required skills and certifications

 l SCP Planned – Number of employees who have the required skills and certifications that the 
workload plan requires

 l SCP Coverage Variance – Difference between the staffing plan and the current schedule, 
accounting for skill & certification profiles. A positive number indicates overcoverage. A 
negative number indicates undercoverage.

 e. To display detailed coverage information, hover the cursor over a time.
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 f. To expand or shrink the coverage graph upward or downward, click and drag the resize bar 
between the coverage graph and the schedule.

 l

Display rule violations
If you have rule violations configured, whenever a rule is violated during the schedule time period, the 
violation appears below the schedule.

The violations that appear in this list are determined by your administrator. 

 o To filter the list:

 a. Click Severity or Rule Type.
 b. Either:

 l Select the items you want to see.
 l Clear the items you want to hide.

 o To sort, click a column heading.
 o If violations thresholds are exceeded, a message notifies you of the violations. Edit the schedule 

accordingly to resolve the violations. 

200



 l

Display productivity metrics
You can display the same or different productivity metrics information that appears in the Metrics 
widget from within the schedule. When you change your selection of date and time in schedule, the 
productivity metrics chart changes for the new selection. This enables you to adjust your schedule as 
you see productivity metrics fluctuations.

 a. Select the Productivity Metrics tab.
 b. Select a schedule period and locations.
 c. Depending on your access rights, you may be able to set preferences.
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Set Preferences — Schedule widget 

Your access rights determine whether you can set preferences for the widget.

Tip: Additional options are available. You can click Close to move the widget to the Related Items 
pane. If you are working on a secondary widget, you can click Pop-out to move the widget to the 
primary position.

 1. Click the gear button in the upper right of the widget and select Preferences.
 2. Edit the following options. If an option has an asterisk next to its label, you must provide information; 

the option cannot be blank.

 o View — Select By Job or By Employee. If you select By Employee, the default schedule displays 
the day-by-day schedule organized by employee. If you select By Job, the default schedule displays 
a graphical time line arranged by job rather than by employee. This view makes it easy for you to 
see coverage, open shifts, and gaps between shifts. You can easily switch back and forth between 
these two views from within the widget.

 o Time Period — Select a default time period. These time periods were set up for your organization; 
you cannot change them here. The maximum schedule period is 6 weeks. 

 o Location — Select the default location to which the Schedule widget will open. You can also select 
All Home Locations as the default location. 

 o Widget Parts — Widget parts are self-contained add-on views that are accessible only from within 
a widget.
If your organization uses Metrics, Schedule Coverage, or Rule Violations widget parts, their names 
are listed in the Available box. Select one of each type of these widget parts from the Available box 
and move them to the Selected box. Hold down the Ctrl key to select more than one. The selected 
widget parts appear at the bottom of the Schedule widget.

 o Procedure Sets — You can optionally assign the following procedure sets for assigning shifts and 
sorting employees:

 l Procedure Set to Assign Shifts — Select a procedure set to identify employees who can fill an 
open shift. The system can identify up to 300 employees per procedure set. If you do not have a 
procedure set for this function, select None.

 l Procedure Set to Sort Employees — Select a procedure set to sort employees listed on the 
schedule by default — by last name, by hire date, by salary, and so forth. Although you can select 
from the first seven sorting procedure sets defined for your environment, the procedure set 
defined here is the default.
If you do not have a sorting procedure set, select None. The selections are defined for your 
organization; you cannot change them here. If you select None, the schedule is sorted by the 
employee name in ascending order.
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 l Column Set — Select a Schedule Planner column set to define what is viewable in the “By 
Employee” view — location, job, and so forth. All column sets defined for your environment are 
displayed. However, if only Workforce Central is installed, the Schedule Editor Column Sets 
appear.
If you select None, only the employee name will appear in the widget. The selections are defined 
for your organization; you cannot change them here.

 o Assign Required Breaks for the New Shift Length — Select this check box if you want to be 
able to reapply the break rules for a shift based on a new shift length.

 o Open Tabs by Default — Select to display by default the widget parts tabs at the bottom of the 

schedule. Clear to hide the tabs and display the Open Close Widget Parts  button on the 
line at the bottom of the schedule. Managers can use this button to show or hide the tabs

 3. Click Save and click X to close the window.
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Chapter 14  

Quick Links and Single 
Links

Although most widgets address specific tasks — such as entering your time, viewing your schedule, or 
requesting time off — you can also get to any Workforce Central page for which you have access without 
leaving your navigator. Two widgets — Quick Links and Single Links — enable you to use Workforce 
Central applications in your navigator. 
Depending on how your navigator is configured, one or more Quick Link and Single Link widgets can be in 
your navigator.



Quick Links
Quick Links can contain more than one link.
Pages or links that are accessed from the main tabs are available as Quick Links. The links that appear in 
the Quick Links widget vary, depending on the Workforce Central products installed and your access 
rights. The order in which they appear corresponds to the order of the information in the Workforce Central 
tabs.

Your navigator may or may not include any Quick Links widgets and even if it does, they are probably not 
labeled “Quick Links.” However, the Default All Quick Links widget can be used as an example of a 
Quick Links widget that contains multiple links.
As its name implies, the Default All Quick Links widget includes all possible Quick Links used by your 
organization. Unlike other Quick Links widgets, this widget does not categorize the links. If your navigator 
includes this widget, Workforce Central security controls allow you to view only the links for which you 
have access. 
Quick Links are organized by categories such as General, Timekeeping, Scheduling, My Information, My 
Calendar, My Links.
Example: 
 1. Click the arrow next to the My Information category. The links associated with that category are 

listed — My Timecard, My Actions, My Reports, and so forth.
 2. Click the My Timecard link.

 3. To return to the list of Quick Links, click the Back to List arrow . 
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Preferences 
Depending on your access rights, you may or may not be able to set preferences for the widget.
 1. Click the gear icon in the upper right of a widget and then select Preferences.

Tip: Additional options are available. You can click Close to move the widget to the Related Items 
pane. If you are working on a secondary widget, you can click Pop-out to move the widget to the 
primary position.

 2. Edit the following options. If an option has an asterisk next to its label, you must provide information; 
the option cannot be blank.

 o Links — Select links that you want to access and move them from the Available box to the 
Selected box. To select multiple links, hold down the Ctrl key.

 o Show Back to List — If you select this check box, a Back to List link appears in the navigator so 
you can return to the list of Quick Links. 

 3. Click Save and then click X to close the window.

Single Links
Single Links contain only one link.
With the Single Link widget, you can directly access one specific Workforce Central component or any 
URL, internal or external to Workforce Central.
Move the widget to the primary position.
By default, the secondary view lists only the link and application name. The secondary view, however, is 
customizable and can contain another Single Link or a URL.
Your navigator may or may not include any Single Links widgets and they may not be labeled “Single 
Links”.

Preferences 

Depending on your access rights, you may or may not be able to set preferences for the widget.

 1. Click the gear icon in the upper right of a widget and then select Preferences.

Tip: Additional options are available. You can click Close to move the widget to the Related Items 
pane. If you are working on a secondary widget, you can click Pop-out to move the widget to the 
primary position.

 2. Depending the primary view link, the following options appear; edit them as necessary. If an option has 
an asterisk next to its label, you must provide information; the option cannot be blank.
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 o HyperFind — Select one of the HyperFinds listed. If you leave this blank, the widget uses the 
default context parameters for the link.

 o Time Frame — Select one of the time periods listed. If you leave this blank, the widget uses the 
default context parameters for the link.

 o Forecast Location — Select the parts of a business to use in volume and labor forecasting (requires 
Forecast Manager).

 o Forecast Week — Select the Forecast Planner time period to pass to each page in the wizard 
(requires Forecast Manager).

 o People List — Select a list of people.
 3. You can also enter a URL directly into the field.
 4. Select Show Back to Listto add a Back to List link in the navigator so that you can return to the list of 

links. 
 5. Click Save and then click X to close the window.

Example Single Links:

 l Favorite reports
You are a manager who is using the Timecard Approval wizard, which allows you to access your 
favorite reports. Before you can access your favorite reports, however, you must define them. 
For more information about the Timecard Approval wizard, refer to the Widget User Guide.
 a. To define your favorite reports you must have a Reports single link widget in your navigator. If this 

widget it not in your navigator, see your system administrator.
 b. Move the Reports single link widget to the primary position and maximize it.
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 c. From the Reports list, select a report and click Create Favorite.
 d. In the Favorite Report area, give the report a name, add remarks, and set a HyperFind or time 

period, then click Save Favorite.
 e. If additional reports are needed, repeat.

When you access the Timecard Approval wizard, whatever reports you marked as favorites are 
accessible from the Related Information drop-down list.

 l Online help
To access Workforce Central online Help, it must be configured as a Single Link widget. If the online 
help is not in your navigator, see your system administrator.
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 a. Move the online Help widget to the primary position. 

 b. Expand the topics in the Contents list and select a topic or click the Search tab and search for a 
specific topic.
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Chapter 15  

Review Productivity with 
the Metrics Widget

Depending on the configuration, you can access the Metrics widget in either of two ways:

Metrics alerts
If Metrics alerts are active, the system will alert you to significant differences between a number of 
configurable indicators, such as scheduled hours and planned coverage, for the anticipated volume. The 
Metrics alert icon displays the number of indicators that are different from a defined target or threshold.
When you log on to your navigator, if a productivity metrics target has been reached, the Metrics alert icon 
displays the number of events. Click the icon and review the alerts in the list.
The system refreshes the number of alerts displayed when you log on and at every 1-hour interval 
afterwords. 
When you select an alert from the list, the Metrics widget opens in the primary position. 



Example:

 l The system behaves differently depending how your administrator defined the alert processing interval. 
For example:

 l If the alert processing interval is set to individual days, and store 101 performs above the target for 
actual hours on Monday, Tuesday and Wednesday, three alerts are reported.

 l If the alert processing interval is set to overall time period, and on Sunday (the first day of the time 
period), store 101 performs poorly, operating at 110% of actual hours, one alert is reported if the target 
was set to 100%. The alert remains present until the next time period starts or the indicator value 
changes.

 l Check with your administrator for information about how your widget is configured.

Review productivity with the Metrics widget
If you prefer or if your navigator does not include Metrics alerts, you can access the Metrics widget 
directly.
The Metrics widget allows you to review productivity metrics by comparing budgeted, targeted, scheduled, 
and actual hours or volume data to see how well scheduled and actual use of resources matches 
expectations. 
Productivity metrics are controlled by indicators, which are typically defined for your organization and 
cannot be changed here. Depending on your access rights, you may be able to edit your preferences and 
select those indicators that you want to monitor in the Metrics widget.
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Alternative: For more functions and detail, use the Metrics in the Schedule Planner widget or the 
Metrics tab of the Schedule Planner.

Example:

 l Actual Hours — Displays the actual hours compared to scheduled hours. The scheduled hours are 
called the target or threshold. If the actual hours exceed the target, they display red, if they are lower 
than the target, they are green, and if they are equal to the target, they are blue.

 l Scheduled Hours — Displays scheduled hours. If the scheduled ours exceed the defined target they 
display as red, if they are lower than the defined target they are green and if they are equal to the target 
they are blue.

Like all widgets, the Metrics widget can be in the secondary position or the primary position. 

Secondary view 

When the Metrics widget is in the secondary view, it provides the following information:

 l Default time period and location
 l Summary information

213



Primary view 

To move the widget to the primary position, click the title bar and drag it to the primary position. In the 
primary position, the Metrics widget displays a summary view at the top and a detailed view at the bottom. 
When you select an indicator in the summary view, the details for that indicator display in the detail view.

Detail view

The detail view displays a daily detail bar chart for the selected indicator. Each bar includes a target bar, 
which defines the target value. 

 l If the indicator amount is more than the target, the “Daily Greater Than Target” color from the color 
key displays above the bar. 

 l If the indicator amount is less than the target, the “Daily Less Than Target” color from the color key 
displays below the bar.

 l If the indicator amount equals the target, the “Daily Equal To Target” color from the color key displays 
below the bar.

 l When you hold your mouse over one of the target bars, the system provides additional information.

Set Preferences — Metrics widget

Depending on your access rights, you may or may not be able to set preferences for the widget.
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 1. Click the gear icon in the upper right of a widget and then select Preferences.

Tip: Additional options are available. You can click Close to move the widget to the Related Items 
pane. If you are working on a secondary widget, you can click Pop-out to move the widget to the 
primary position.

 2. Edit the following options. If an option has an asterisk next to its label, you must provide information; 
the option cannot be blank.

 o Indicators — Indicators compare planned with actual workload, labor volume, coverage, volume, 
hours, and cost at any organizational level. The indicators listed were defined for your organization; 
you cannot change them here. Select up to eight indicators from the Available box and move them to 
the Selected box. Hold down the Ctrl key to select more than one indicator.

 o Location Type — Select one of the location types listed. The selections are defined for your 
organization; you cannot change them here.

 o Hours Category Set — Hours categories put schedule metrics indicators into groups according to 
the percentage of shift time that corresponds to jobs or pay code edits. Hours category sets group 
hours categories. This grouping strategy allows you to use indicators to compare direct to indirect, 
and productive to non-productive hours. If your environment uses hours categories, select one from 
the drop-down list. If your environment does not use hours categories, the drop-down list is blank.

 o Time Period — Select one of the time periods listed. These time periods were defined for your 
organization; you cannot change them here.

 o Location — Select All Home Locations or custom locations.
 o All Home Locations — The home location of the person using the widget displays in the navigator.
 o Custom locations — If custom locations are defined, they are in the list.

 3. Click Save and then click X to close the window.
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Chapter 16  

Staff Management Widget

The Staff Management widget gives you quick access to your daily staffing plan so that you can make 
adjustments to your schedule when unforeseen events occur, such as when an employee calls in sick, or 
when an unplanned event requires extra or fewer staff during a scheduled time period. You can easily 
access the data that you need while keeping the impact on the budget and on service to a minimum.
The Staff Management widget allows you to operate optimally across departments or units with your 
available budget and staffing resources. Note, however, that it is a tool for daily operations, and it does not 
take the place of the Schedule or the Schedule widget. 
The Staff Management widget reflects changes to the schedule that are made, for example, in Scheduler or 
the Schedule widget. Changes made to shifts in the Staff Management widget, are reflected in the 
schedule, as well. Use Refresh to ensure that you are seeing the most up-to-date information.

Staff management process

 l Importing or manually entering external driver data (point-of-sale volume, planned workload, budget 
data, etc.)

 l Verifying shift fidelity (time-off requests, sick calls, etc.)
 l Adjusting staff to new demands based on the above factors
 l Repeating the process as necessary, often several times a day
 l The locations and jobs that you can select are determined by the locations and jobs in your 

organizational group.



Primary view
When the Staff Management widget is in the primary position in the navigator, it displays the locations, 
such as units and departments, and jobs that are configured in your Preferences. You can select different 
options from the drop-down lists in the header area. Each location in the widget contains for the selected 
time span:

 l Jobs that are scheduled 
 l Pay codes 
 l Open shifts that are available to be filled.
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Secondary view
In cases where you have more than one widget in your workspace, you may see the Staff Management 
widget is in the secondary position. This is how it appears before you have dragged it to the primary view. 
In the secondary view, the Staff Management widget displays the basic coverage information for each last 
selected location in the last selected time period.

 l

Select the data to view
In the primary view, you control the date, locations, zones or shifts, and jobs that you see by selecting 
from the drop-down menus in the header area at the top of the Staff Management widget. These 
selections define the context for the data displayed. 

The list of options that you can choose from is based on your organizational group. The lists also 
depend on the location that you select: only jobs and shifts or zones for the selected location are on the 
drop-down menus.

Important: Click Refresh to update Staff Management widget information. Changes to the schedule 
are not automatically displayed. Refresh ensures that you see any changes that someone else made to 
your schedule.
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Dates
You can select Today, Tomorrow, or Yesterday as the date to display. Because most of the time you 
will be making adjustments for a shift later today, Today is the default.
You can select any date from the Calendar icon.

Locations
You can select specific locations in Preferences or in the Staff Management widget. You can also 
select Custom Locations that you created in the Schedule Planner from either of the Location drop-
down lists. 
You must have an organizational map installed to see the location links.

Tip: For best performance, select only the units that you need to see.

Select locations. Either:

 o Select one of your locations from the list.
 o To see all the areas in your organization set, select All Home Locations.
 o To select one or more locations from the organizational map, select Select Location(s)... Select the 

locations. The locations that you see are determined by the Location Type selected in the 
Preferences.

Locations in a large organization 
Large organizations may use a central staffing office to manage schedules and coverage for large 
numbers of employees (200+). Although the office needs access to a large number of employees, they 
do not necessarily need to see all the employees at one time, and loading all employees at once is a 
drag on performance. 
To enhance performance, you can select only the specific locations and associated employee pools that 
you need to see.

 a. Click the gear icon in the upper right corner of the Staff Management widget and select 
Preferences.

 b. In Location, select None.
 c. Click Save.
 d. In the Staff Management widget, select Locations to select only the locations that you need from 

the organizational map. Or select another option.
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 e. Click Save.

Select custom locations
You can create a custom location in Scheduler and save it with a name. The custom locations that you 
create then show up on the Location drop-down list in both the Staff Management widget and in 
Preferences. The custom locations that are on the Location list appear only on your list. Other 
managers cannot see or use your custom locations.
To create and save a custom location: 

 a. In the Schedule Planner, click Show.
 b. Select Select Locations.
 c. Click Clear All. 
 d. Select the location or locations that you want.
 e. Click Save As.
 f. Enter a unique name for the locations. Click OK. 
 g. When you go to the Staff Management widget, the custom locations that you created and saved are 

on the Location list in both Preferences and the Staff Management widget.

Important: You cannot select jobs instead of locations from the organization map. The Staff 
Management widget does not support job selection from the organizational map.

Shift sets and zone sets
Either:

 o Select All Day to see all of the employees with a shift or pay code for the selected locations and 
jobs. 

Important: All Day is not based on the definition of the Day Divide.

 o Select a single shift or zone from the drop-down list. The list contains the shift sets and zone sets 
that are associated to the selected locations. Shifts are displayed first and then zones. 
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Jobs
Select All Jobs to see all the jobs in the selected locations that are in your organizational group, or 
select one job from the drop-down list. The list refreshes when you select a different location. 

Refresh
Click Refresh to update the Staff Management widget with any changes that have been made to the 
schedule. At the same time, the schedule is updated with information from the Staff Management 
widget.

Important: Changes to the schedule are not displayed automatically. Refresh ensures that you see 
any changes that someone else made to the schedule.

If you try to make a change to a value that has been changed in the schedule, you will get an error 
message. You cannot overwrite someone else’s changes.

Display the Employee Pool

Click the people button  to display or hide the Employee Pool. 

Visual indicators 
You can see several visual indicators about employee-related status in the unit.

 o A visual indicator may show to the right of the unit name to indicate the occurrence of an Org Rule 
violation. 

 o Up to four visual indicators display to the left of the employee name, depending on whether the 
indicator applies to the item and whether the indicator has been set to visible in Preferences. 

Indicator Icon Description
Org Rule 
violation

One or more Org Rule violations has occurred in 
the unit.

Rule violation 
warnings

One or more rule violations occurred on the 
employee for the selected context. 

Transfers Any type of transfer exists on any segment of the 
shift.
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Indicator Icon Description
Locks The item is locked by All shifts or Shifts by Date.

Comments and 
notes

The item has comments or notes that apply 
to it.

The indicators are highlighted in blue when they are active, otherwise they appear in gray. Click each 
indicator to launch a dialog box.

Note: Unlike in the Schedule widget, Schedule Editor, or Schedule Planner, shifts that employees 
self-schedule are not indicated by bold text in the Staff Management widget.

Indicator dialog boxes
When you click a visual indicator, a dialog box opens under the indicator.

Rule violation warnings
This indicator displays when there are rule violations for the employee. The associated rule violation 
messages are displayed in the dialog box. A vertical scroll bar appears if more than two messages are 
displayed. 

Transfers
This indicator displays when there is at least one transfer within the shift. This transfer can be a job or 
labor level or work rule. Transfers are defined for both segments and shifts, and one shift can have 
multiple segments. The shift transfer indicator indicates that the shift or segment contains one or more 
types of transfers in the shift, such as Job transfer, Labor level transfer, or Work rule transfer. To see 
more details, click on the indicator to open the dialog box.

Shift transfer indicator format 
[Date] [label or start/end time of shift]
----------------------------------------------
[start time segment][duration]
Job transfer: [Working Job path]
Primary job: [primary job path]
Labor level transfer: [labor level transfer]
Work Rule: [work rule] 
---------------------------------------------

Example of dialog for shift transfer indicator 
Tue 7/17 day shift
-----------------------------------------------
[7:00] [5.5]
Job transfer: Organization/Hospitals/Hosp A/Floor 1/ER/RN
Primary job: Organization/Hospitals/Hosp A/Floor 1/ER/CR
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Labor level transfer: 100/201/302/404
Work Rule: Part time
------------------------------------------------
[13:00][2]
Work Rule: Part time
------------------------------------------------
[15:00][1]
Job transfer: Organization/Hospitals/Hosp A/Floor 1/Pediatrics/RN
Primary job: Organization/Hospitals/Hosp A/Floor 1/ER/CR

Example of dialog for shift transfer indicator 
Job transfer: Organization/Hospitals/Hosp A/Floor 1/ER/CR
Primary job: Organization/Hospitals/Hosp A/Floor 1/ER/RC
Labor level transfer: 100/200/300/401
Work Rule: Call-in

Segment transfer indicator format 
Job transfer: [Working Job path]
Primary job: [primary job path]
Labor level transfer: [labor level transfer]
Work Rule: [work rule] 

Note: The labels and values for the items in the indicator dialog box only appear if that item actually 
is in the segment.

Locks
This indicator displays when the shift is locked.If a shift is locked by All Shifts or Shifts by Date, it 
displays as a Locked Shift.

Comments and notes
This indicator displays when there are comments on the shift. Multiple comments are separated by 
lines. The notes are displayed in the dialog box as:
<Text><last_editor’s_ID><last_edit_date_and_time> 
Example:
Note;269;07/06/2012;1:42 PM 
A vertical scroll bar appears if more than two comments or notes are displayed.

Pinning 
Pinning allows you to reduce the number of units to view by pinning only the units that you want to 
view. To view only the pinned units:
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 a. Click the toggle button  that is located on the top right corner of the unit. The pin turns 
orange when selected. 

 b. Click the Pinned toggle button in the toolbar area of the Staff Management widget.
 c. To unpin the unit, click the toggle button again. By default, all units are unpinned. 
 d. You can pin units on different pages. The units will remain pinned until you put the widget in the 

related items drawer or log out of the navigator.

Pagination 

 a. You can page through the units using the page indicator in the middle of the bottom of the units. 

The number of circles represents the total number of pages and adjusts automatically if the page 
number changes

 b. Hover over the page circle to see a tool tip with all the unit names on the page.
 c. Click the page circle to navigate to the associated page. The circle of the current page is filled in 

blue.
 d. Click the arrows to navigate from page to page.

 l

Read schedule information
The units or departments on the Staff Management widget contain many pieces of information.
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PLN — Planned is the sum of all people hours in the adjusted workload plan for a time span, divided 
by the time span. If the adjusted workload plan is zero, the default values are taken from the baseline 
workload plan or the baseline labor forecast.
Example: If you have 3 employees planned from 8:00 to 10:00 and 4 employees planned from 10:00 to 
11:00, your calculation is:
((3*2) + (4*1))/3 = 3.33 employees
This is the average number of employees required for the given period.
SCH — Scheduled is the sum of all people hours that are scheduled in the Schedule Planner and 
Schedule widget for the defined time span, divided by the time span.
VOL — Volume is the projected volume for the selected time span: In Health care, volume is 
weighted and is based on census; in Retail, volume is sales.

 o The abbreviation for volume is configurable and may be different in your Staff Management widget. 
Example: The abbreviation could be labeled CEN, for census, rather than VOL for volume.

 o If Budgeting is installed, all volumes are based on forecast sales from the Published Plan, and 
locations associated to shift or zone sets display volume as N/A.

Unit Name
Unit Name is the name of the selected location; for example, ER. Hold the cursor over the name to 
display the full path name in a tool tip. 

Coverage details
The Coverage details window shows coverage status, designated by the color of the arrow. 

 o Red indicates undercoverage. Undercoverage measures every minute of undercoverage during a 
selected time span (ignores overcoverage) divided by the selected time span.

 o Green indicates overcoverage. Overcoverage measures every minute of overcoverage during the 
selected time span (ignores undercoverage) divided by the selected time span.

 o Black indicates zero (0) overcoverage or zero undercoverage
 o Click the blue bar at the top of the unit to see coverage details.
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 o Variance is the difference between total scheduled hours for the time span minus total planned work 
hours for the time span. 

 o Hold the cursor over a job name to see a tool tip with the full path.

How the system calculates coverage
The following illustrations are examples of how planned (PLN) and scheduled (SCH) coverage values 
are calculated in the Staff Management widget. The values depend on what is selected in the time 
span. Although the example uses zone sets, the same type of calculation is used for shift sets.

Important: The calculation for All Day coverage — planned and scheduled — is based on a day 
from midnight to midnight, and not on the configured Day Divide.

Planned Coverage (PLN) 
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Calculation

Time Span (Employees x Hours)/Time span hours
Displayed 
Result

Night Zone 11p - 
7a

(4*8) / 8 4.0

E Day 7a - 11a (8*4) / 4 8.0
L Day 11a - 3p (11*4) / 4 11.0
Evening 3p - 11p (8*8) / 8 8.0
All day ((4*7) + (8*4) + (11*4) + (8*8) + (5*1)) / 

24
7.21

7.21 is the average number of people required by the hour for the day.

Scheduled coverage (SCH)
Schedules for eleven employees are indicated by the rectangles drawn on the time spans. 

Calculation 

Time Span (Employees x Hours)/Time span hours
Displayed 
Result

Night Zone 11p - 
7a

(4*8) / 8 4.0

E Day 7a - 11a (3*4) / 4 3.0
L Day 11a - 3p (4.5*4) / 4 4.5
Evening 3p - 11p (5*8) / 8 5.0
All day ((4*7) + (3*4) + (4.5*4) + (5*8) + (0*1)) / 

24
4.08
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4.08 is the average number of people scheduled by the hour for the day.

Where volume and planned values are obtained when Budgeting is installed 
When Budgeting is installed, the values for PLN and VOL are obtained as follows:

Plan (PLN)   
Is Budgeting installed? Is labor forecast 

configured?
Plan comes from:

Yes Yes Labor forecast
Yes No Workload Planner
No n/a Workload Planner

Volume (VOL)  
Is Budgeting 
installed?

Time span selected Volume displayed

Yes All Day Forecast sales
Yes Shift set or zone set n/a
Yes Defined time span n/a
No All Day Sum or prorated, projected, weighted 

volume

For Retail, if zone sets and shift sets are not configured, values for volume (VOL) and planned 
(PLN) are represented by day.

How the All Day census is calculated
When you sue All Day, census is the sum of prorated, projected, weighted volume.
Example:

Zones:
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 o Day — 7-3p
 o Eve — 3p-11p
 o Night — 11p-7
To calculate the volume for Thursday from midnight to midnight, volume for the Night zone is prorated 
as follows:

 o From midnight to 7a, the Wednesday night shift is used.
(Hours in the Thursday time span / Zone length) * Projected volume for the 
night shift on Wednesday
(7/8)*1 = 0.875

 o For the volume for the night shift from Thursday to Friday, the same calculation is used:
(1/8)*2 = 0.25

 o The volume for All Day is:
.0875 (from Wednesday) + 5 (the day zone) + 3 (the evening zone) + 0.25 
(from Thursday) =- 9.125 which is rounded to 9

Tip: If the census is updated several times, the value is the latest value from the projected 
weighted volume.

Employee information
Each row for a location contains the last name, first name, and job (in the unit) for the first segment of 
the selected time span.
If no labels are defined, you see the start and end times. Hold the cursor over the label to see a tool tip 
with the job details and shift or zone time details for the employee.
An ellipse at the bottom of the list of employees in a location indicates that the list is longer. When you 
hold the cursor on the location, you see an up arrow and a down arrow, which you can use to scroll 
through the entire list.

Pay codes
Green type indicates a pay code. Pay codes show only for employees for whom this is the primary 
location. 
If you put a pay code edit on a transferred employee, the employee disappears from the unit he 
transferred to and appears in his primary location.

Transfers
Double arrows before the name indicate at least one employee transfer within the span. The transfer 
can be a job, labor level and/or work rule transfer.
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Sort by employees or jobs
Click the sort arrows to list shifts by employees (in alphabetic order) or by jobs (in alphabetic order). 
Click the sort arrow again to sort the items in the other order. 

Open shifts are always at the top of the list in red. A shift with a pay code is in green type. 

Show shift details
If you hover the cursor over a shift or zone, an open shift, or a pay code, the details of that span, 
including comments, display in a tool tip.

Shift or zone tool tip 

 o If an employee has more than one shift on the same date, there is one row for each shift, and a tool 
tip for each.

 o If a shift has a transfer segment and the job for each segment is in a different unit, then the shift 
appears in both units. The shift start and end times are shown in both units for the entire shift, not for 
the applicable segment.
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Open shift tool tip 

Pay code tool tip
You can also see details for a pay code by holding the cursor over a line in green type. 

 l

Show the Employee Pool
The Employee Pool is a list of employees who are not scheduled to work in the selected context and do 
not have pay codes in the selected context. Their primary job or a job in their transfer set matches the 
selected job and selected location in the context.
The employee pool includes all the people from the manager’s organizational group. It also includes 
anyone missed by the Location Type selected in Preferences. Example: If the Location Type is Unit 
and someone is working a job in the manager’s organizational group at the Department level (one level 
up), that employee shows up in the Employee Pool whether they have a shift or not. 
You can filter the employees in the Employee Pool by job by selecting a job in the context. Example: If 
you select RN as the job in the header area, then the Employee Pool shows only employees who can 
work the RN job because it is their primary job or it is in their job transfer set.

Important: Employee Availability is not taken into account. Therefore, it is possible to schedule 
unavailable employees to work. If you select an employee who has a schedule rule violation, an error 
message displays for No Save-type rules. Schedule rule violations do not have visual cues at this 
time.

To display the Employee Pool, click the People button . 
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 a. To fill an open shift with an employee from the Employee Pool, select the employee in the pool and 
drag the employee to the open shift. You can drag employees only to an open shift.

 b. You can limit the size of the Employee Pool by selecting a specific Job in the header.
 c. You can sort the Employee Pool by Name, Primary Job, and shift. Click the column header to sort.

Tip: For best performance, close the Employee Pool when you are not using it.

List employees in the Employee Pool
Members of the Employee Pool vary depending on the selections in the context. If you select:

 o  All Day — Show employees with no shift or pay code who can work the selected jobs, and who are 
in the manager’s organizational group.

 o  A specific shift or zone — Show employees who are not scheduled in the selected shift set or zone 
set and who are in the manager’s organizational group and can work the selected jobs.

If an employee in the pool has a shift at a time other than the selected time span, the shift label or start 
and end times are displayed in the Shift column of the Employee Pool.

Scenarios for the Employee Pool
A manager and an employee have the following assignments:
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 o Manager

 l Organizational group contains:

 l Hospital A 
 l Hospital B

 l Transfer set contains:

 l Hospital A
 o Employee 

 l Primary job is: 

 l Hospital B/Pediatric/RN2
 l Job transfer set contains:

 l Hospital B/Pediatic/RN
 l HospitalB/Pediatric/Clerk

Depending on what the manager selects in the context, the results are: 

Context
Employee 
in pool? Result

All 
Home 
Locations

All 
Day

All 
Jobs

Yes Employee is in the pool because they are in the manager’s 
organizational group and can work at least one job in the 
selected context.

Hospital 
A

All 
Day

All 
Jobs

No Employee is not in the pool because they cannot work any 
jobs in the selected context.

The context also controls the actions that a manager can take on a specific employee. Example: If a 
manager selects All Home Locations, All Day, and All Jobs, they can do the following for the 
employee: 

Manager Action Result
Assign employee to 
primary job 
(Hospital 
B/Pediatric/RN2).

Employee can be assigned to the employee’s primary job.
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Manager Action Result
Transfer the 
employee to an 
open shift in 
Hospital B.

If the open shift in Hospital X is not the employee’s primary job, the 
manager gets an error message because the job is not part of the 
manager’s transfer set.

Transfer the 
employee to an 
open shift in 
Hospital A.

The manager can transfer the employee to an open shift in Hospital 
A, because Hospital A is in the manager’s transfer set, and the 
manager’s transfer set takes precedence over the employee’s transfer 
set.

 l

Add open shifts

Add open shifts to locations
You can add open shifts in the Staff Management widget. They also appear on the Schedule widget and 
the Schedule Planner.

 a. Click the sort arrow to the left of the location name. 

 b. Select Add Shift.
 c. Optionally, in Label, enter identifying text for the shift. Example: Day for a day shift.
 d. Select the Start date.
 e. Enter the Start time for the shift.
 f. Select the End date. 
 g. Enter End time for the shift.
 h. Select the Job. 
 i. Click Add.
 j. To add another segment with another job, add a transfer.
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Assign open shifts to employees

 a. Select the name of an employee in the Employee Pool.
 b. Drag the name to the open shift.
 c. To assign someone who is already scheduled for another shift:

 a. Unassign that person so that they enter the Employee Pool.
 b. Drag their name to the open shift.

 l Transfer shifts or segments

 o Add a segment with a transfer

You can add a segment with a transfer to a shift that is assigned to an employee or to an open shift.
Either:

 l Select Breaks. Enter a break of at least 1 minute.
 l Click again on the shift and select Change Job. Edit the segment for the transfer.

 o Transfer a full shift to another unit

You can transfer an employee’s full shift to another unit.
Either:

 l Use drag and drop:

 a. Select an employee’s shift to transfer.
 b. Drag the selected shift to another unit.

 l Use the Action menu:

 a. Click the shift and select Change Job.
 b. Edit the shift for the transfer.

Important: 

 l All work segments must have the same org job. Breaks are allowed.
 l You can drop a shift anywhere in the unit, except over an open shift, if the any of the following 

conditions are met:

 l A labor level transfer exists in the dragged shift.
 l A work rule transfer exists in the dragged shift.
 l The job does not exist in the target unit.
 l The job exists in multiple locations for the target unit.
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 o Transfer a segment to another unit

You can transfer a segment of an employee’s shift to another unit.
Either:

 l Use drag and drop:

Note: The segment of an open shift cannot be dragged. To transfer a segment, drag and drop it 
in another unit.

 a. Select a segment of an employee’s shift to transfer.
 b. Drag the selected segment to another unit.

 l Use the Action menu:

 a. Click the segment and select Change Job.
 b. Edit the shift for the transfer.

 o Transfer a full shift to an open shift 

You can transfer an employee’s full shift to an open shift, as long as the start and end times are the 
same.

 a. Select an employee’s shift to transfer.
 b. Drag the selected shift over an open shift.

 l If the start and end time differ, the error message states that the start and end time of both 
shifts must be the same. 

 l If the shift times are the same, the open shift is replaced by the transferred shift.

 l Edit schedules with the Actions menu 

To show the Actions menu, click the arrow next to the shift that to change.
Example Actions menu for an employee who has a shift: 
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The Actions menu varies depending on the context:

 o For an open shift, the Unassign and Add Pay Code options are not available.
 o For an employee who has a pay code, only Delete and Comment are available.

Change the start time of a shift
The Change Start Time action allows you to change the start date and time of the selected shift. The 
start date is limited to only the day before the current day of the day selected.

 a. Click the shift to change.
 b. Select Change Start.
 c. If the selected shift has a Label, the label name displays. Edit it if you want to.
 d. If the new start time is on an earlier date than the current shift, enter the new Start date.
 e. Enter the new Start time.
 f. Click OK.

Change the end time of a shift
The Change End Time action allows you to change the end date and time of the selected shift. The end 
date is limited to only the current day or the day after the day selected.

 a. Click the shift to change.
 b. Select Change End.
 c. In Label, the label for the selected shift displays. Edit it if you want to.
 d. If necessary, enter the End date for the new end time.
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 e. Enter the new End time.
 f. Click OK.

Add or change the label for a time span
You can add or edit a Label for a time span using the Action for Change Start or Change End from the 
Action Menu.
If no name is entered in the Label field, only the shift Start Time and End Time appear. Example: 8:00p 
- 3:00a.

 a. Click the shift to change.
 b. Select Change Start or Change End.
 c. In Label, add a name for the time span or edit an existing label. This label displays on the widget in 

the right-hand column. 

Add or edit shift segments

 a. Select an assigned shift.
 b. Left-click to open the Action Menu, and select Change Segment. The Change Segment dialog box 

opens with all shift segment information, including breaks.

 c. To show segment details, click the right arrow  next to the segment start and end times.

 d. To edit a segment, enter your changes, and click OK.

 e. To delete one or more segments, click the red Delete button  and click OK. At least one non-
break segment must remain in the shift.

 f. To Add a segment, click Add Segments. The New Segment opens.
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 g. In the new segment, optionally, select a different Start date.
 h. Enter a Start time. You cannot overlap the new segment with any part of the original shift. It must 

start and end before or after the original shift.
 i. Enter Duration in the format hh:mm.
 j. Optionally, select a Details option from the drop-down menu. 
 k. To add another segment, repeat.
 l. Click OK.

 m. To see an added segment in a tool-tip, hover the cursor over the shift.

Add breaks
The Breaks action allows you to add, edit, or delete a break for an existing shift.

 o If Shifts Conform to Break Rules is selected, and if you enter a break that fails validation, you get 
an error message. Otherwise, no validation is performed. 

 o You can create one or more breaks in a shift.

 a. Click the shift to change.
 b. Select Breaks.

 c. Click  Add Break.
 d. The default break Start date is the start date of the shift. You can change it if necessary.
 e. Enter the break Start time.
 f. Enter the break Duration.
 g. To enter another break, click the green Add Break button and repeat.
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 h. To edit an existing break, select a new start date and time or a new duration for the break.
 i. To delete a break, click the red button on the right of the break.
 j. Click OK.

Add comments to shifts or pay code edits
Comments that you add to a shift or zone, pay code, or open shift display in the tool tip for the time 
span.

 a. Click the shift to change. 
 b. Select Comments.
 c. Select the comments.
 d. Click OK.

Lock shifts
A shift that is locked cannot be changed.

 o To lock a shift, click the shift and select Lock.
 o To unlock a shift, click it and select Unlock.

Transfer jobs, labor levels, or work rules
For the selected shift, you can:

 o Change jobs (add a transfer)

 a. Click the shift to change.
 b. Select Change Job.
 c. For more than one segment, select the one you want or enter the Start time and the End time 

for the transfer.
 d. To transfer to another job, select the new Job. You can also select Select Location(s)... > 

Clear Locations and then select a job from the Organizational Map. 
 e. Click Select.
 f. To transfer to another labor level and/or another work rule, click Advanced.
 g. Click Add.

 o Change labor levels

 a. Select a shift and click Change Labor Level from the Actions menu.
 b. Select a segment or enter a start and end time.
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 c. Select the new labor level from each available labor level.
 d. To delete a labor level row, click the red minus button.
 e. To clear all levels, click Clear All.
 f. Click Advanced to change a job or work rule.
 g. Click Add.

 o Change work rules

 a. Select a shift and click Change Work Rule from the Actions menu.
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 b. Select a segment or enter a start and end time.
 c. Select a work rule.
 d. Click Advanced to change a job or labor level.
 e. Click Add.

Assign skill and certification profiles 
Add or edit Skill & Certification Profiles for regular and transfer shift segments.

 a. Click the shift.
 b. Select Change Skill & Certification Profile from the Actions menu.
 c. Select a segment.
 d. Select profiles.
 e. Click OK.

Add a pay code edit
Adding a pay code, such as sick or vacation, does not create an open shift.

 a. Click the shift to change.
 b. Select Add Pay Code.
 c. Enter the Effective Date for the pay code edit. This is the date when the pay code edit occurs.
 d. Select the Pay Code.
 e. Depending on the pay code, select an Amount of time or money.
 f. Enter the Start Time for the pay code edit.
 g. Optionally, open the Advanced section.
 h. If the pay code edit replaces a shift, select Override Shift. 
 i. To create an open shift with the same attributes as the replaced shift, select Create Open Shift. 

Note: The Override Shift check box is checked by default. If you would prefer it to be 
unchecked, your system administrator can change the default setting so that Override Shift is not 
checked.

 j. If the pay code edit is in addition to the shift, clear Override Shift. Example: Pay a bonus or 
schedule an on-call shift, do not override the shift. 

Note: If an employee has more than one scheduled shift during a day, a pay code edit overrides 
only the first shift that day. To change this default override, contact your system administrator.
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 k. In Repeat for (D), enter the number of consecutive days to repeat the pay code edit. 
 l. Click Add.

Delete a shift
When you delete a shift, an open shift is not created to replace it. The employee who was scheduled 
for the shift moves back to the Employee Pool.

 a. Click the shift or pay code to delete.
 b. Select Delete.
 c. Verify that the information is correct, and click Delete. The employee is returned to the Employee 

Pool. The shift is deleted, and no open shift is created to replace it.

Unassign a shift
When you unassign a shift, an open shift is created to replace it. The employee who was scheduled for 
the shift is moved back to the Employee Pool.

 a. Click the shift to change. 
 b. Select Unassign.
 c. Verify that the information is correct, and click Unassign. The employee is returned to the 

Employee Pool. An open shift is created to replace the unassigned shift.

 l Edit schedules with quick actions 

Quick actions duplicate the most commonly used capabilities of the menu selections in the Staff 
Management widget, bypassing most dialog boxes. In some cases, fewer options are available when 
working with quick actions, but the payoff is fewer mouse clicks to get the job done. 

Quick action bar

The quick action bar is part of the Staff Management widget toolbar. Three buttons and a drop down 
menu provide access to the quick actions.

 o The left button and the center button are determined by the system.
 o The right button is the most recently used quick action.
 o The drop-down menu provides access to actions that are not currently visible as buttons in the quick 

action bar.

How Quick actions work

The mouse clicks for quick actions are different from the mouse clicks for menu commands. When you 
click a quick action button, the action remains active and highlighted until you deactivate it. 
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Example: If you need to lock several shifts, you can click the Lock Shift button once, then select each 
shift you want to lock. Do not click the Lock Shift button again until you are finished locking shifts. 
This makes it easy to repeat an action several times. However, this also means that you must 
intentionally deactivate the action when you are finished using it. To deactivate an active quick action, 
click a different quick action button, or click anywhere in the toolbar except the zoom controls. 
Visually, the quick action button reverts to its default state (not highlighted) and the quick action is 
deactivated. 
The quick action is also deactivated when you change the time frame or change the location.

Tip: Quick actions allow you to make many changes to your schedule in a very short time. 
Remember to save frequently.

 Copy/Paste 
Duplicates a shift in the schedule and applies it to a different time, employee, or job
The Copy/Paste quick action behaves differently depending on whether you are in the Employee view 
or the Job view.

 a. Click the Copy/Paste button. 
 b. Select the shift to copy.
 c. Select one or more cells, jobs, or employees to paste the copied shift.

 Add Pay Code 
Replaces a shift with a pay code

 a. Click Add Pay Code.
 b. Select the pay code from the list that appears. Only time-based pay codes are available.
 c. Select one or more scheduled shifts to apply the pay code to each.

 Assign Shift 
In Employee view only, assigns an open shift to an employee

Important: The time and date of the assigned shift is always the same as the open shift. You cannot 
move the open shift to another time with this action.

 a. Select Employee view.
 b. Click the Assign button.
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 c. Select an open shift.
 d. Select an employee name or anything in the employee’s row of the schedule to assign the shift to 

that employee.

 Unassign Shift 
Removes a shift assignment to create an open shift

 a. Click the Unassign button.
 b. Select one or more assigned shifts to change to open shifts.

 Delete 

 a. Click the Delete button.
 b. Select one or more shifts or pay codes.

 Lock Shift 

 a. Click the Lock Shift button.
 b. Select one or more assigned shifts.

 Unlock Shift 

 a. Click the Unlock Shift button.
 b. Select one or more locked shifts.

 Apply shift template 
Assigns a pre-defined shift template to an employee or a job for the date you select. 

 o If you assign a shift template in the Employee view, you create an assigned shift. 
 o If you assign a shift template in the Job view, you create an open shift.

 a. Click the Shift Template button.
 b. Select a template from the list.
 c. Select a cell in the Schedule widget to assign the shift template to an employee and a start date (in 

246



the By Employee view) or a job and a start date (in the By Job view).
 d. (Optional) Select more cells to assign the same shift template to the employee or job on the start 

date of each selected cell.

 Transfer Shift 
Changes the job for a shift 
All segments of all selected shifts are assigned the selected job. Other data associated with the shift do 
not change.

 a. Click the Transfer Shift button.
 b. Select the job. The list contains only jobs that are in both your current transfer set and the selected 

location or jobs selected under a location
 c. Select one or more scheduled shifts.

 Add Comment 
Attaches a comment to a shift or pay code

 a. Click the Add Comment button
 b. Select a comment category from the list: Shift or Pay Code.
 c. Select a comment.
 d. Depending on the comment category you selected, select shifts or pay codes to attach the same 

comment.

 l Set Preferences — Staff Management widget

Optional: Depending on your access rights, you may or may not be able to set preferences for the 
widget.
Click the gear button in the upper right corner of the Staff Management widget and select Preferences.

This dialog box lets you select the default options on the drop-down lists in the header area of your 
Staff Management widget. The items selected in this dialog box are your preferences — what you 
usually select. You can select something different in the header area lists. You can also change the 
defaults at any time.
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 o Location preferences

 a. Select the highest location in the hierarchy that you want to see. All locations and jobs under this 
location are available for you to select in the Staff Management widget. You can select 
locations only from your organizational group.

 b. If you have a large number of employees to schedule, you can select None or you can create a 
named group of specific locations. 

Select None for location
In Preferences, you select what you want to see as the default context in the Staff Widget. If you 
select None in Preferences, then the Staff Management widget opens with no data displayed in the 
context. You can then select the data and locations that you need to deal with. 
To select locations in the Staff Management widget:

 a. Click the gear button in the upper right corner of the Staff Management widget and select 
Preferences.

 b. In Location, select None.
 c. Click Save.
 d. In the Staff Management widget, select Locations to select only the locations that you need 

from the organizational map. Or select another option.

 e. Click Save.

Select locations
If you select locations from the organizational map in Preferences, the locations that you selected 
load into the Staff Management widget.
To select locations in the Staff Management widget:

 a. From the Staff Management widget Gear button, select Preferences.
 b. In Location, select Select Locations.
 c. If necessary, click Clear Locations to move all selected locations back to the left.
 d. Select the locations that you want from the left. Use the right arrow to move each selected 

location to the right.
 e. Click Select to return to the Preferences page.
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 f. Click Save. The Staff Management widget opens with Selected Locations in the context and the 
details for those locations loaded. 

Location Type
The Location Type selection that you make affects what can be displayed on your widget. Example: 
If you select Division as your location type, the widget shows only the locations that are configured 
as divisions.
The widget does not show a mix of location types. Example: You cannot view both departments and 
units at the same time. If you select Department, and there are two units under the department, the 
department displays with a summary of the units’ coverage. To see unit details, you must change 
your Location Type preference to Unit.
All the Locations Types that have been defined for your organization are included in the list, and not 
just those to which you have access in your organizational group.
The locations that you see in the Staff Management widget depend on:

 l Your organizational group
 l The Location Type selected in Preferences
 l The Location selected in the context of the widget
Example location and location type:
Organizational map
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Sally Smith has Hospital A in her organization set. She can see all jobs in the Units under that 
location: Floor 1, Floor 2, and Floor 3.
When Sally selects Hospital A as the location in the widget context, all of the departments under 
Hospital A are shown; in this example, ER, Pediatrics, Maternity, and ICU.
If Sally selects Labor and Delivery, all of the departments under Labor and Delivery are shown. In 
this example, there are no departments under Labor and Delivery; therefore the widget is empty.
More examples for Sally Smith:

Location Type 
selected in 
Preferences

Location selected in 
widget context What you see

Location Hosp A Three boxes, Floor 1, Floor 2, 
and Floor 3

Location Floor 2 One box, Floor 2
Location PP No data
Department Hosp A Four boxes, ER, Pediatrics, 

Maternity, and ICU
Unit Jobs under PP No data
Unit Hosp A Three boxes: Labor and 

Delivery, Neo-natal, and PP
Unit Floor 2 Three boxes: Labor and 

Delivery, Neo-natal, and PP
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 l The first column is the Location Type selected in Preferences.
 l The second column shows the location selected in the widget context.
 l The third column shows what you should expect to see. 

 o Time Span 
Select All Day to see all the shifts and zones for your locations. All Day runs from midnight to 
midnight. To be sure to see an entire zone or shift, select a time span.
Select Define time span to enter a specific start and end time to see information only within that 
period. After defining a time span, the start and end time is displayed at the bottom of the time span 
list.

Note: When the end time is set earlier than or equal to the start time, it represents a time on the 
next day. For example:

The manager sets the start time at 9:00 a.m. and the end time at 8:00 a.m. The defined time span is 
9:00 a.m. today to 8:00 a.m tomorrow.

 o Jobs
Select All Jobs to see all jobs in your locations.

 o Rename Employee Pool
In Widget Preferences, the user can change the Employee Pool Name of up to 21 characters. A 
name with reserved characters, such as an underscore or comma, is not supported.

 l Assign Required Breaks for the New Shift Length
Automatically places breaks based on:

 l The pay rule that is assigned to the employee
 l The location profile assigned to the location of the employee’s open shift

 o Procedure Set to Assign Shift 
Use Procedure Set to Assign Shift to select a Procedure Set to assign open shifts.
This feature can be accessed by either:

 l Selecting the Preferences in the Staff Management widget
 l Editing the Staff Management widget in the Widgets tab.

 a. Select a procedure set from Procedure Set to Assign Shift by clicking the drop-down arrow.
 b. If you select a procedure set, when you click Assign Shift for an open shift, the procedure set 
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filters a list of employees that you can select. 
 c. If you select None, Assign Open is not available from the Action menu.

 o Staffing Indicator Type Display
Enables you to see several visual indicators about employee-related status in the unit, if applicable.
The widget can show up to four visual indicators to the left of the employee name, if the indicator 
applies to the item and it has been set to visible in Preferences.

 o Display coverage values
Display all coverage values in the Staff Management widget.
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Using Rule Violations
Rules set to Warning in the employee or location schedule rule set can be configured to be displayed in the 
Staffing widget configuration and User Preferences. 
Within the Staffing widget the following new indicators are available:

 l Employee Rule Violation (Pool)
 l Employee Rule Violation (Unit)
 l Location Rule Violation
When these are selected, indicators appear to the left of the employee's name or in the unit header when a 
rule is violated. The indicator will be removed automatically as soon as the relevant rule violations have 
been resolved. 

Rule Violation Indicator Type
Rule Violation 
Indicator

More than the 
Maximum 
Indicator

Employee Rule Violation (Pool)

Employee Rule Violation (Unit)

Location Rule Violation

View employee rule violations
Employee Rule Violation indicators will only display if Employee Rule Violation (Pool) or Employee Rule 
Violation (Unit) have been configured to display in the widget configuration or user preferences. 

Rule violations indicators for pool employees
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If Show Employee Rule Violation (Pool) was selected in widget configuration or in user preferences, an 

indicator  will display when a rule is violated. Only rules set to Warning in the schedule rule setup 
will be shown in the staffing widget. 

If more than the Maximum number of Rule Violations per Employee have been exceeded an indicator  
is displayed. To display missing violations, resolve currently visible rule violations.

Rule violations indicators for unit employees

If Show Employee Rule Violation (Unit) has been selected in widget configuration or in user preferences, 

an indicator  will be displayed when a rule is violated. Only rules set to Warning in the schedule rule 
setup will be shown in the staffing widget. 

If more than the Maximum number of Rule Violations per Employee have been exceeded, an indicator  
is displayed. To display missing violations, resolve currently visible rule violations.

View employee rule violation details

Clicking the Rule Violation Indicator will display the following information on the Rule Violation:
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 l Employee
 l Date
 l Severity
 l Explanation
If there are multiple Rule Violations for the employee a scroll bar is displayed. 

View location rule violation
Location Rule Violation indicators will only display if Location Rule Violations have been configured to 
display in the widget configuration or user preferences. 

Rule violation indicators for locations

When a Location has a Warning Location Rule Violation and the Location Rule Violation has 
been selected in widget configuration or user preferences the indicator will display in the top right 
beside the location icon.
If more than the Maximum number of Rule Violations per Job have been exceeded an indicator is 
displayed. To display missing violations, resolve currently visible rule violations.

View location rule violation details

Clicking the Rule Violation Indicator will display the following information on the Rule Violation:

 l Location
 l Date
 l Severity
 l Explanation
If there are multiple Rule Violations for the location a scroll bar is displayed. 
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Applying Coverage Rules to Shift Display 
How Coverage is counted can be configured with the coverage counting rule applicable to selected 
locations. This rule allows the exclusion of shifts with certain work rules, shift segments with certain 
details, and certain pay codes. Coverage rules can also determine if a period of time at the beginning and 
end of a shift should be excluded from coverage counting. Zone set exceptions are also included when 
determining coverage.
The Filtering Coverage Rules Option allows users to filter the display of employee’s shifts in the Staffing 
Widget based on the coverage rules.
See the Widget User Guide for more detailed information on Coverage Rules, and how coverage rules are 
calculated.

When the shift filter is set to Coverage Setting
When the shift filter is set to Coverage Setting the Staffing widget will only display the employees that 
have a shift that counts towards coverage for the time span selected in the widget. 
Employees who have a shift that intersects the time span without contributing to coverage are displayed in 
the Employee Pool. 

When the shift filter is set to All Shifts
When the shift filter is set to All Shifts, all employees that have a shift that intersects the time span 
selected in the staffing widget will display.

For example

In this example Jane and John have overlapping shifts. The last half hour of Jane’s shift is an exception. 
This means that Jane’s last half hour does not count towards the Evening Zone Coverage.
When the manager views the Evening Zone:
If Coverage Setting is selected from the drop-down only John’s shift will display. 
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If All Shifts is selected from the drop-down both Jane and John’s shifts will display.
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How to use

 1. Navigate to the Staffing Widget.
 2. Select Coverage Setting from the drop-down.
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Shift, Pay Code and Unit Actions

Contextual menus were added to the Staffing widget to facilitate easy edits to Shifts and Pay codes. 

Hide single-edit actions
The display of Single Edit action options available in the contextual menu can be configured in the Staffing 
Widget Configuration and in the Preferences.

Hide Single-Edit 
Actions
in Menu Selected Unselected
Employee Shift Contextual 
Menu Options

259



Hide Single-Edit 
Actions
in Menu Selected Unselected
Open Shift Menu Contextual 
Menu Options

Selecting Hide Single-Edit Actions does not remove the actions completely. These actions can still be 
performed in the Edit Shift dialog box.
The Hide Single-Edit Actions in Menu option is unselected by default.
To Configure in Preferences:
 1. navigate to the Staffing Widget > Preferences.
 2. Select Hide Single-Edit Actions in Menu.
 3. Click Save.

How to use the shift editor
The display of contextual menu options for the Shift Editor is dependent on the FAP access to the Schedule 
View.
The Edit Shift dialog displays instead of the Job Transfer dialog when a shift or shift segments are dragged 
from one location to another, only if the current job exists more than once in the unit it is being transferred 
to or does not exist in the unit.

Add a shift

 1. Select the Unit and click action option.
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 2. Select Add Shift.

 3.  The Add Shift dialog displays the following information: 

 o Employee Name — Select an Employee from the Employee name drop-down, search for an 
employee. If Unassigned is selected an Open Shift will be created.
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Note: The available employee names are based on the selected location. 

 l If an employee is selected an Employee Photo displays.

Note: Employee Photos will only display if the feature is enabled in System Settings and in the 
Staffing widget.

 o Shift Details — the following fields are read only:

 l Shift Date (mm/dd/yyyy) — The Display Format is configured in Setup > Display Preferences 
> Display Profiles. 

 l Start Time
 l Duration (HH:mm or HH hh) — The Display Format is configured in Setup > Display 

Preferences > Display Profiles. 
 l Primary Job — if an employee is selected the Primary Job is automatically populated

 o Insert Template — Select to search for and insert a shift template. When a template has been 
selected the template will replace all current segment information and the shift label will change to 
the template label. 

 o Shift Label — add a Shift Label.

Note: If a template is added the text entered will be overwritten. If the shift template information 
has been modified, Kronos recommends the label should be modified to reflect these changes

 o Shift Segments
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 l Add a Shift Segment— Select Add a Shift Segment  to add a row. 

 l Delete a Shift Segment— Select Delete a Shift Segment  to delete a row. 
 l Start Date and End Date (mm/dd/yyyy) — The Display Format is configured in Setup > Display 

Preferences > Display Profiles.
 l Type — Select a segment type from the drop-down:RegularBreakTransfer
 l Start Time and End Time — If no Template was selected the Start and End Time must be 

entered.
 l Duration(HH:mm or HH hh) — displays the segment duration. This field is view only.
 l Skill & Certification Profile — One or more Skill & Certification Profiles can be selected. 
 l Transfer — The drop-down lists all jobs associated with the selected location. 

Note: 

The Job Transfer field is mandatory when creating an open shift.

Display of the Organizational Map is based on the Manager's Job Transfer Set defined in the 
People Editor. 

Select More
The Advanced Search dialog will open to select a Job Transfer. 

Click Save when finished.
 o Work Rule — Select a Work Rule from the drop-down list.
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 o Details — Select details from the drop-down list.
 o Comments — Add a Comment and Note. See Add and delete comments and notes on page 265.

 4. When finished, click OK.

Note: The Error column will display if there is an error with one or more shift segments after 
clicking OK. This column indicates the segment(s) that contains the error with an error icon. 
Hovering over the error icon will display the errors associated with the shift segment row.

Edit an existing shift

 1. Navigate to the Staffing Widget.
 2. To Edit an existing shift click the Contextual Menu arrow on the shift and select Edit Shift.
 3. In the Edit Shift dialog box the same information is displayed as in the Add Shift dialog box. See Step 3 

for information on the displayed options. 

Note: In the Edit Shift dialog Transfer drop-down, the five most recently used Organizational Map 
path and Job or Labor Account will display.

 4. Make the desired edits to the shift and click OK. 
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Add and delete comments and notes

Comments are displayed in the Add Shift and Edit Shift dialog boxes.

For a comment indicator  to display, the indicator must be selected in for Staffing Indicator Type 
Display in the widget configuration or in user preferences. 
If a note has been added to a shift and the indicator has been selected in the Widget configuration it will 
display to the left of the employee’s name. Clicking on the Comments Icon will display the comments and 
notes.
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To add a comment and note
 1. Navigate to the Shift Editor.

 2. Select a comment from the Select a comment drop-down list.

Note: The available Comments are defined in Setup > Comments > Shifts.

 3. (Optional) Add a note in the Type a Note field.
 4. Click Add.
 5. (Optional) Add additional comments and notes.
 6. Click OK.

To delete a comment and note
 1. Navigate to the Shift Editor.

 2. Click Delete Comment  to delete the comment and all attached notes or click Delete Note  to 
delete the note.
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 3. Click OK.

How to use Pay Code Edit

Note: The display of contextual menu options for the Pay Code Edits is dependent on the FAP access to 
the Schedule View.

Pay code editor
 1. Select the Pay Code in the Staffing Widget.
 2. Select Edit from the menu.
 3. In the Pay Code Editor: 

 a. Select the Pay Code from the drop-down list.

Note: The list is based on the user’s Pay Code Profile as defined in the People Editor for Pay 
Codes “Edit Profile and Pay Codes “View” Profile.

 b. Select the Amount from the drop-down list. 

Note: The display of the Duration is based on what is selected for the Display Format under 
Setup > Display Preferences > Display Preferences.

 c. Input a Start Time. 
 d. Select Advanced to display the Override Accrual Days option.

 4. Click OK when finished.

Change job

Note: FAP access is required to Add Job Transfers.
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 1. Select the Pay Code in the Staffing Widget and open the contextual menu. 
 2. Select Change Job.
 3. Select the desired options in the Add Transfer dialog box: 

 a. Select the Job from the drop-down.
 b. (Optional) Select Advanced to view or edit the Labor Level Transfer. 

 4. Click Add.

Change labor level

Note: FAP access is required to edit the Labor Level.
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 1. Select the Pay Code in the Staffing Widget and open the contextual menu. 
 2. Select Change Labor Level.
 3. Select the desired options in the Edit Labor Level dialog box: 

 a. View or edit Labor Level transfer as desired.
 b. (Optional) Select Advanced to view or edit a Job Transfer.

 4. Click Add.
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Comments

 1. Select the Pay Code in the Staffing Widget and open the contextual menu. 
 2. Select Comments.
 3. Select the desired comments from the list.
 4. Add or Delete Notes:

Click Add to add a note. Click on New Note Here and type the note.
Click Add again to add an additional note.

Click Delete to delete a note.

 5. Click OK.

How to use unit actions

Select multiple jobs for display

Select Multiple Jobs to view only those jobs in the Staffing widget. Employees with jobs that are not 
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selected in the Jobs drop-down will display in the pool if their primary job or their job transfer set has the 
job selected.
 1. Navigate to the Staffing Widget.
 2. Select the Jobs Drop-down. 
 3. Select one or more Jobs to be displayed. Select All Jobs to select or deselect all jobs.

Select multiple locations to the job level

The user can now select one or more org jobs without selecting their parent locations. The parent location 
displays in a separate Unit, showing only the selected jobs. 
 1. Navigate to the Staffing Widget.
 2. From the Locations drop-down select Select Location.
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 3. The Select Locations dialog will display. Select locations to the job level as desired.

 4. Select Select when done.

To view extra locations

 1. View sub-units below the location type as its own unit. The information on the sub-unit will no longer 
be rolled up to the select location type.

 2. Navigate to the Staffing Widget > Preferences or navigate to Manage Navigators > Widget and 
select the desired Staffing widget and select Edit.
In the List of Locations from Other Location Type enter the desired extra locations keyword or 
location path. 
For Example: *float*
For best results, use the asterisk (*) wild card.

 o To use multiple keywords, separate the keywords with semi-colons. 
Examples:

 l *float*;*Hosp A*
 l *float*;

*Hosp A*
 o Each location path must not have any illegal characters: 

 l Must have at least one alphanumeric character when “*” and 
“/” are entered. 
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 l Other characters that must have at least one alphanumeric in front or after are: 
? ( ) [ { + . \ ^ $ |

Notes:

 l Location path is case insensitive. The following two location paths are equivalent:
hosp/build
hOsp/BUILD

 l Location path heading and trailing spaces are omitted. 

The following are all the same The following are different
"*buildingA; ER”
" *buildingA; ER”
" *buildingA; ER ”
" *buildingA; ER ”
" *buildingA ; ER ” 

"*building A; ER”
"*building A; ER” 
"*buildingA; E R”
"*building A ; E R”
"* building A; ER”

 3. Click Save.

For Example: 

All Jobs and Coverage/Metrics are removed from the parent Unit panel and are displayed on the extra 
location unit panel.
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FAP access

 Shift edit FAP access

Advanced Search FAP access for Job Transfers

Perform job 
transfers

perform 
account 
transfers Actions in the Staffing Widget

Disallowed  The Job Transfer section of Advanced Search does not display.
 Disallowed The Labor Account section of Advanced Search does not display.
Allowed Allowed When the user select More... in the Transfer Job and Labor 

Account sections in Advanced Search display.
Disallowed Disallowed The Transfer Column does not display the Edit Shift and Add Shift 

dialog.
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Shift Edit FAP access for Comments

Schedule Shift 
Comments

Notes to Schedule 
Shift Comments Actions in the Staffing Widget

Allowed Disallowed The Comments section is displayed on the Edit Shift and 
Add Shift dialog.
The Note section is not displayed on the Edit Shift and 
Add Shift dialog.

Disallowed Allowed The Comments and Notes sections are not displayed in 
the Edit Shift and Add Shift dialog.

Disallowed Disallowed The Comments and Notes sections are not displayed on 
the Edit Shift and Add Shift dialog.

Allowed Allowed The Comments and Notes sections are both displayed on 
the Edit Shift and Add Shift dialog.

 Pay code edit FAP access

Scheduling/Schedule Access

Edit View Actions in the Staffing Widget
None Disallowed Staffing Widget is not loaded.

Error message displayed that you do not have permission 
None Allowed Staffing Widget is not loaded.

Error message displayed that you do not have permission 
All Disallowed Staffing Widget is loaded

Click on Contextual Menu arrow on a pay code and menu is displayed with 
Edit Option and the user can perform an Edit. 

All Allowed Staffing Widget is loaded
Click on Contextual Menu arrow on a pay code and menu is displayed with 
Edit Option and the user can perform an Edit.

All but 
Self

Allowed/Disallowed Staffing Widget is loaded
Click on Contextual Menu arrow on Manager's pay code and Edit Option is 
displayed and the Dialog is in view mode 
Click on Contextual Menu arrow on any Employee's pay code and Edit 
Option is displayed and the user can perform an Edit. 

Scheduling Pay Code Edits

 l Allowed — The Pay Code Edit option will display in the pay code contextual menu.
 l Disallowed — The Pay Code Edit option will not display in the pay code contextual menu.
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Perform job transfers

 l Allowed — The Change Job action will display in the pay code contextual menu.
 l Disallowed — The Change Job action will not be displayed in the pay code contextual menu.

Perform account transfers

 l Allowed — The Change Labor Level action will display in the pay code contextual menu.
 l Disallowed — The Change Labor Level action will not be displayed in the pay code contextual menu.
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Chapter 17  

Assign Open Shifts with the 
Call List Widget

When someone calls in sick, you need to fill that person’s shift quickly. Depending on how your navigator 
is set up, you can fill an open shift in either of two ways: 

 l If your navigator contains a Schedule alert linked to the Call List widget, click the Schedule alert icon 
to view the dates of open shifts. When you select an open shift from the list, the system guides you 
through the process of filling the shift. 

Note: The Schedule alert notifies you when there are open shifts. Depending on the configuration, the 
alert leads you to the Call List widget or the Call List widget of the Schedule widget.

 l If you prefer or if your navigator does not contain alerts, use the Call List widget directly. The widget 
displays details about the open shifts and lists the employees with the best qualifications.

Alternatives: The Call List is available from the Mobile Scheduler and as a tab in the Schedule 
Planner.

Use the Call List widget to find employees who are qualified and available to fill an open shift.
In the secondary view, the Call List widget displays the default locations and date as well as the number of 
open shifts.



Fill open shifts with the Call List widget
 1. Move the Call List widget to the primary position.
 2. (Optional) Select a location and date. The call list matches employees who have a Scheduler license 

and primary jobs at the selected locations. To include employees with valid transfer jobs, select the 
corresponding locations.

 3. From Shifts, select an open shift. The Call List lists employees who are qualified and eligible to fill the 
open shift. The people who best match the criteria have a star icon and are listed first. 

Tip: The system identifies qualified employees from procedure sets. To change the criteria, change 
your preferences.

 4. Select an employee to display their schedule. To view all columns, maximize the widget.
 5. Go through the list to find someone who is available for the selected shift. When you locate a person 

who is available, the open shift appears in the person’s schedule with an Assign button below it.
 6. Click Assign to assign the person to the shift. 
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Set Preferences — Call List widget

Depending on your access rights, you may or may not be able to set preferences for the widget.

 1. Click the gear icon in the upper right of a widget and then select Preferences. 

Tip: Additional options are available. You can click Close to move the widget to the Related Items 
pane. If you are working on a secondary widget, you can click Pop-out to move the widget to the 
primary position.

 2. Edit the following options. If an option has an asterisk next to its label, you must provide information; 
the option cannot be blank.

 o Column Set — Select the Schedule Planner column set to display. These selections are defined for 
your organization; you cannot change them here.

 o Allow Duplicate Employees — If you use two or more procedure sets, select this option to allow 
an employee to be included in each procedure set.

 o Offset From Today — Enter up to 28 days in advance to assign open shifts. Although you can 
modify the date in the widget, the date that displays in the call list by default is today’s date plus the 
number entered here. For example, if you enter 0, today’s date is displayed. If you enter 1, 
tomorrow’s date is displayed.

 o Procedure Sets — Select up to five procedure sets to identify employees who can fill an open shift. 
Each procedure set includes a specific set of criteria. For example, procedure set 1 may identify 
part-time employees, procedure set 2 may identify full-time employees, and procedure set 3 may 
identify employees who can incur overtime. The system uses each procedure set, in turn, to identify 
people to fill an open shift.

 3. Provide the following information for each group:

 o Group Label — Enter up to 50 characters to identify each procedure set defined for your 
organization.

 o Procedure Set — Select one of the procedure sets listed. The system can identify up to 300 
employees per procedure set.

 o Location — Select All Home Locations or Select location(s).
 o All Home Locations — The home location of the person using the widget will display in the 

navigator.
 o Select location(s) — Select a date and navigate to the appropriate location. When finished, click 

Select.
 4. Click Save and then click X to close the window.
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Chapter 18  

Manage Requests with the 
Request Manager Widget

Employees submit requests to change their schedules to their managers for approval. These requests can 
include requests to take time off, work overtime, swap shifts, or fill an open shift. 
Managers use the Request Manager to approve, reject, or submit these requests on behalf of the 
employees.

Ways to make requests

 l The Calendar widget
 l My Requests
 l Process Manager templates

Ways to manage requests

 l Request Manager widget — Use to manage requests that employees submit from the Calendar 
widget, My Requests, or Process Manager templates.

 l The Calendar – The Calendar widget displays scheduled and open shifts, pay codes, open-shift and 
time-off requests, availability and holidays. You can also create and modify requests.

 l Time-Off Request widget — Addresses only time-off requests that employees submit from My 
Requests

Important: The Time-Off Request widget and alert do not display global time-off requests or forms-
based requests. Instead, use the Request Manager widget and alert.



The Request Manager widget provides a summarized, sortable view of selected requests. You can enlarge 
the Request Manager grid using the sizing control in the upper right corner.
If configured, the Request Manager Alert icon at the top of your workspace shows the number of requests 
that need attention. When you click the icon, a Requests list appears. If you select a request type from the 
Requests list, requests are listed in the Request Manager grid.
The columns that appear in Request Manager depend on the request type. If configured, you might also 
have one or more panels at the bottom of the Request Manager grid. If there is more than one panel, click 
the tab to see the information you want. An indicator of multiple periods can be included on the Request 
Manager grid. Hover over the icon to show the request periods.
In addition, users can select multiple status types, such as Pending or Submitted. The screen changes to 
show “Multiple” as the column header. 

Note: The interface is highly customizable, and everyone’s product mix and access rights are different. 
Request Manager might not appear exactly as shown in this document. See your administrator for 
information about you configuration.
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Manage employee requests
 1. If Request Manager is not active, either:

 o Click and drag the Request Manager widget to the center.
 o Click the Request Manager Alert and select a request type to open the Request Manager widget. 

 a. The number on the alert indicates the number of requests that are pending.
 b. The Requests list shows the number of requests for each type of request. Use the up and down 

arrows to move through the list.
 c. Click a request type in the Requests list.

The columns and buttons vary by request type. If configured, add-on tabs such as the Detail 
Panel are below the list. 

 2. You can modify the requests in the grid. Above the columns:

 a. Select a time period.
 b. Select a location.
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 c. Select a request type.
 d. Select a status.

 3. Either:

Show details
To show detailed information – such as type of shift, hours, job, location, breaks, skill & certification 
profile – about a request, either:

 a. Double-click a request.
 b. Select a request.
 c. Either:

 o Click Details.
 o View the information in the Details tab. 

The Detail Panel displays request details as well as any other configured data, such as Genie 
columns. The Details button displays only request information.

 d. Hover the cursor over an item to open a tool tip.

Status indicators 

Icon Status
Draft
Only you can see your draft requests.
You can see only your own draft requests.
Submitted
You can submit your own new or draft requests, or new requests on behalf of your 
employees.
The request is ready for approval or rejection.
Retracted
You can retract your own submitted requests.

Pending
A submitted request has not been approved or rejected.
If multiple managers must approve the request, the status remains pending until all of 
the managers approve or a single manager rejects the request.
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Icon Status
Approved
All of the managers who must approve the request, approved it.

Rejected
At least one manager who must approve the request, rejected the request.

Show accruals

 a. Select a request.
 b. Select the Accruals tab to review the employee’s accruals.

Act on requests

 a. Select one request or multiple requests of the same type.
 b. Click the button for the action you want to take.

Note: When you complete an action, the request status updates, and the request may be 
removed. For example if the status is Submitted, and you Approve the request, the request is 
removed from the filtered view. However, the requests remain in the database for use in Genie 
or reports.

Tip: If you do not see the button for a request, select More to select the request.

Approve or reject requests
Approve or reject schedule requests from employees.

 a. Select Submitted or Pending requests of the same type.
 b. Optionally, select another Comment and enter a Note.
 c. Click either:

 o Approve
 o Refuse

If configured, the system notifies the employee.
 d. If you receive a message to adjust breaks:
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Only for requests to work partial shifts, if the schedule changes cause odd shifts and breaks, use 
the Schedule Planner widget, Schedule Planner, or Schedule widget to adjust the schedule.

 e. Time-off requests can be configured to require approval by multiple levels of management. If you 
approve the request, the system notifies the other approvers. If refused by any approver, the 
request is rejected.
Only for multiple requests to work partial shifts or shift segments:
When you approve a request for partial open shift or open shift segment, the entire open shift is 
removed from the request database. If a second partial or segment request exists for another part 
of the same shift, the second request is also removed from the database. This is true even if both 
requests are approved simultaneously. 
Example: Employee_A requests the morning segment of an open shift, and Employee_B requests 
the afternoon segment of the same open shift. If you select and approve both requests, only 
Employee_A's request is recorded as approved. Employee_B's request is deleted by the system. 
Best practice is to approve one request, and then ask the other requester to re-submit.

 f. Only for time-off requests, a single request can include non-consecutive days or date ranges, or 
multiple pay codes. If the request configuration allows changes at approval, you can edit and 
approve parts of the request.

 a. Edit the options as needed:

 o Start Date
 o End Date
 o Pay Code
 o Duration
 o Full Day
 o Half Day – Half the total time of shifts that day. The time off starts when the first shift of 

the day starts. For other half-day amounts, select 1st or 2nd Half Day or Hours.
 o 1st Half Day – Total time of the first half of shifts that day
 o 2nd Half Day – Total time of the last half of shifts that day
 o Hours – Only for Hours, edit Start Time or Length. Note: The values in Start Time and 

Length reset if you select Full or Half Day. If you later select Hours, you must enter the 
values again.
Managers can edit only the same durations that the employee who submitted the request 
could edit.

 b. To add another date range, click Add another time-off period. Enter the options.
 c. To remove a date range, click the X.
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 d. Optionally, select another Comment and enter a Note.
 e. Click Approve. If configured, the system notifies the employee.

Change the status to pending
You can delay approval or rejection by changing the status of requests to Pending.

 a. Select Submitted requests of the same type.
 b. Click More. Select Pending.
 c. Optionally, select another Comment and enter a Note.
 d. Click Pending. If configured, the system notifies the employee.

Reassign a request
You can move a request to another person.

 a. Select a Submitted request of the same type.
 b. Click Reassign.
 c. Complete the options.
 d. Select one manager from the available list or search for a manager name. 
 e. Enter a comment or instructions for the assignee.
 f. Click OK.bu

Edit requests

 a. Select requests of the same type.
 b. Click Edit.
 c. Edit the options according to the request type and status.
 d. Optionally, select another Comment and enter a Note.

 o Only for requests to cover, if a manager enters a Comment, the employees can see it. If the 
manager enters a Note, the employees cannot see it.

 o Only for time-off requests, managers can add or edit multiple comments or notes. Request 
details display all comments and notes whether entered by the employee or manager. 
Employees can enter notes only for their default comment.

 e. Click Edit. If configured, the system notifies the employee.
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Withdraw requests

Submitted status: Retract requests

You can retract your own submitted requests or your employees’ submitted, pending (including partially 
approved), refused, or approved requests.
A record of the request remains in the database.

 a. Select requests of the same type.
 b. Click More > Retract. The dialog displays details.
 c. Optionally, select another Comment and enter a Note.
 d. Click Retract.

 o If configured, the system notifies the employee.

 o Important: If you retract a request, you must manually remove any pay code edit that 
resulted from the request.

 o Important: A time off request changes an assigned shift into an open shift. If a time off 
request is retracted, the open shift is not reassigned back to the employee. If the shift is still 
available, manually reassign the shift. Alternatively, the employee can request the open shift.

Draft status: Delete requests

You can delete only your own requests and only if the status is Draft.

 a. Select draft requests of the same type.
 b. Click Delete.
 c. Click Delete. If configured, the system notifies the employee.

Approved status: Cancel employee requests

You can cancel approved requests from employees only for time-off requests, and only if the request is 
configured to allow cancellation.

 a. Select approved, time-off requests.
 b. Click Cancel.
 c. Optionally, select another Comment and enter a Note.
 d. Click Cancel. If configured, the system notifies the employee.
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When cancellation does not remove pay code edits

The pay code edit from the original request is removed automatically – but only if the pay code 
edit was not changed. If the pay code edit was changed, cancellation does not remove it.
To restore the schedule completely, manually remove the pay code edit and create a new shift to 
assign to the employee.
Example:
The symbolic source of the pay code edit is Contract or Pattern:

 o The request was approved when the pattern or contract was not defined, and the length of the 
resulting pay code edit is 0. When the pattern or contract is defined, the pay code edit changes 
to the defined length.

 o If the pattern or contract is changed, the pay code edit also changes.
 o Later, if the employee cancels the request, the system does not remove the pay code edit 

because it cannot find the exact pay code edit from the approval of the request.
 o Time-off planning occurs in January, so the time off period goes from February through January 

of the next year. Employees may not have accrued the fully scheduled vacation time that is 
planned for the year. So, the organization uses a Pending Vacation pay code as a placeholder 
for the planned time-off of the employee. Later, this pay code edit is replaced by the real pay 
code. Then, if the employee cancels the request, the system does not remove the pay code edit.

 Submit Requests on Behalf of Employees
Managers can submit requests on behalf of employees.
Example: The employees may not have access to the Calendar widget.

Submit requests to work open shifts

Employees can select whole Open Shifts to create their own work schedule. For employees to display 
and request open shifts, define the open shifts visibility period.
Managers can submit requests to work open shifts on behalf of their employees.

Note: To allow an employee to request open shifts from posted and unposted schedules, set their 
function access profile to access unposted schedules.

 a. Click Request Open Shift. If you do not see the button, select More to select the request.
 b. Edit the options. Depending on the status of the request, some options are not available and cannot 

be edited.
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 a. Employee – Select an employee.
 b. Status – Select the status of the request. Select Approved to assign the open shift to the 

employee.
 c. Date – If the status is Draft, and the request is not saved, you can select the date of the open 

shift. Otherwise, not editable.
 d. Open Shifts – Select an open shift from the table. Not editable.

 c. Optionally, select another Comment and enter a Note.
 d. Click either:

 o Draft – Save a draft to submit later.
 o Submit – Submit the request to the manager for approval or rejection.
 o Cancel – Do not save or submit this request.

Submit requests to work open shifts or segments

Employees can select whole open shifts, or predefined segments of an open shift, or part of an open 
shift to create their own work schedule. 
Managers can request an open shift or a shift segment on behalf of an employee. Shift segments may 
be predefined or created from an existing open shift.

 o Multiple nonconsecutive segments can be requested; however segments cannot be redefined. 
 o To request part of an open shift, use the Partial Shift option.
 o Notifications can go to managers when employees submit or retract a request.
 o Notifications can go to employees when the status of the request changes.
 o If a break is between the segments in the original whole shift, and both segments are requested, the 

break is not assigned to the employee.
 o Configuration can exclude overlapping shifts or can evaluate minimum and maximum shift lengths.
 o After approval, a manager may need to manually adjust the shift to add breaks and remove gaps in 

the schedule.

 a. Click Request Shift. If you do not see the button, select More to select the request.
 b. Select the Employee who wants the shift.
 c. Select the request Type from the list of configured options.
 d. Under Available Shifts select the date when the open shift starts.
 e. Select the open shift.
 f. Select either:

290



 o Whole Shift – to schedule the whole shift.
 o Predefined Segments – to see a list of segments for the shift you selected. Select the segments 

you want to add to your schedule.
 o Partial Shift – to adjust the start time or end time of the selected open shift. Select Start time 

and enter the adjusted time or select End time and enter the adjusted time. Do not change both 
the Start and End time. The minimum duration allowed for a partial shift is indicated next to the 
Partial Shift selection as minimum hrs. The time must be during the time span of the selected 
shift.

 g. (Optional) Select a predefined Comment.
 h. (Optional) Add or edit a Note.
 i. Click either:

 o Draft – Save a draft to submit later.
 o Submit – Submit the request to the manager for approval or rejection.
 o Cancel – Do not save or submit this request.

Submit an availability change

A manager can request a temporary Availability change on behalf of an employee.

 a. Select Change Availability Request. If you do not see the button, select More to select the 
request.

 b. Select Request Change Availability.
 c. Select the Employee.
 d. Select the Request Period and Type.
 e. Select the dates to change.
 f. Select Available, Preferred, Preferred Time Off, Unavailable, or Unknown.

 g. Color codes for availability 

 Available — light green 

 Preferred — green 

 Preferred Time Off — pink 
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 Unavailable — purple 

 Unknown — white 
 h. Click either:

 o Draft – Save a draft to submit later.
 o Submit – Submit the request to the manager for approval or rejection.

The display of availability changes backdates to the start of the schedule week. Example: If you 
change availability for a Friday, the Calendar widget displays the icon on the first day of the 
schedule period. However, the Details show that the change was made on the Friday.

 o Cancel – Do not save or submit this request.

 i. Approve an availability change request
When an employee makes a change to the availability that appears on their schedule, you may 
have to approve it.

 a. Select Change Availability Request.
 b. Highlight the request you want to approve.
 c. Select Approve.

Submit requests to swap shifts

Employees can exchange their scheduled shift with another qualified employee.
If the following conditions are met, employees can swap shifts with other employees:

 o The submission period is open.
 o Both employees are qualified to work the other shift.
 o The swap does not violate schedule rules as configured for your organization.
 o Neither shift is locked.
 o Neither shift was deleted.
 o Neither shift overlaps another assigned shift in either employee’s schedule.
 o The other employee agrees to swap the shifts.
 o The manager approves the swap.
 o Either the shift must be posted, or the Request type must be configured to allow shift swap with 

unposted shifts.
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Note: A shift swap does not affect the visibility of an unposted shift. Example: An employee with 
permission to view and access a certain shift on an unposted schedule wants to swap that shift 
with another employee who does not have permission to see that shift because it is unposted. The 
other employee can see the offered shift swap and accept or reject it. However, if the shift is 
accepted, it does not appear on the other employee’s calendar until the schedule is posted.

Swapping shifts is a multiple-step process:

 a. The employee or the employee’s manager submits a request to swap the shift with the other 
employee.

 b. The other employee accepts or refuses the request.
 c. The manager approves the request. 

To submit a shift swap request on behalf of an employee:

 a. Click Request Shift Swap. If you do not see the button, select More to select the request. 
 b. Select the employee with the shift to swap. 
 c. Select the Date, Time and Type of the shift to offer to another employee. 
 d. In the Swap with section, select the date, location or the job to work.
 e. Select the shift to work.
 f. Optionally, select a Comment and enter a Note.
 g. Click either:

 o Draft – Save a draft to submit later.
 o Submit – Submit the request to the manager for approval or rejection.

The shift is not swapped until another employee accepts the offer. Only then does the shift 
move from the first employee’s schedule to the other employee’s schedule.

 o Cancel – Do not save or submit this request.

Submit a request to cover

If employees cannot work a shift, they can use the Calendar widget to search for eligible employees 
whom they can request to cover that shift. The receiving employees use the Calendar widget to accept 
or reject the request, and the manager uses the Request Manager to approve or reject the request. 
A manager can submit a on behalf of an employee.

 a. Click Request Shift to Cover. If you do not see the button, select More to select the request.
 b. Select the Employee for whom you are submitting the request to cover.
 c. Select the Date, Type and Time of the shift. Shift to cover by displays a list of employees who 

293



are eligible to cover the shift.
 d. Check the employees to whom to offer the shift.
 e. (Optional) Enter a Note for the request. The employees cannot see the Note.
 f. Click either:

 o Draft – Save a draft to submit later.
 o Submit – Submit the request to the manager for approval or rejection.

The shift is not covered until another employee accepts the offer. Only then does the shift move 
from the first employee’s schedule to the other employee’s schedule.

 o Cancel – Do not save or submit this request.

Status indicators – request to cover 

Status Description

Employee 
needing 
coverage

Employee 
asked to 
cover Manager

Draft A request to cover that is visible only 
to the person who created it. 
Drafts can be created by the 
employee or the manager.

Can 
Submit or 
Delete 
Drafts 
they 
created

Cannot see 
the request 
until it is 
submitted

Can Submit 
or Delete 
Drafts they 
created

Offered A request has been submitted, but it 
has not been reviewed by the 
employee asked to cover. 

Can 
Retract

Can Accept 
or 
Refuse/Declin 

Can view 
Details, 
Edit, 
Accept, 
Refuse, or 
Retract

Submitted The request has been accepted by an 
employee. If more than one employee 
was offered the shift, it disappears 
from their calendars.

Can 
Retract

Can view 
Details

Can view 
Details, 
Edit, 
Approve, 
Refuse, 
mark as 
Pending or 
Retract

Offer 
Refused 

The employees who were asked to 
cover declined the offer. 

Request is 
visible on 
calendar. 

No longer 
sees the offer 
on their 

Can view 
Details, or 
Edit
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Status Description

Employee 
needing 
coverage

Employee 
asked to 
cover Manager
calendar

Refused The offer was refused by the manager 
when it was in the submitted state. 

Can view 
details

— Can Edit

Retracted The employee needing coverage or 
the manager retracted the offer. You 
cannot reopen a retracted shift. You 
need to create the request from the 
start to offer again the request to 
cover. 

Can view 
Details 

— Can view 
Details or 
Edit

Pending The manager has reviewed the 
request, but has not approved or 
declined it. The shift is still assigned 
to the employee needing coverage. 

Can view 
Details 

Can view 
Details 

Can view 
Details, 
Edit, 
Approve, 
Refuse or 
Retract

Approved The shift is assigned to the employee 
asked to cover.
The shift disappears from schedule of 
the employee needing coverage. 

Can view 
Details

Can view 
Details 

Can View 
Details, Edit 
or Retract

Submit requests for time off

Employees can request whole days, half days, or hours off.
Managers can request Time Off on behalf of their employees.

 a. Select Draft requests of the same type. Click Request Time Off.
 b. Select the request options:

 o Employee – Select an employee.
 o Type – Select the type of time-off request.

 c. Check the accrual balances on the default or another date.
 d. Edit the options of the time period:

Important: Not all of these options are available; they differ according to the configuration of 
the time-off request.
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 o Start Date
 o End Date
 o Start Time – Only for simplified, hours-off requests
 o Pay Code – Only time-based pay codes are available. If configured, you can select another pay 

code.
 o Duration – Select:
 o Full Day – Entire shift that day
 o Half Day – Half the total time of shifts that day. The time off starts when the first shift of the 

day starts. For other half-day amounts, select 1st or 2nd Half Day or Hours.
 o 1st Half Day – Total time of the first half of shifts that day
 o 2nd Half Day – Total time of the last half of shifts that day
 o Hours – Only for Hours, edit:

 l Start Time
 l Length – Enter a number of hours; less than or equal to 24 hours (1 day).

The values in Start Time and Length reset if you select Full or Half Day. If you later select 
Hours, you must enter the values again.

 o Duration – Only for simplified, hours-off requests. Enter a number of hours; less than or equal 
to 24 hours. The duration must not be longer than the selected time period.

 e. If configured, a single request can include non-consecutive days or date ranges, or multiple pay 
codes:

 a. Click Add another time-off period.
 b. Repeat the options.
 c. Optionally, to remove a date range, click the X.

 f. Optionally, managers can add or edit multiple comments or notes. Request details and history 
group all notes for the same comment together.

 a. Select a Comment and enter a Note.
 b. Click Add. The current comment and note are saved.
 c. Select the same or another comment.
 d. Enter a new Note.
 e. To add more comments or notes, repeat.

 g. Click either:
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 o Draft – Save a draft to submit later.
 o Submit – Submit the request to the manager for approval or rejection.
 o Cancel – Do not save or submit this request.
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Set Preferences — Request Manager widget 

Your access rights determine whether you can set preferences for the widget. Example: You may be 
able to filter the types of requests that appear. 

The selections that you make in Preferences are the defaults that display each time you open Request 
Manager. If you select other options while you are working with requests, those selections remain active 
until you sign out of the session. 
 1. In the Request Manager widget, click the gear icon, then select Preferences.
 2. Change filters:

 o Request type — A list of request types from Process Manager and the Scheduler
 o Request status — The available status options depend on the request type.
 o Time period — The time period for which you want to see requests
 o HyperFind — Controls the employees that are included in the search for requests

 3. Change the Request Types — Request Manager widget parts control the data that appears in the grid 
for a particular type of request. Depending on your configuration, you can select request types other 
than the defaults in your Request Manager preferences. 

 4. Change the Add-ons — Depending on your configuration, you can select add-on widget parts, such as 
the Accruals Panel or the Detail Panel, to the Request Manager widget.

 5. Check Suppress accrual warnings if you want to suppress the warning a manager receives when 
approving an employee request that will result in a negative accrual balance. 

 6. Check Goto Control (Navigator) if you want to include this widget in the Goto control.
 7. Either:

 o Click Save, then click x to close Preferences. The selected preference settings will be in effect the 
next time you log on.

 o To close Preferences without making changes, click Cancel.
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Chapter 19  

Manage the Time-Off 
Request Widget

Important: The Time-Off Request widget and alert do not display global time-off requests or forms-
based requests. Instead, use the Request Manager widget and alert.

When someone requests time off, you need to respond quickly so both you and your employee can plan 
your time accordingly. Depending on how your navigator is set up, you can address time-off requests in 
either of two ways: 



Respond to time-off requests from an alert
When you log on to your navigator, if pending time-off requests are waiting for your attention, the Time-
Off alert icon displays the number of weeks during which employees have requested time off. Hover your 
mouse over the icon, and scan the drop-down list that shows the weeks and the number of requests for each 
week. When you select a week, the Time-Off Request widget becomes the primary widget. 
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Manage time-off requests with the Time-Off Request 
widget

Secondary view
When the Time-off Request widget is in the secondary view, the number of actionable, approved, and 
rejected requests are listed. You must move the widget to the primary location to act on these requests. 

Primary view
If the Time-Off Request widget is in the secondary position or in the Related Links pane, drag it to the 
primary position. If you are accessing the widget from the Time-Off Request alert, the widget opens in the 
primary position automatically.
 1. If necessary, select the date and location from the top of the widget. A list of requests appears. Icons 

identify the status of each request. Hover your mouse pointer over an icon for more information: 

Submitted 
Draft 
Approved 
Rejected 

 2. Select one of the requests. A table opens at the bottom of the widget with two tabs: Details and 
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Balance.
 3. Click the Details tab, and review the information submitted by your employee: Date/Time, Status, and 

Changed By.
 4. Click the Balance tab, and make sure that the employee has adequate accrued time for the request.

 5. Now you can reply to the request: Click Approve or Reject and add a comment if necessary.
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Set Preferences — Time-Off Request widget 

Depending on your access rights, you may or may not be able to set preferences for your widget.

Tip: Additional options are available. You can click Close to move the widget to the Related Items 
pane. If you are working on a secondary widget, you can click Pop-out to move the widget to the 
primary position.

 1. Click the gear icon in the upper right of a widget and then select Preferences.
 2. Edit the following options. If an option has an asterisk next to its label, you must provide information; 

the option cannot be blank.

 o Display Actionable Requests Only — If you select this check box, only Pending requests are 
displayed. If you do not select this check box, Pending, Draft, and Submitted requests are displayed.

 o Ignore accrual warnings for the approval — If you select this check box, the system does not 
warn you about accrual issues when you approve a request.

 o Time Period — Select one of the time periods listed. These time periods were defined for your 
organization; you cannot change them here.

 o Location — Select a location from the drop-down list. These selections are defined for your 
organization; you cannot change them here.

 3. Click Save and then click X to close the window.
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Chapter 20  

Request Schedule Changes 
with the Calendar Widget

The Calendar Widget allows you to view scheduled shifts, open shifts (only with the Scheduler license), 
pay codes, requests for changes, availability (only with the Scheduler license), and holidays. You can also 
create and modify requests.
 1. Select the Calendar widget.
 2. (Optional) You can load another time period. Either:

 o Select an option from the time period menu.

 o Click Select Dates .
 3. Select the view

 – By Day

 – By Week

 – By Month

Note: The By Month view does not show employee availability.

 4. If the loaded time period is longer than the view displayed, click the arrows to select another part of the 
time period that is loaded. 

 5. Either:



 o Show shifts, pay codes, requests, holidays on page 307
 o Show accruals, location schedules, coverage on page 313
 o Request Schedule Changes with the Calendar Widget on page 305
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Show shifts, pay codes, requests, holidays
Shifts, pay codes, and requests

 o To see detailed information – for example, type of shift, hours, job, location, breaks, skill & 
certification profile – in a tool tip, hover the cursor over an item.

 o To filter the items to display in the Calendar:

 a. Click Filter .
 b. Clear the items that you do not want to see.
 c. Select the items that you want to see.
 d. Click in the Calendar.

Important: Your filter settings are not saved when you log out.

Color codes

 o Scheduled shifts – blue
 o Open shifts – red
 o Pay codes – green
 o Requests – gray
 o Shift swap requests – gray
In the By Day or Week views:

 o Items that are 24 hours or longer are in the date headers. 

 o Items that are shorter than 24 hours, are at the relevant times. 
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 o In the By Month view, items are on the relevant days. 

 o If an open shift has a read-only icon , you cannot request to work the shift. 
 o Depending on how your system is configured, shifts may display only their label, or a additional 

information as well:
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 l The start and end time of a shift 
 l The location and name of the job

 l For a simple transfer out, an arrow points to the right 

 l For any other kind of transfer, a double arrow 
 o For additional information, position the cursor over the item; a tool tip appears with full information 

on the item.

Requests
Requests can be to:

 o Take time off 
 o Self-schedule

 l Work open shifts
 l Change availability
 l Swap shifts
 l Request someone to cover a shift

The label displays the pay code, the number of requests, and the number of days or hours for the 
request.
Requests for less than one day are displayed at the relevant times in the Calendar.

Status indicators 

Icon Status
Draft
The Calendar displays only draft requests that you create, and not draft 
requests that your manager creates on your behalf.
Your manager cannot see your draft requests.
Submitted
You can submit only your own, new or draft requests.
The request went to your managers for approval or rejection.
Retracted
You can retract only your own, submitted requests, or your own offered 
shift swap requests.
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Icon Status
Pending
Your managers have not yet approved or rejected your submitted request.
If multiple managers must approve your request, the status remains 
pending until all of the managers approve the request (partially 
approved).
Approved
Your manager or all of the managers who must approve your request 
approved it.

Note: If configured, requests can be automatically approved.

Rejected
At least one manager who must approve your request rejected your 
request.
Offered
For shift swap or requests to cover
Offer Refused
For shift swap or requests to cover

Details – To see detailed information in a tool tip, hover the cursor over the status icon.

 Holidays 

 o In the By Day or Week views, the holiday icon indicates holidays in the date headers. The 
corresponding pay code covers the day. 
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 o In the By Month view, the holiday icon indicates holidays on the relevant days. 

If a holiday crosses the day divide (crosses midnight), and the holiday is:

311



 o A day or longer (24 hours or longer) – The holiday icon is displayed only on the start day.
 o Shorter than a day (less than 24 hours) – The holiday icon is displayed on all days of the holiday.
 o If more than one holiday occurs on a day, the day shows only one holiday icon. Hover the cursor 

over the holiday to see the details in a tool tip of all of the holidays on that day.
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Show accruals, location schedules, coverage
Depending on how your system is configured, your calendar may include one or more Calendar widget 
parts.

Show a widget part

 a. Click the tab at the bottom of the Calendar widget.

 b. To hide the widget parts and maximize the space for the Calendar, click the small icon  at 
the center of the top edge of the Calendar widget parts.

 c. To make the widget parts visible, click the same icon again.
 d. If some columns or rows of the widget part are hidden, you can scroll vertically or horizontally to 

view them all. 
 e. If you need more or less vertical space to view the widget part:

 a. Place the cursor between the Calendar and the widget part. The cursor changes to a double-
headed arrow.

 b. Hold the left mouse button down, drag the border up or down, then release the mouse button.

 The widget parts

Display accruals

Use the Accruals widget part to view detailed information about your accruals.
Example: Display this widget part when you submit requests to match your time-off requests to your 
accruals.
Select the Accruals tab.

Display a schedule for all employees at a location

Use the Location Schedule widget part to view schedule information for the other employees at your 
location. The location schedule shows employees regardless of whether they have a shift scheduled or 
not.
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Example: Use this widget part to see which shifts other employees are working while simultaneously 
using the Calendar and Request Self Schedule to build your own schedule.

Tip: You can also see shift or pay code details by placing the cursor over a cell in the schedule. 
Employees who are transferred from another job and location have an asterisk (*) next to their job.

 a. On the Calendar widget, load the time period of interest and adjust the display to show the week 
view or the day view. The location schedule widget part displays the same time period as the 
Calendar widget.

Note: The location schedule is not available in the By Month view.

 b. Select the Location Schedule tab. 
 c. (Optional) Select the Location.

The Location menu shows the schedule for your primary job location. Depending on how your 
system is configured, you may be able to select one or more alternate locations on the menu, 
corresponding to other locations where you may be assigned to work.

 d. Use the date control at the top of the Calendar widget to view earlier or later time periods within 
the loaded time period.The location schedule automatically adjusts to display the same time period 
as the Calendar widget.

 e. Click the Employee header or the Job header to sort the list by that column.
 f. Scroll down the location schedule to see all the employees at the default or selected location.
 g. A row of buttons to the right of the Location menu control display options for the location 

schedule widget part.

Tip: Position your cursor over the shift or pay code and leave it motionless for a second. A 
tool tip shows additional detailed information. If the tool tip disappears, move the cursor 
slightly away from the shift or pay code, then move it back again.

 o The Job menu contains a list of the jobs associated with the employees at the current location 
or transferred in to the current location that are possible to display with the current location 
schedule settings.

 l Select the check box next to any job to include those shifts in the display.
 l Clear the check box next to any job to remove those shifts from the display.

 o The Time and Label toggle button controls how shifts and pay codes are displayed in the 
location schedule:
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 l Select Time to show the start and end time of each shift or shift segment.
 l Select Label to show only the label of each shift.

 o The Whole Shift and Segmented Shift toggle button controls whether shift segments are visible 
or not:

 l Select Whole Shift to show each shift in a separate row. In this view, the Job column shows 
the primary job for each employee. 

 l Select Segmented Shift to show each shift segment in a separate row. In this view, the Job 
column shows the actual job scheduled for each shift segment for each employee. If the job 
name has an asterisk (*), it means that the shift is not at the selected location. The 
Segmented Shift view always displays the start and end times of the segment, since the 
segments have no labels.

 o Select Hide unscheduled employees to remove employees who have no shift or pay code 
scheduled for the period from the location schedule display. To show all employees at the 
location, clear the check box.

 h. Click Refresh icon to reload the location schedule from the database.

Shift transfers

 o For quick reference, icons indicate job transfers on the Location Schedule. The icons have slightly 
different meanings depending on whether you are using the Whole Shift view or the Segmented Shift 
view.

 o For full details about the transfer, position your cursor over the shift or segment to display a tool tip.

Icon Term Whole Shift view Segmented Shift view
Transfer 
In

The employee's primary job is at 
another location, but is working at 
the selected location for that shift.

The employee's primary job is at 
another location, but is working at the 
selected location for that part of the 
shift.
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Icon Term Whole Shift view Segmented Shift view
Transfer 
Out

The employee's primary job is at the 
selected location, but the employee 
is working at another location for 
that shift.

The employee’s primary job is at the 
selected location, but the employee is 
working that part of the shift in 
another location.

Other 
Transfer 
Types

Most other possible transfer cases 
show a double arrow, including:
One part of the shift is a transfer in; 
another part of the shift is a transfer 
out.
The shift (or part of the shift) 
includes a work rule transfer or a 
labor account transfer.
The employee’s primary job is at the 
selected location, but the employee 
is working at a different job at the 
same location

Most other possible transfer cases 
show a double arrow, including:
The employee's primary job is at the 
selected location but that segment is 
another job at the selected location.
The segment includes a work rule 
transfer or a labor account transfer.

Display coverage for a job

The Coverage widget part allows you to easily find shifts that have overcoverage or undercoverage for 
any job at the locations configured for your system.

 a. On the Calendar widget, load the time period of interest and adjust the display to show the week 
view or the day view. The Coverage widget part displays the same time period as the Calendar 
widget.
The coverage widget part is not available in the By Month view.

 b. Select the Coverage tab.
 c. Select the location and Job. The Job menu shows the employee’s primary job by default, and also 

includes all jobs at the employee’s primary and transfer list locations.
 d. Depending on how workload is configured for your system, you may see a Span or a Zone menu. 

Use the Span menu or the Zone menu to control the display of coverage data for the different 
spans or zones. 

 o Select a checkbox to display coverage data.
 o Clear a checkbox to hide coverage data.

 e. Each cell under a date shows the scheduled number of employees followed by the required number 
of employees for each span or zone on that date.
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 o  = The schedule has undercoverage. If you are requesting to work shifts, these times are the 
best to select.

 o  = The schedule has overcoverage. If you are considering a time off request, these times are 
the best to request.

 o [No arrow] = The schedule meets the coverage requirement.
 f. Use the date control at the top of the Calendar widget to view earlier or later time periods within 

the period that you selected. The Coverage widget part automatically adjusts to display the same 
time period as the Calendar widget.

 g. Hover the cursor over the Job menu to see the full path of the job. 
 h. To show more rows of coverage values, click and drag the border between the Calendar and the 

widget part.
 i. Click Refresh.

Submit requests

Check submission periods with Request alerts
The Alerts widget at the top of the navigator displays alerts that notify whether submission periods are 
open for the following requests:

 o Time-Off Request
 o Open Shift
The alert displays the number of submission periods that are open.

 o Submission period – The time you can submit requests
 o Request period – The time of the requested open shift or time off 

 l The submission and request periods can be at different times. Example: A submission period from 
November 1 to 30 is for the Vacation request period from January 1 to December 31 of the 
following year.

 l Multiple submission periods can be open at the same time. Example: 11 submission periods can 
be open for different request periods or types of time off.

 l If the alert displays no number, no submission period is open.
To see a list of active or available requests:
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 a. Click the alert if it displays a number. 

 b. To scroll, click the arrow buttons or press the arrow keys.
 c. Note the severity of each alert:

 o Low —  Blue “balloon” icon 
The request is a little after the start of the submission period.

 o Medium —  Orange triangle with an exclamation point 
The request is in the middle of the submission period.

 o High —  Red octagon with an exclamation point 
The request is coming to the end of the submission period.

 o The label displays the type of request and the request and submission periods:
<RequestName> (<RequestPeriod_StartDate – EndDate>) is available until 
<SubmissionPeriod_EndDate EndTime>
Example:
Personal Day (01/03/2012 – 31/03/2012) is available until 23/02/2012 
5:00PM

 o If the request or submission periods are defined as Any Day or Time, these periods are not in 
the label.
Example:
Personal Day (01/03/2012 – 31/03/2012) is available
Personal Day is available until 23/02/2012 5:00PM
Personal Day is available

 d. To act on requests, select from the list. The Calendar widget opens to the defined request period.
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Request to work an open shift
The label of Open Shifts displays the number of available open shifts.

 o If the open shift has a read-only icon , you cannot request to work that shift.
 o You can request to work only one shift each day in each request. To schedule more than one shift in 

a day, you must submit more than one request. 
 o For a tool tip of information about a shift, hover the cursor over the open shift.

 a. In the Calendar, either:

 o Click Request Open Shift. Select the Date and Type for the shift you want to work.
 o Click the open shift (pink) that you want to work. Select Request Open Shift from the pop-up 

menu.
 o Select the day. Click Request Open Shift. Select the open shift.

 b. (Optional) In the Request dialog box, you can select another date to look for other open shifts.
 c. (Optional) Add or edit a Comment or a Note.
 d. Click either:

 o Draft – Save a draft to submit later.
 o Submit – Submit the request to your manager for approval or rejection.
 o Cancel – Do not save or submit this request.

Request to work an open shift or segment
You can request to work an open shift or a predefined segment of an open shift.
For a tool tip of information about a shift, hover the cursor over the open shift.

 a. In the Calendar, click Request Shift.

Tip: If you do not see the Request Shift button, select More. 

 b. Under Available Shifts select the date you want to schedule a shift. 
 c. Select the Type.
 d. Select the shift you want to work. 
 e. Select either: 

 o Whole Shift – to schedule the whole shift. 
 o Predefined Segments – to see a list of segments for the shift you selected. Select the segments 
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you want to add to your schedule. 
 o Partial Shift – to adjust the start time or end time of the selected open shift. Select Start time 

and enter the adjusted time or select End time and enter the adjusted time. The minimum 
duration allowed for a partial shift is indicated next to the Partial Shift selection as minimum 
[value] hrs.

Important: The following limitations apply to Partial Shift requests:
– Either the Start or End time must not change.
– The times must be within the time span of the selected shift

 f. (Optional) Add or edit a Comment or a Note.
 g. Click either:

 o Draft – Save a draft to submit later.
 o Submit – Submit the request to your manager for approval or rejection.
 o Cancel – Do not save or submit this request.

Change your availability
If you cannot work during a time you are normally available to work, you can block your calendar so 
that you are not scheduled to work during that time. You can override the Calendar and temporarily 
change your Availability.

Note: For long-term changes to your availability pattern, contact your manager.

 a. In the Calendar, select Request Availability. 
If you do not see the Request Shift to Cover button, select More. 

 b. Find the day or block of time you would like to change.
 c. Select Available, Preferred, Preferred Time Off, Unavailable, or Unknown.

Color codes for availability 

 Available — light green 

 Preferred — green 
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 Preferred Time Off — pink 

 Unavailable — purple 

 Unknown — white 
 d. Click either:

 o Draft – Save a draft to submit later.
 o Submit – Submit the request to your manager for approval or rejection. The calendar changes 

colors to reflect the new availability you chose.
Changes to availability affect the entire schedule week and backdate to the start of the week. 
Example: If you change availability for a Friday, the Calendar shows that the change starts on 
the first day of the schedule period. However, the Details show that the change was made on 
the Friday.
If the time period overlaps, changes to availability override earlier changes.

 o Cancel – Do not save or submit this request.

Swap shifts
If the following conditions are met, you can swap shifts with another employee:

 o The submission period is open.
 o Both employees are qualified to work the other shift.
 o Both jobs are at the same location.
 o The swap does not violate schedule rules as configured for your organization.
 o Neither shift is locked.
 o Neither shift was deleted.
 o Neither shift overlaps another assigned shift in either employee’s schedule.
 o The other employee agrees to swap the shifts.
 o The manager approves the swap.
 o Either the shift must be posted, or the request type must be configured to allow shift swap with 

unposted shifts.

321



Note: A shift swap does not affect the visibility of an unposted shift. Example: If you have 
permission to view and access a certain shift on an unposted schedule and you may request to 
swap that shift with an employee who does not have permission to see that shift (because it is 
unposted). The employee receiving the request can see the request and accept or reject it. 
However, if the shift is accepted, it does not appear on the employee’s calendar until the schedule 
is posted.

Swapping shifts is a two-step process:

 a. Request swaps

Note: Depending on how your system is configured, it may be possible to request a shift swap 
that affects an unposted portion of the schedule.

 a. In the Calendar, select the date.
 b. Click Request Shift Swap.
 c. Select the shift that you want to swap. If you do not select any days in the calendar, the drop-

down list displays all shifts that are during the selected time period of the calendar.
 d. To display detailed information in a tool tip, hover the cursor over a shift or segment.
 e. Optionally, you can filter shifts by location or job.
 f. In Swap With, select an employee who is assigned a shift that you want to work.
 g. Select the other employee’s shift that you want to work.
 h. Optionally and if the shift has a comment, you can enter a Note.
 i. Click either:

 o Draft – Save a draft to submit later.
 o Submit – Submit the request to the employee who can accept or decline your request. The 

request also goes to your manager.
 o Cancel – Do not save or submit this request.

 b. Respond to swap requests

The Calendar displays shift swap requests that are offered to you. Requests that offer to swap 
shifts are highlighted in color.

 a. Click an offered shift swap request.
 b. Optionally, you can filter offered shifts by date.
 c. Click Accept or Decline.

322



 d. Optionally and if the shift has a comment, you can enter a Note.
 e. Click either:

 o Accept or Decline – Submits the request for validation, to the employee who requested the 
swap, and to your manager.

 o Cancel – Does not save or submit your response.

Create your own schedule
If self scheduling is configured, you can create your own work schedule by picking available shifts 
from a schedule that was set up by your manager.
Request Self Schedule shows:

 o 7 days of your current schedule at one time. If the scheduling period is longer than 7 days, use the 
arrows to display days before or after.

 o Shifts in your primary location and transfer shifts that you are eligible to request.
 o The deadline for submission.

 a. In the Calendar, select the time period when you want to schedule shifts.
 b. Select Request Self Schedule. A grid lists the available shifts.
 c. You can sort the available shifts by the time the shift starts, the label or job title, location, or the 

duration of the shift.
 d. Select the shifts that you want to work.
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Tip: To help you to find appropriate shifts, use the Location Schedule or Coverage widget 
parts.

 e. Click either:

 o Draft – Save a draft to submit later.
 o Submit – Submit the request to your managers for approval or rejection.

Your submission can fail because:

 l Shifts are no longer available – If multiple users self-schedule at the same time for the 
same shift, the first person to select and submit the request for the shift gets the shift. The 
second person does not get the shift because it is no longer available. If the second person 
selected multiple shifts, a message displays the dates for all shifts that are not available. To 
continue, select other shifts and submit another request.

 l Self-schedule rule violations – Rules can limit the number of hours you can schedule during 
a request period. For example, you can work up to a maximum number of hours, or only a 
certain number of people can work a shift. If you select a shift that causes a rule violation, 
the request is rejected. A message displays the date of the shift that caused the rule 
violation. To continue, remove the shift and submit the request again.

 l Submitted a request after the request period closes – If you create a draft self-schedule 
request, you cannot submit the request after the request period closes. To continue, click 
Cancel. Create the request again.

 o Cancel – Do not save or submit this request.

Request someone to cover a shift
If you cannot work a shift, use the Calendar widget to search for eligible employees whom you can 
request to cover that shift. The receiving employees accept or reject the request, and the manager 
approves or rejects the request.

 a. In the Calendar, select Request Shift to Cover.

Tip: If you do not see the Request Shift to Cover button, select More. 

 b. Select the Date, Type and Time of the shift you need covered. Shift to Cover By lists employees 
who are eligible to cover the shift.

 c. Check the employees to whom you want to offer your shift. 
 d. (Optional) Enter a Note. 
 e. Click Submit. Your offer goes to the other employee’s calendar.
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 o The shift is not covered until another employee accepts your offer.
 o Your company may also require manager approval before shifts are reassigned.
 o When another employee accepts your offer and the manager approves the request, the shift 

moves from your schedule to the other employee’s schedule.
 o If an employee refuses an offer and enters a Comment, you can see the Comment only.

Request time off
Time off can be for vacation, sick time, appointments, personal time, or other absences.

Tip: To check your time-off accruals before you submit requests, click the Accruals tab.

 a. In the Calendar, either:

 o Click Request Time Off.
 o Select the day or hours. Click Request Time Off.

 b. Select the options:

Important: Not all of these options are available; the options differ according to the type and 
configuration of request.

 o Start Date and End Date – To select other dates, click the calendar icons.
 o Start Time – Only for hours-off requests. The start time must be within the selected time 

period.
 o Pay Code – Only time-based pay codes. If configured, you can select another pay code.
 o Duration:

 l Full Day – Entire shift that day.
 l Half Day – Half the total time of shifts that day. Important: The time off starts when the 

first shift of the day starts. For other half-day amounts, select 1st or 2nd Half Day or Hours.
 l 1st Half Day – Total time of the first half of shifts that day
 l 2nd Half Day – Total time of the last half of shifts that day
 l Hours – If configured, enter a Start Time and Length, or a number of hours.

 o Accruals on – Your accrual balances on the start date of the request. You cannot edit or sort 
the accruals. To select other dates, click the calendar icons.

 c. If configured, you can include non-consecutive days or multiple pay codes in a single request, 
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click Add Another Time-Off Period. Repeat the options.
 d. (Optional) To remove a date range, click Delete a Row.
 e. (Optional) Add or edit a Note.
 f. Click either:

 o Draft – Save a draft to submit later.
 o Submit – Submit the request to your managers for full or partial approval or rejection.
 o Cancel – Do not save or submit this request.

Modify your requests

 a. In the Calendar, click a request.
 b. Select either: 

 o Submit
 o Cancel Submitted – Available only if configured and only for time-off requests. 
 o Delete
 o Retract

 c. (Optional) Add or edit a Note.
 d. Click Submit or OK to confirm. The request goes to your managers for approval or rejection.

Display details about a request

 a. In the Calendar, click any request.
 b. Select Details. The dialog box lists requests from top to bottom:

 o Current status of the request, and when that status became active
 o Detailed information about the request such as dates, durations, pay code, subtype
 o History of status changes in order from the most recent change; includes the name of the person 

who changed the status. Draft requests are not shown in the history.
 c. Click Close.
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Chapter 21  

Assign Open Shifts from a 
Schedule Alert

The Schedule alert icon displays the number of open shifts. Example: A 34 on the Schedule alert icon 
indicates that there are 34 open shifts.
 1. To respond to this Schedule alert, click the Schedule alert button.
 2. Select an open shift from the list.
 3. In the Call List widget, assign the shift.



328



Appendix A  
Formats

Time of day formats
For time of day, the system ignores the colon.

 l For minutes, enter the hours followed by the minutes. The colon is optional.
 l For 7:15 a.m., enter 715.
 l For 7:30 a.m, enter 730.
12-hour format:

 l From 0:00 to 11:59 is a.m. For 7 a.m., you can enter 7, 7a, 700, or 7:00.
 l From 12:00 to 11:59, add p for p.m. For 5:00 p.m., enter 5p. 12:00 is noon, or you can enter 12p or 12. 

00:00 is midnight, or you can enter 12a.
24-hour format:

 l Range is from 00:00 (midnight) to 23:59.
 l For 5:30 p.m., enter 1730.
 l The system does not accept 24:00. Enter 12a, 0, or 00:00 for midnight.
The system converts decimal times into hh:mm format.

 l If you enter 7.5, the time is 7:30 a.m.
 l If you enter 7.5p, the time is 7:30 p.m.



Name and Description Formats

 l A Name must be unique, can be up to 50 characters long, and must not include the following 
characters: &_*%?:;=()/[]\|#@<>

Tip: Kronosrecommends that names have 42 or fewer characters. Later, if you duplicate this item, 
the new item has a name called “Copy of <original name>,” which adds 8 characters to the original 
name.

 l A Description can be up to 250 characters long, and must not include the following characters: &_
*%?:;=()/[]\|#@<>

Duration Formats
For durations, the system does not ignore the colon.

 l For minutes, enter the hours followed by a colon and the minutes.
 l For 8 hours and 15 minutes, enter 8:15.
 l For 8 ½ hours, enter 8:30. If you enter 830, the duration is 830 hours.
For whole hours, you do not have to enter the minutes. For 8 hours, enter 8 or 8:00.
The system converts decimal times into hh:mm format.

 l If you enter 8.5, the duration is 8 ½ hours and is displayed as 8:30.
 l If you enter 6.27, the duration is 6:16 (6.27 = 6 h + (0.27*60 min) = 6 h + 16.2 min = 6:16).
Unless otherwise stated, durations can be greater than 24 hours.

Shift Label Formats
Shift labels replace shift start and end times in the schedule. Labels are compact, can make schedules 
easier to read, and can distinguish shifts that have identical start and stop times.
A shift label can be up to 30 characters long; however, the column width in reports limits shift labels to 5 
characters. Limit the length to 3 characters or fewer, and create unique labels. 

 l Example: Label a 7:00 a.m. to 3:30 p.m. shift with a break at 12:00 as 78A. Label a 7:00 a.m. to 3:30 
p.m. shift with a break at 12:30 as 78B.

 l Do not include:
&_*%?:;=()/[]\|#@<>

 l For a shift template, the shift template name is the default shift label.
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